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GENERAL

SECTION 1 GENERAL

Remote Programming Interface (RPI)

Programming Cable
Connect To
Serial Port

NOTE: An RPI box is
required with the
7780 portable.

Figure 1-2 Typical Portable Programming Setup

1.1 PROGRAMMING SETUP 7780 Portable
To program the various transceivers, a ® Programming cable from RPI to transceiver, Part
Windows®-based computer, EFJohnson No. 597-2002-123. NOTE: This cable, the -488
PCConfigureTM programming software, Part No. programming software, and the PDF file for this
023-9998-488, and the following items are required to manual are included in Programming Kit, Part No.
program the various transceivers. A mobile program- 250-7780-002.
ming setup isshown in Figure 1-1, and a portabl e setup ® Remote Programming Interface (RPI), Part No.
isshownin Figure 1-2. 023-9800-000
51xx Portable 5300 M obile
® Programming cable from computer to transceiver, ® Programming cable from RPI to transceiver, Part
Part No. 023-5100-920. NOTE: Thiscable, the-488 No. 023-5300-005. NOTE: This cable, the -488
programming software, and the PDF file for this programming software, and the PDF file for this
manual are included in Programming Kit, Part No. manual are included in 5300 Programming Kit,
250-5100-003. Part No. 250-5000-004.
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® Remote Programming Interface (RPI), Part No.
023-5300-000.

9800 M obile

®* Programming cable from RPI to transceiver, Part
No. 597-2002-200. NOTE: The above items, the
-488 programming software, and the PDF file for
thismanual are included in 9800 Programming Kit,
Part No. 250-9800-002.

® Remote Programming Interface (RPI), Part No.
023-9800-000

Connecting M obile Transceivers To Computer

With 5300 transceivers, only RPI, Part No. 023-
5300-000, can be used. Other RPIs such as 023-9800-
000 and 023-9750-000 are not compatible with this
transceiver.

With 9800 transceivers, earlier RPIs such as Part
No.s 023-5810-000 and 023-9750-000 can also be
used. However, the 023-9800-000 version is required
for other functions such as Flash programming and
tuning.

The Radio Programming Interface (RPI) provides
the required logic interface between the computer and
transceiver. The cable from the RPI to computer is not
included with the RPI or in the programming kit. The
current RPI's have afemae DB9 connector, and most
computer serial ports have amale DB9 or DB25
connector. Therefore, amale DB9 to female DB9 or
DB25 cableisusually required. Thisisastandard cable
available at most computer supply stores or order 6 ft.
DB9M to DBIF cable, Part No. 597-5900-002.

The cable from the RPI to the transceiver is not
included with the RPI, but it isincluded with the
programming kits or can be ordered separately as
previously described.

This cable plugs into the microphone jack of stan-
dard front or remote mount transceivers. With 5300
transceivers using the Handheld Control Unit (HHC),
the connection point is the 10-pin programming jack
on the HHC junction box via a special adapter plug
(Part No. 023-5300-140). If the HHC is not equipped
with the junction box (Part N0.023-5300-130), it is
also required for programming.

Connecting Portable Transceivers To Computer

NOTE: Although they may look the same, the 5000
portable programming cable cannot be used to
program a 5100 portable and vice versa.

5100 Series- No RPI isrequired because the radio
contains the interface circuitry. The programming
cable has afemale DB9 connector for connecting to
the computer.

7780 - The 9800 RPI and programming cable listed in
the preceding information are required. The RPIs used
to program the 5100 and 5300 are not compatible. The
programming cable connects to the accessory jack on
the side of the transceiver.

Aswith mobile transceivers, the cable between
the RPI and computer is not included with the RPI.
Refer to preceding description for more information.

1.2 COMPUTER DESCRIPTION

The computer used to run this program must meet
the following minimum requirements:

Windows® 95/98/NT/2000/X P (3.1 cannot be used)
Pentium® processor or equivalent

At least 16 MB of RAM

A hard disk drive with at least 4 MB of free space
A CD-ROM drive

An available seria port

1.3 OPERATING AND SERVICE MANUALS

This manual includes brief descriptions of the
various programmabl e parameters. For detailed radio
operating information, refer to the applicable radio
operating or service manuals which are as follows.
With the 5100/5300, both the operating and service
manuals contain operating information, so either can
be used.

5100 Portable CD Op Man, PN. 002-5100-1005CD
CD Serv Man, PN. 001-5100-0015CD
CD Op Man, PN. 002-5300-009CD
CD Serv Man, PN. 001-5300-009CD
7780 Portable Service Manual, PN. 001-7780-500
9883 Mobile  Serv Man Addend, PN. 001-9800-500
Operating Man, PN. 002-9800-503

5300 M obile
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I Radio Configuration - EFJohnson Company
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Figure 1-3 Main Screen (Global Screen Shown)

1.4 SOFTWARE INSTALLATION

NOTE: Before completely removing an old version of
PCConfigure, be sureto transfer thefilesin the Data
and Keys folders to those folders of the new version.

1. Make surethat there are no other applications open
during this installation procedure. Also, make sure
that the computer meets the minimum regquirements
listed in the preceding section.

2. Insertthe PCConfigure CD-ROM inthe CD drive of
your computer.

3. Inthelower left corner of the screen, select Start >
Run and then click the Browse button. Select the
CD-ROM drive and thefile“PCConfigurex_x.exe”
(x_x isthe PCConfigure version number). Click the
Open button and then from the Run window, click
OK and the installation process begins.

4. Follow the on-screen instructions. The default
directory for the program is\Program Files\EF
Johnson\PCConfigure. This directory can be
changed during installation if desired.

1.5 STARTING AND EXITING

To Start PCConfigure

Click the Start button and select the PCConfigure
group. Then click the PCConfigure icon.

To Exit PCConfigure:

Select File > Exit or press ALT and F4.
1.6 PROGRAMMING FILE TYPES

Programming datais stored in a disk file that can
be saved, read, copied, and deleted (see Section 3.1).
Thisfileis automatically given the extension “.rcf”.

1.7 HELP FILES

To display help information on the current screen,
click Help in the menu bar.

NOTE: For a list of changes made with the various
releases of this software, refer to the ReleaseNotes.txt
file located in the PCConfigure program fol der.
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1.8 MAIN SCREENS

Four different screens can be selected by clicking
the tabs at the top as shown in Figure 1-3. The func-
tions of these screens are as follows:

Global - This screen is shown in Figure 1-3, and it
programs parameters that are the same for all Conven-
tional, Project 25 Trunked, SMARTNET ", and
SmartZone® systems. Refer to Section 4 for more
information on parametersin this screen.

Radio Wide - This screen programs the parameters
that are the same for all programmed Conventional
(P25 and analog), Project 25 Trunked, and
SMARTNET/SmartZone systems (adifferent screenis
displayed for each). The screen system typeis selected
in the System Specific box. Refer to Section 5 for
more information on parametersin this screen.

Per System - This screen programs the parameters
that are unique to each programmed system. The
system to be edited is selected by clicking it in the
Systems box. Refer to Sections 7.1, 8.1, and 9.1 for
more information on parametersin this screen.

Zone - This screen programs the channels and zones.
Unique channel parametersinclude system number and
type, frequency, and talk group. Refer to Sections 7.2,
7.3, 8.3, and 9.3 for more information on parametersin
this screen.

1.9 OTHER SCREEN INFORMATION
1.9.1 PROGRAMMABLE TITLE AND LOGO

Thetitle that is displayed after “ Radio Configura-
tion” at the top of the screen (see Figure 1-3) is
programmable using the Tools > Organization |den-
tity menu item. This can be used, for example, to
display a company name on the top line. In addition,
the logo that is displayed on the right end of the menu
bar can be customized. Refer to Section 3.4 for more
information.

1.9.2 ORGANIZER

Clicking the organizer button ” B on theright
end of the toolbar displays a screen is used to organize
the various programming files into groups and
subgroups. This can make administrating the program-

ming files of alarge organization easier. Refer to
Section 3.8 for more information.

1.9.3 FILE SIZE INDICATION

The maximum number of channels that can be
programmed may be limited by the available memory
spacein theradio. A running indication of the amount
of memory used by the current dataif it was down-
loaded to the radio is displayed as a percentage in the
“Size:” box in the status bar on the bottom of the
screen (see Figure 1-3). When this percentage reaches
100%, the available memory isfull and some channels
may need to be deleted if more information remainsto
be programmed.

1.9.4 DECIMAL/HEXADECIMAL SELECT

On some screens, such asthe SMARTNET Talk
Group, numbers can be entered using either a Decimal
or Hexadecimal format. The format is selected
globally which meansthat when aformat is selected, it
is selected for applicable numbers on all screens.

The currently selected format isindicated in the
status bar on the bottom of the screen in the box next
to thefile size indication (see Figure 1-3). A “D” indi-
cates the Decimal format is selected and an “H” indi-
cates the hexadecimal format is selected. In addition,
the background color isivory for all numberswhich
must be entered in Hexadecimal, and white for
Decimal and other entries.

To toggle between the Decimal and Hexadecimal
formats, right click the H/D box and click Yesin the
confirmation box that is displayed. This mode can also
be toggled using the Tools > Preferences screen
described in Section 3.4.

1.10 CREATING SYSTEMS

A system as used with these transceiversis a
collection of channels or talk groupstypically assigned
to the same repeater site. Unique system parameters
are shown in the Per System screen and include the
scan list, varioustimers, and talk groups. Up to sixteen
systems of any type can be created.

To create anew Conventional, SMARTNET,
SmartZone, or Project 25 Trunked system, select
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Radio > Add Systemsin the menu bar and then select
the desired system type (see Section 3.2). Alterna
tively, click %/~ in the toolbar and select the desired
system type from the drop down list. To view current
and added systems, select the * Per System” screen and

they are displayed in the “ Systems” box. To delete a
system, select it in the “ Systems” box and then select
the Radio > Delete System in the menu bar or M in
the toolbar.

SECTION 2 PROGRAMMING PROCEDURE

Thefollowing is agenera procedure that can be
followed to program atransceiver.

2.1 PRELIMINARY
1. Select aprogramming file asfollows:

Create a New File - To start with anew file
containing default parameters, select File > New and
then when the dialog box appears, select the frequency
band of the radio: VHF, UHF 380 (380-470 MHz),
UHF Low (403-470 MHz), UHF High (450-512
MHZz), 800 MHz.

Open An Existing File - To open an existing file
stored on disk, select File > Open and then the file-
name to be opened.

Read a File From a Radio - To transfer afile from a
radio to the computer for editing or use as abasisto
program another radio, connect the radio to the
computer as described in Section 1.1. Then turn the
radio on and select Transfer > Read Parameters From
Radio in the menu bar. Encryption parameters cannot
be uploaded for security reasons. Refer to Section 3.3
for more information.

2. Besurethe correct radio type (such as the 5300-
series mobile or 5100 portable) is selected by the
Radio > Series menu (see Section 3.2).

3. With trunked operation, the correct system key must
be selected on the Per system screen. Refer to
Section 13 for more information.

NOTE: Some operating protocols and options may not
be available with your radio. To display the options
that have been factory enabled, select Transfer > Read
Options From Radio (see Section 3.3).

2.2 CREATING SYSTEMS

A conventional system is automatically set up
when anew programming fileis created. Create the
desired number and type of Conventional,
SMARTNET, SmartZone, and/or Project 25 Trunked
systems by selecting Radio > Add System or 4 ~|in
the toolbar. The Per System screen must be selected to
view the current systems. Refer to Section 1.10 for
more information.

2.3 ENTERING GLOBAL PARAMETERS

1. Display the Global Parameter screen by clicking the
Global tab at the top of the screen.

2. Program the applicable parametersin this screen as
described in Section 4. Parametersthat do not apply
to the selected Radio Series are grayed out.

2.4 ENTERING RADIO WIDE PARAMETERS

1. Display the Radio Wide screen by clicking the
Radio Wide tab at the top of the screen.

2. Program the applicable parametersfor all Conven-
tional, SMARTNET/SmartZone, and/or Project 25
Trunked systems as described in Section 5.

NOTE: The Radio Wide Scan List cannot be
programmed until the channels are set up as described
in the next section.

2.5 SETTING UP ZONES AND CHANNELS

1. Display the Zone screen by clicking the Zone tab at
the top of the screen.

2. Set up Zones and Channels as described in
Section 6. Zones can include up to 16 channels of
any type from any system.
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2.6 ENTERING CONVENTIONAL SYSTEM AND
CHANNEL PARAMETERS

NOTE: If no conventional channels are programmed,
proceed to Section 2.7.

1. Display the system programming screen by clicking
the Per System tab at the top of the screen.

2. Select the system in the |eft pane and program the
applicable parametersfor each Conventional system
asdescribed in Section 7.1. NOTE: It may be neces-
sary to further define the channels as described in
the next steps before programming the standard
scan lists.

3. Display the Zone screen by clicking the Zone tab at
the top of the screen. Program the individual
channel information of each Conventional channel
in each zone as described in Sections 7.2 and/or 7.3.

4. If necessary, program the standard scan listsin each
system (see preceding step 2). After al channel
information is programmed, program the Radio
Wide scan list in the Radio Wide screen (see
Section 2.4).

2.7 ENTERING SMARTNET/SMARTZONE
SYSTEM AND CHANNEL PARAMETERS

NOTE: If no SMARTNET or SmartZone channels are
programmed, proceed to Section 2.8.

1. Display the system programming screen by clicking
the Per System tab at the top of the screen. Make
surethe correct System Key is selected as described
in Section 13.

2. Select the system in the |eft pane and program the
applicable parameters for each SMARTNET and
SmartZone system as described in Section 8.1.
NOTE: It may be necessary to further define the
channels as described in the next steps before
programming the various system lists.

3. Display the Zone screen by clicking the Zone tab at
the top of the screen. Program the individual
channel information of each SMARTNET and
SmartZone channel in each zone as described in
Section 8.3.

10

4. If necessary, program the system lists (seepreceding
step 2). After all channel information is
programmed, program the Radio Wide scan list in
the Radio Wide screen (see Section 2.4).

2.8 ENTERING PROJECT 25 TRUNKED SYS-
TEM AND CHANNEL PARAMETERS

NOTE: If no Project 25 Trunked channels are
programmed, proceed to Section 2.9.

1. Display the system programming screen by clicking
the Per System tab at the top of the screen. Make
surethe correct System Key is selected as described
in Section 13.

2. Select the system in the | eft pane and program the
applicable parameters for each Project 25 Trunked
system asdescribed in Section 9.1. NOTE: It may be
necessary to further define the channels as
described in the next steps before programming the
standard scan lists.

3. Display the Zone screen by clicking the Zonetab at
the top of the screen. Program the individual
channel information of each Project 25 Trunked
channel in each zone as described in Section 9.3.

4. If necessary, program the standard scan listsin each
system (see preceding step 2). After all channel
information is programmed, program the Radio
Wide scan list in the Radio Wide screen (see
Section 2.4).

2.9 PROGRAMMING RADIO (WRITING FILE)

When al the required programming information
has been entered in the various programming screens,
the information can be written (downloaded) into the
radio. When writing afile, be sure that all connections
between the computer and radio are secure, theradiois
turned on, and the proper serial port is selected (see
Section 3.3). Then proceed as follows:

1. Select Transfer > Write Parameters To Radio from
the menu bar.

2. If nofileiscurrently loaded, adialog box appearsto
select the desired file. Otherwise, the current fileis
transferred to the radio.
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SECTION 3 MENUS, TOOLBAR, AND STATUS BAR

L R A R

I| File= Hadio Transzfer Toolz Help

I ~u o L [ =

3.1 FILE MENU

File Radio Transfer Tooks Help

[ mew -+
= Open ... O
& save Chrl+3

Save 4s ...
Close

Send ko Selected Organizer @roup

Prink ...

Eanyert Band L4

Exit Chri+3

New - Creates a new programming file named
“Untitled.rcf” containing default parameters and
displays a dialog box for selecting the frequency
range.

Open - Opens a programming file that was previously
saved to disk. If amodified fileis currently open, you
are asked if that file should be saved before the new
fileis opened.

Save - Saves the current file to disk using the current
filename. If it isthefirst time aNew fileisbeing
saved, the following Save As screen is displayed to
specify the file name and destination.

NOTE: It isno longer possible to save any type of new
programming file to disk without a radio connected.
Refer to Section 15 for more information.

Save As - Saves the current file to disk and displays a
screen for changing file name and destination if
desired.

Close - Closes the current file without exiting the
program so that another file can be opened or created
if desired. If the current file has been modified and the
changes have not been saved, you are asked if the
changes should be saved before closing.

Send to Selected Organizer Group - Addsthe
current file to the group that is selected in the
Organizer. Refer to Section 3.8 for more information.

Print - Prints the information in the current file. A
screen isdisplayed to select if Global, Radio Wide, Per
System, and/or Zone information is printed.

Convert Band - If the current file type is UHF 380
(selected when it is created by File > New), this can be
used to change it to the UHF LO type and vice versa.

Exit - Closes the PCConfigure program. If the current
file has been modified and the changes have not been
saved, you are asked if the changes should be saved
before closing.

3.2 RADIO MENU

Series - Selects the specific radio being programmed.
Only parameters which apply to that radio are then
displayed and others are grayed out.

Add System - Adds a new Conventional,
SMARTNET, SmartZone, or P25 Trunking system as
described in Section 1.10. “Multi-Net” isreserved for
future use.

|Eadiu:u Transfer Tool: Help

| Series

! L] Add System
ﬂﬁ Delete System

; T Load Swstem Keys

Yieww Programmed Radio Wide Functions {&ll Protocols)

' B, 5100 Portable
Conventional S3oc Mobile
Smart Met 7780 Portable
Smart Zone 9853 Mobile
P25 Trumking
Tkt et

Radio Menu
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Delete System - If two or more systems have been set
up, this function deletes the system that is currently
selected in the Per System screen.

L oad System Keys - Allows the system keysto be
loaded from afolder other than the default “Keys”
folder. A dialog box is displayed to select the desired
folder. Refer to Section 13 and “Preferences’ in
Section 3.4 for more information.

View Programmed Radio Wide Functions (All
Protocals) - Displays the screen shown below which
indicates the functions that have been assigned to the
programmable option buttons on the Radio Wide
screen (see Section 5.4). These buttons can be
programmed for a different function in each mode
(conventional, SMARTNET/SmartZone/P25
Trunked). Up to two modes selected by the drop down
lists are displayed.

Radio Wide Programmed Functions (All Protocaols)
Correentional LI
F1. Clear/Home Mumeric 3 Unprogrammed
F2 Menu MNumeric 4: Unprogrammed
F3 OTAR Rekey Request MNumeric 5 Unprogrammed
F4: Change Kepzet MHumeric B Unprogrammed
Found #: Unprogrammed Mumeric 7. Unprogrammed
Star * Unprogranimed MNumeric 8:  Unprogrammed
Toggle: Unprogranmed MNumeric 3 Unprogrammed
Emergency:  nprogrammed Side Button1: Clear/Secure
MNumeric 0 Unprogrammed Side Button2:  kaonitar
MNumeric 1:  Unprogrammed Side Button3: Fepeater T4
Mumeric & Unprogrammed
SmartMet / SrartZone
F1: Clear/Home MNumeric 3: Unprogrammed
F2 Menu MNumeric 4:  Unprogrammed
F3 BacklLight Mumeric & Unprogrammed
F4: Home Zone MNumeric B Unprogrammed
Pound #: Unprogranimed MNumeric 72 Unprogrammed
Star = Unprogrammed Mumeric & Unprogrammed
Toggle: Zone Select MNumeric 3:  Unprogrammed
Emergency: Emergency Side Button1: Scan
MNumeric 0 Unprogrammed Side Button2: Scan Edit
Mumeric 1; Unprogrammed Side Button3:  Site Lock Funct
MNumeric 2. Unprogrammed

o 0K

3.3 TRANSFER MENU

NOTE: To stop a data transfer in progress, click @
in the toolbar (see Section 3.6).
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Comports- Displays a dialog box which selects the
seria port used to program the transceiver (see Section
1.1). Thedefaultis COM1, and the last selected port is
saved and then automatically reselected whenever the
program is started. Refer to Preferencesin Section 3.4
for more information.

|Iransfer Tool: Help

@ Comports L.,

Baud Rates 2a00
19200
ﬂ_';' Read Parameters fram Radio  Ckrl+R
35400
ﬂfl' \Write Parameters to Radio ChrlHhy
| 57600
HY write DSP Code to Radio 115200

¥
s
i

‘rite Application Code to Radio

Read Yersion Info From Radio

Read Options From Radio

Read/Write IP Address ...
Fead|ite Spur FrEqUENTES ..

Transfer Menu

Baud Rates - Select 9600 baud for standard program-
ming of the 7780 portable, 9883 mabile, and 5300
mobileswith the Rev 4 logic board. All 5100 portables
and all 5300 mobiles with Rev 6 or later logic boards
usethe 19200 baud rate. DSP and ARM code download
functions can be performed at the higher baud rates,
including 115200. The default baud rateis 19200. Refer
to Preferences in Section 3.4 for more information.

Read Parameter s From Radio - Transfersthe infor-
mation programmed in a transceiver into anew
programming file. If the current file has not been
saved when this function is selected, adialog box is
displayed to allow it to be saved if desired. The trans-
ferred data can be viewed, edited, or saved to a disk
file as desired. An upload password may have to be
entered. Refer to Section 10 for more information.

Write Parameters To Radio - Programs the trans-
ceiver connected to the computer with the datain the
current programming file. Use the 115200 baud rate. A
download password may have to be entered. Refer to
Section 10 for more information.

NOTE: Later 51xx/53xx models have safeguards to
prevent unauthorized cloning. Refer to Section 15fr
more information.
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Write DSP Code To Radio - Reprograms early 5300
radios (see Section 16) and also 9883 radios with
updated DSP operating code (more info. follows).

Write Application Code to Radio - Programs all
5300 and 5100 radios with updated firmware (oper-
ating software). With “F” and earlier 5300 radios, this
codeisreferred to as ARM code. Proceed as follows:

1. A specia computer file containing the operating
code must be obtained from EFJohnson. The
Application (ARM) code hasa*“.hex” extension,
and the DSP code has an “.out” extension. With
early 53xx ARM models, copy the .hex fileto the
ARM\5300 folder of the PCConfigure program,
andthe .out fileto the DSP\5300 fol der. With later
53xx models, copy the .hex file to the
PPC\5300 i folder, and with al 51xx models,
copy it to the PPC\5100 folder. Other locations
can also be used if desired.

2. Put theradio in the firmware programming mode
asfollows.

53xx - Turn power on with the special Flash
Mode Select Plug, Part No. 023-5300-010,
plugged into the microphone jack. Alternately,
short pin 3 to 7. With the HHC, plug it into the
programming adapter plug that is plugged into
the junction box programming connector.

51xx - Turn power on with the option button
above the PTT switch pressed.

98xx - Turn power on with the PTT sw pressed.

3. Select the 115,200 baud rate with the 5100 and
the 57,600 rate with the 5300.

4. If applicable, make sure that the radio is
connected to the computer and then select this
function. Enter the password (obtained from the
EFJohnson Company) in the screen that is
displayed and click the OK button.

5. Thefollowing screenisthen displayed. Select the
loader and code filesiif required by clicking the
“Change’ button. Theloader fileisincluded with
PCConfigure software. In some cases, an updated
loader file may be required and would then need
to be selected instead of the included loader file.
The operating code file should be in the folder
selected in step 1.
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6. Click the Start button to begin code downloading
(try clicking Start again if afailure occurs). Writing
may require 20 minutes or more. With the early
53xx, repeat for DSP code if applicable.

NOTE: After downloading is complete, perform* Read
Parameters From Radio” and then “ Write Parameters
To Radio” to ensure that the file format is correct.

Code Download

Loader fils to download:

IC:\F‘rogram Filez\EF JohnzonPCConfigure\PCConfigure_1_164ppchal

i Chooze

Code file to download:

IC:\F‘rogram Filez\EF JohnzonPCConfigure\PCConfigure_1_1E4ppchal Chooze |

Progress:
[ Start |

I~ Close dialog when finished

X Cancel |

Read Version Info From Radio - Transfers version
information on the software the radio contains and
then displaysit as shown below.

E
File Format Version: RB
D5P Software Wersion: 2048
Controller Yersion: 2119
Hardware Revision: 020

Radio Serial Mumber;

40-53-17-27-10-01-75-42
2.2

Boot Load Yersion:

Read Options From Radio - Displaysinformation on
which options have been enabled in the radio as shown
in Figure 3-1. The check boxes indicate which options
are enabled. They are for informational purposes only
and cannot be edited.

The*Update Options” button is used to add additional
options that have been purchased for the radio. An
encrypted data file keyed to the radio serial number is
provided to unlock these options. Thisfile hasan
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Radio Options

—P25 Options —Encmption Options
[ Migital Waze [¥ DES Securenect
v Conventional Mobile Data ¥ DESEL
v Trunking Mobile D'ata = v
v Digital Conwentional |l R R

v Digital SMARTHET /SmartZone v P25 DES OFE

Iv 4ES

—OTAR Options

v Conventional
v P25 Trinking

—Feature Dizable Option

[ SMARTMET/SmartZone Status Dizable

[~ SMARTHET SmartZone and P25 Message Dizable

[ Emergency Disable

I Dynamic Regroup Dizable

[~ SMARTMET /SmartZone and P25 Interconnect Disable
[~ Call Alert, Unit Call, D Disable

—Trunking Optiong | Featurs Option

¥ STAR Trunking

¥ SMARTMET Trunking
¥ SmarZone Trunking
¥ P25 Trunking

I~ Multinet Trunking

I Custom lcons

¥ Zonefail Site Lock

¥ Keypad Programming
I~ Full Eevpad Support
¥ 512 Talkgroups/Channels

Figure 3-1 Transfer > Read Options Screen (5300 Shown)

“.opt” extension and is selected and downloaded by a
screen that is displayed when this button is clicked.

Read/Write I P Address (5100 only) - Thisfunction
is not used because an Ethernet link to theradio is
currently not supported. It displays the following “IP
Address’ screen which reads/edits the | P address
stored in the radio.

Radio'z IF Addres

| 000.000.000.000

Write |F |

X Cancel |

Read/Write Spur Freguencies (7780 only) -
Displays the following “ Spur Frequencies’ screen
which is used to read and write spurious frequencies.
When afrequency in thistable is selected by the radio,
theinternal crystal frequency is shifted dlightly to
minimize receive noise caused by these signals.
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Enter Spur Frequency: Frequency Lizt:

[000.0000° | (MHz) Ll
=<

“wirite Fregs |

x Cancel |

3.4 TOOLS MENU

| Tools Help

Toolbar Options ...

Crganization Identity

Password Management

Preferences ...

Toolbar Options - Displays the following dialog box
which is used to select theicons that are displayed in
the toolbar (see Section 3.6). When the * Custom” box
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is checked and highlighted, the additional window
shown below is displayed to select which icons to
display. The last selected configuration is saved and
then automatically resel ected when the program is
restarted.

Standard Add System
Tramszfer Delete System
Help Edit Zones & Channels

E dit R adio *wide Scan List
Riead Yersion

Read Options

[#] ‘wite DSF Code

Wwite ARM Code

Organization Identity - Displays the following
screen which can be used to display a unique company
title and logo on the programmer screen. To display a
unique company name, enter the desired name in the
“Organization’s Name” box in this screen. It isthen
displayed after “Radio Configuration” at the top of the
screen (see Figure 1-3).

Organization ldentity

lonez and Jones [ncorporater

Organization's M ame:

Lago
Logo Directony:  C:h APCConfigurehPCConfigure_1_18 Dhzplash

N

[~ Usze Default

0K I

x Cancel |

A logo is displayed on the right end of the toolbar, and
when aradio read or write operation is occurring, this
logo changes. To display the default logo, check the
Use Default box. To display a custom logo, create a
bitmap file of the desired graphic that meets the
following requirements. A photo editing program such
as Photoshop® or Paint Shop Pro® can be used.

® 53W x 22 H pixels

®* bmp fileformat

® 256 colors or higher recommended

® Upto 30 files can be created named Logol.bmp,
Logo2. bmp, and so on up to Logo30.bmp. These
graphics are then displayed in rapid succession
during aradio read or write operation.
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Password Management - Displays the following
screen which is used to enable, disable, and change
radio passwords. A radio must be connected to display
this screen. Actual passwords are never displayed in
this screen. Passwords, no matter what the length, are
always represented by eight asterisks (********),

X
o r—
Statuz:  Enabled

x Cancel |
Originalst aster Paszward: IW 1 ? Help |
Mew Pasaword: I ““““““““ \
Re-enter Mew Password: I ******** Incorrect
Password
Indicator
LChange | Enable | Dizable |

NOTE: Thisisa new feature available only with later
5100 and 5300 radios with updated firmware. The
power-up password previously programmable on the
global screen with earlier models can be programmed
in those models only with PCConfigure, Veersion 1.21.6
or earlier. Refer to Section 10 for more password
information.

User - Thisdrop down list selects the particular
password being changed as follows

User 1, User 2, User 3, User 4 - Up to four different
power-on passwords can be programmed.
Currently, the same user features are available with
each.

Upload, Download - These passwords are required
to Upload (read) or Download (write) program-
ming parameters. A preceding “User” password is
not required to upload or download parameters.

Master - Thispassword overridesall the other pass-
words. It can be used by a system administrator or
if any of the above passwords are |ost.

Selected User - This box indicates status of the
selected password (Enabled or Disabled). The Pass-
word box always indicates eight asterisks and is not
editable.
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Proceed as follows to set up or change a password.
Passwords must be 1-8 charactersin length and
consist of numbers 0-9. Zeros are valid charactersin
any location, even as leading characters.

Changing a Password

NOTE: To enter a password, click the first asterisk
or select all eight asterisks. If an incorrect pass-
word isentered, ared “!” exclamation pointis
displayed to the right of the box (see preceding
screen) and the password must be re-entered.

1. Select the password in the drop down list.

2. If the password was previously set up, enter the
current password in the Original/Master box.

If thisisthefirst time the password is used, it
initially consists of null (deleted) characters. In
this case, do not enter anything in this box.

3. If the password is simply being enabled or
disabled, click the appropriate Enable or Disable
button. Proceed to step 6.

4. If the password is being changed or initially set
up, enter the new password in the New Password
box and then re-enter it in the Re-enter New Pass-
word box to confirm it. Click the Change button.

5. Repeat for other passwords as required.

6. To exit without sending the change to the radio,
click the Cancel button. To exit and send the
change to the radio, click the OK button.

Preferences - Displays the following screen which
sets several program preferences.

On New

When “Always’ is checked, a programming file
with the Radio Series and Band selected by the drop
down listsisautomatically created in asingle step by
File> New or the @ button. However, the Band of a
file then cannot be changed, so only files with the
selected Band can be created. If thisis not checked,
the Band is selected in a separate step before thefileis
created (see following).
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=
P
~On Mew ~On Exit
v Alwaps [V Remembar series

Default series: !5300 M abile 'I v Remember band

Default band:  |WHF - I~ Remember baud rate
¥ Remember keys directary

~General

W Use HEX input [applicable parameters only]

Defaultl o 0K I X Cancel |
On Exit

When checked, the parameter is restored to the
current condition when the program is restarted.
Otherwise, the default is selected. Note that the first
two parameters are overridden by the preceding “On
New- Always’ if it is checked.

Remember Series- The current Radio Seriesis
automatically selected whenever anew fileis
created by selecting File > New or the [ button.
If thisis not selected, “5300” isthe default.

Remember Band - The current frequency Band is
highlighted (and can be changed if desired) when
the Band select screen is displayed by selecting
File> New or the 1| button. If thisisnot selected,
“VHF" isthe default.

Remember Baud Rate - The currently selected
baud rate is automatically reselected (see Section
3.3). If thisis not selected, “19200" is the default.

Remember Keys Directory - The currently
selected key directory is automatically reselected.
If thisis not selected, the “Keys’ folder isthe
default (see“Load System Keys’ in Section 3.2).

Genera

Use Hexadecimal Input - When selected, all
applicable numbers are entered in Hexadecimal
format instead of Decimal format. All Hexadecimal
numbers are indicated by an ivory-colored back-
ground. Refer to Section 1.9.4 for more
information.
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3.5 HELP MENU

Contents - Displays the help system table of contents.

Help
Contents
About Configuration Software ..

About Configuration Softwar e - Displays the PC
Configure version number and company information.

3.6 TOOLBAR

Thetoolsin the toolbar provide quick accessto
many menu functions. The tools that are displayed are
selected by the Tools > Toolbar Options menu
described in Section 3.4. The Standard, Transfer, Help,
and Custom tools can be turned on and off by this
menu.

3.6.1 STANDARD TOOLS

Refer to Section 3.1 for more information on
these functions.

E New - Opens anew programming file containing
default parameters.

|- Open - Loads afile from disk. Clicking the
down arrow displays a drop-down list of recently
loaded files.

E Save - Saves the current file to disk.
3.6.2 TRANSFER TOOLS

Refer to Section 3.3 for more information on
these functions.

ﬂ COM Port - Selects the serial port used to
connect the radio to the computer.

ﬂ Read Parameter s From Radio - Transfers data
from the radio to a new programming file.

@ Write Parameters To Radio - Programs the
radio with the datain the current programming file.

9 Sop Data Transfer - Cancels the data transfer
in progress.

3.6.3 HELP TOOLS

@ Help - Displays help information.
Manual - Reserved for future use.
3.6.4 CUSTOM TOOLS

e~ Add System - Adds a new system. Clicking
the down arrow displays a drop-down list of the
system types that can be added.

ﬂ Delete System - When the Per System screenis
displayed, clicking this button deletes the selected
system.

i Edit Zones and Channels - Displays the Edit
Zones and Channels screen.

Edit Radio Wide Scan L ist - Displaysthe Radio
Wide Scan List edit screen.

ﬂ.t Read Version From Radio - Reads version
information from the radio for the software it contains
and then displays that information.

ﬂ.’r Read Options From Radio - Reads option
information from the radio and then displaysiit.

@ Write DSP Code To Radio - Programs 98xx and
early 53xx models with new DSP software.

ﬂ Write Application Code To Radio - Programs
the radio with new Application/ARM software.

3.7 STATUS BAR

The status bar which follows indicates the
following information:

Eiand: YHF Seties: 5100 Porkable  File: Untitledl

Size: 6 % of 16K D

Decimal/Hexadecimal Indicator

Read Parameters from Radio

Information /

Status Bar



MENUS, TOOLBAR, AND STATUS BAR

Band - The frequency band of thefile. Thisis selected
when anew fileis created by the File > New function.

Series - The Radio Series of the file selected by the
Radio > Series function.

File - The file name of the current programming file.
Thisnameis specified thefirst timethefileis saved by
the File > Save function or it can be changed by the
File> Save Asfunction.

Size - Indicates the percent of the available memory
space that would be used if the radio was programmed
with the current file (see Section 1.9).

D/H Box - Indicatesif the Decimal or Hexadecimal
number format is selected (see Section 1.9.4).

Information - Displays a short description of toolsin
the toolbar when they are selected by the cursor.

3.8 ORGANIZER

Clicking the organizer button ” B on theright
end of the toolbar toggles the following screen which
can be used to organize alarge number of program-
ming files into groups and subgroups for easier identi-
fication when administering alarge organization.

=[] Mup Orgarizer

Ellj Street Dept
@ ServiceT ruck.rof
MY Supervisor.rch

= Public Safety

i

----- (] “wiater Dept

(|

Organizer Screen

NOTE: Thisorganizer does not add, delete, or move
programming files on the hard drive. It simply orga-
nizes those files into logical folders and subfolders.
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Groups are indicated by afolder symbol I:l
and programming files are indicated by a @ symbol.
A [=] symbol next to an item indicates that the branch
is expanded, and clicking it collapses the branch. Like-
wise, a symbol indicates that the branch is
collapsed, and clicking it expands the branch. If afile
in the organizer has been deleted from the hard drive,
itisindicated by ared “X” through the icon .

1. To add the current programming file to the Orga-
nizer, select the desired Group in the Organizer and
then select the File > Send to Selected Organizer
Group menu item (see Section 3.1). To add other
files, see step 3.

2. Toopen afilelisted in the Organizer, simply double
click it, drag it to the main programmer screen, or
select “Open” as described in the next step.

3. To add, edit, delete, or move agroup or file, right
click the applicable group or file and the following
screen is displayed.

Open

Add Group
Add File(s)
Delete Group
Delete File

Show Full Path

Cut

Copy
Faste

Eename

Open - Opensthe selected file. If the current file has
not been saved, you are asked if you would like to
save it first.

Add Group - Adds a new group below the selected
location.

Add File(s) - Displays a screen that is used to select
afileonthehard drive to add to the sel ected | ocation.

Delete Group - Deletes the selected Group from the
Organizer only (the actual files on the hard drive are
not deleted).
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Delete File - Deletes the selected File from the Orga-

nizer only (the actual file on the hard drive is not
deleted).

Show Full Path - Displaysthe entire path name of the

file on the hard drive.

Cut - Moves the selected Group or Fileto the
clipboard.

Copy - Copiesthe selected Group or Fileto the
clipboard.

Paste - Copiesthe current file on the clipboard to the

selected location

Rename - Renames the selected Group. Files cannot
be renamed from the Organizer.

SECTION 4 GLOBAL SCREEN PARAMETERS

[ Low T Power
Power Up Zone: 1

Chanrels

i -
Laszt Chanrel -

Power Up Channel. 1

Horme Channel:
. Soft Power Dot
Power Up in:

Sound
[ Alert Tane OM

Ignition Power Dowr;

Other
- Inf. [ Hangup Box Manitar
= [m] L [~ Backlight on Key Press
Dizabled hd [+ Programmed Channels Only on Display

Backlight Lewvel: Qff -

Global Emergency Channel v Horm Cadence: m ’—j

p - . Controller Tppe: Mormal -
iz ZONET Fimimum Yolume: |0 j S =
Channel: 1 = T ane Yolume: ID—jI Mic Levels Yolurne Ticks: 05
Cursor [v tMenu Enabled

= ey Managemert v Ch. | Selector Enabled
Cursor Time Out: |0 =00 : o arnel Selector Enable
e T =] Made: SLN [CKE Eeys Table [ Ignore Clear/Secure Switch when Strapped
ursor Fosition: Zone :|v Infinite: Key Retention: |Of = [ Surveillance Mode

[ Erasze Keys On Keyset Change

File Badic Transfer Tools Help ‘ .
O2- 3 & N L IR Y = A o i &
Global ] R adio Widel Per System] Zohe ]
>

Global Parameters

Syatems Power F.eppad

Mumber of Spstems: 1 [ Battery Saver Keppad Type: Full K.eypad -

Zones Low Battery Indicators [v Pemanent Keypad Lockouk

Mumber of Zones: 1 [ Low Battery Beep [~ Lock Channel Selector

Home Zone: ZOMET - [ Tx Chip [ Lock Wolume Knab

LED Indiczat
e m [ aliEEliy [~ Front Only Keypad Lockout

Backight ON Tire: [0 -+

" LED Dizabled w/ Backlight OFF

EFT
2

Figure 4-1 Global Parameter Programming Screen

4.1 INTRODUCTION

The Global screen shown in Figure 4-1 programs
parameters that are the same for all systems, channels,

and zones. Only parameters that apply to the selected
Radio Series are displayed and the others are grayed
out. The parametersin this screen are as follows:

NOTE: Passwords have changed and are no longer
programmed on this screen. Refer to Sections 3.4 and
10 for more information.
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4.2 PARAMETER DESCRIPTION
Systems
Displays the number of systems that have been

created as described in Section 1.10.

Zones (A zoneisaprogrammed collection of up 16
channels of any type.)
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Number of Zones - The total number of zones
currently set up. The maximum number allowed

is 16. Zones are created in the Zone > Edit Zones
screen by clicking the “+” button (see Section 6.2).

Home Zone - Selectsthe zone that is selected by the

Home Zone option function button (if programmed).

Power Up In - Selectsif the transceiver powersup on
the Home or Last Selected zone.

Power Up Zone - When data is uploaded from a
radio, thisnumber indicates the power-up zonein the
radio. It does not change until the current dataiis
downloaded and then uploaded again.

Channels

Home Channel - Selects the channel that is selected
by the Home Zone function button (if programmed)
and when the transceiver powers up on the Home
channel. With the 51xx, thisis selectable only if the
channel selector switch is disabled (see “ Channel
Selector Enabled” parameter on page 23).

Power Up In* - Selectsif the Home or Last Selected
channel is selected on power up. With the “Last
Zone' [*Home Channel” power up configuration, the
programmed home channel number of the last active
zone is selected. If that channel number is not
programmed in the active zone, “ Unprogrammd” is
displayed. With the 51xx, only “Home Channel” is
not available if the channel selector switchis
enabled.

Power Up Channdl - Indicates the power-up channel
in the radio similar to the power-up zone just
described.

Global Emergency Channel**

Selectsthe zone and channel on which all emergency
calls and alarms are transmitted regardless of the
type of channel currently selected. For example, if
the global emergency channel is a conventional
channel and a trunked channel is selected when the
emergency isinitiated, it istransmitted on the
conventional global emergency channel.

* This feature available only in 51xx models with Flash code 1.9.0 or
later and (if applicable) 53xx models with ARM code 1.22.0 or later. 20

Cursor (53xx Mobile Only)

Cursor Time-Out - Programs the time delay that
occurs before the cursor (zone or channel select indi-
cator) returnsto the default position programmed in
the next parameter. Times of 0-255 seconds can be
programmed (“0” selects no return).

Cursor Position - Selects if the Zone or Channel
select mode is enabled when power isturned on and
after the preceding time-out period expires.

Battery Saver (Portables Only)

If thisis checked, 51xx and 7780 portables automat-
ically switch to the low transmit power mode when
the RSSI signal indicates the siteis probably nearby
(when operating in the SMARTNET/SmartZone or
P25 trunked modes only).

L ow Battery Indicators (Portables Only)
L ow Battery Beep - When checked, a short tone

sounds periodically in the standby mode whilealow
battery condition is being detected.

Tx Chirp - When checked, a chirp sounds each time
the PTT switch is pressed while alow battery condi-
tion is being detected.

LED Indicator - When checked, the LED on the top
panel indicatesalow battery condition. For example,
the 51xx indicator flashes red in the receive mode.

L ow Power - When checked, low transmit power is
automatically selected while alow battery condition
is being detected.

Ignition Power Down (M obiles Only)

When theignition switch control stransceiver power,
this setsthe delay that occurs between when the igni-
tion switch isturned off and when transceiver power
actually turns off. Times of 0-254 minutes or an
infinite time (no turn-off) can be selected.

Soft Power Down (51xx Only)*
The soft power down feature prevents radio power

from being turned off by accidentally turning the top

** This feature available only in 51xx/53xx models with Flash
code 2.x or 3.x (see Section 16).
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panel on-off/volume control. Any side option button
can be programmed for this function (in addition to
itsnormal function). Then for power to turn off, this
button must be pressed during or just after power is
turned off by the on-off/volume control.

Sound

Alert Tone On - If checked, all supervisory tones
sound. If not checked, no tones sound.

Horn Cadence (53xx Only) - Programsthefollowing
styleswhen the horn alert isenabled by the horn alert
option switch. Repeating does not occur with either
style.

Syle1- Thehornison for 1 second and off for
0.5 second for three cycles.

Style 2 - The horn sounds continuously for the
programmed time (2-255 seconds).

Minimum Volume (Mobiles and 5100 Portable) -
Sets the minimum volume level that can be selected
by the volume control. This can be used to prevent
mi ssed messages caused by inadvertently turning the
volume down too far. Relative levels of 0-255 in
steps of 15 can be set (0" sets the lowest minimum
volume).

Tone Volume* - This adjusts the alert tone volume
level relative to the volume control setting. This can
a so be done by a Tone Volume Edit option button if
programmed. Changes made by this button perma-
nently overridethissetting. Relativelevelsof —170to
+170 can be set with “0” the standard default setting.

Miz Levels ...

| Mic Levels- Displaysthe following
screen which sets the microphone sensitivity for
various types of calls. Relative levels of O (less
sensitive) to 4 (most sensitive) are set for Analog,
Digital, and SecureNet® (encrypted) calls with “4”
the default. This can only be set with 51xx models
which have Version 1.6.0 or higher Flash code, and
53xx models must have Version 1.38.0 or higher
DSP cade (or any 2.x/3.x code with both models).

* This feature available only in 51xx models with Flash code 1.9.0 or
later and (if applicable) 53xx models with ARM code 1.22.0 or |ater.

Mic Lewvels

Mic Level Setting

/DKI

X Cancel |

Analog Digital SecureMet

|4 - LoudestLI |4 - Loudest;l

Irkencannect: |4-L0udele| |4-LoudestL| |4-Loudest;|

Marmal:

Key Management

The following modes select the method used to
load and manage encryption keys. The Motorola
keyloader has ASN and Astro 25 modes. The ASN
mode can load analog channel keys (DESIDES-XL)
only, and the Astro 25 mode can load both analog and
digital (DES-OFB/AES) channel keys.

Mode - Select the PID/ASN or SLN/CKR mode as
follows. Note that the keyloader can operate in only
the ASN mode when PID/ASN is selected, and in
either the ASN or Astro 25 mode when the SLN/CKR
mode is selected.

PID/ASN Mode - Select this mode to load anal og
channel keysdirectly into aKey PID (Physical 1D)
from 0-15. Digital channel keys cannot be loaded
in this mode, OTAR (Over-The-Air-Rekeying) is
not available, and the Keys Table is not used.

SLN/CKR Mode - Select this mode to load keys
into a SLN/CKR location from 1-4095 instead of a
Key PID location from 1-16. This mode is aso
selected and to program the radio for OTAR. Up to
16 CKRs are specified, and the following key
(alias) table links each CKR to aKey PID. SLN
(Storage Location Number) and CKR (Common
Key Reference) are equivalent terms.

T KepsTable | - Clicking this button displays the
following screen which associates Key PIDs 1-16
with the SLN/CKRsfrom 1-4095 specified when the
key isloaded. Thistable must be programmed if the
preceding SLN/CKR mode is selected. The SLN/
CKR number points to a specific key or key dot of
the two keysets with OTAR. The 10-character Key
Aliasisdisplayed briefly by the radio when transmit-
ting, changing channels, and switching between the
clear and secure modes.

Infinite Key Retention** - If “On” is selected, keys
are stored in memory and are not lost when power is
removed. If “Off” is selected, the keys are

** Thisfeature available only in 51xx models with Flash code Version

1.11.0 or later and 53xx models with ARM code 1.19 or later.
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OTAR Keys Table Screen

maintained with power removed only until the
storage capacitance discharges (approximately 8

hourswith a53xx mobileand 30 secondswith a51xx

portable).

Erase Keys on Keyset Change (OTAR Only) - If this
is selected, the keysin the original keyset are erased
whenthe OTAR Changeover command or the K eyset
option switchisused to select the other keyset. If this

not selected, the keysin the original keyset are not
erased when this occurs.

Keypad (Portables Only)*

Keypad Type - Selectsif the portable being

programmed has a Full DTMF Keypad or a Limited

Keypad (without the 0-9, *, # DTMF keys).

Permanent Keypad Lockout - If checked, the keys
selected by the following “Front Only Keypad

Lockout” parameter are disabled and cannot be re-
enabled by the user. In addition, the following can

then be selected and locked/unl ocked by a side panel

Keypad Lockout option key if side panel keys are
enabled (“Front Only Keypad Lockout” selected).

Lock Channel Selector - If the preceding param-
eter is selected, checking thislocks the top panel
channel selector switch.

Lock Volume Knob - Likewisg, if the preceding

Permanent Keypad L ockout parameter is sel ected,

checking this locks the volume control function
(but not on-off) of the top panel on-off/volume
control.

* This operation applies only to 51xx models with Flash code
Version 1.12.1/2.2.1/3.2.1 or later.
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NOTE: The channel control can be totally disabled
by the following " Channel Selector Enabled” param-
eter, and the volume control istotally disabled if an
Up/Down volume button is programmed (see
following "Volume Ticks" parameter).

Front Keypad Lockout Only - This controls the keys
that are disabled by the preceding Permanent Keypad
Lockout function or by the Keypad L ockout option
button if programmed. If neither or these functions
are used, checking this parameter has no affect. If
checked, the front panel keys are disabled but the
side panel keysremain active. If not checked, both
the front and side panel keys are disabled.

Other

Hang-Up Box Monitor (Mobiles Only) - When
checked, enables microphone off-hook detection.
Taking the microphone off-hook then enables the
monitor mode (conventional only) and disables
scanning. When not checked, taking the microphone
off-hook has no affect on these functions.

Backlight on Keypress (Portables Only) - If checked,
the backlight turns on for the Backlight On Time
whenever akey is pressed.

Programmed Channels Only on Display (53xx
Only) - If checked, only programmed channels can
be selected, and if not checked, all channels are
displayed. When an unprogrammed channel is
selected, “UNPROGRAMD?” isindicated and atone
sounds.

Backlight On Time (Portables Only) - Programs the
length of time in seconds that the backlight stays on
after it is enabled by pressing a key (see preceding)
or by the Backlight option switch. Times of 0-7.5
seconds in 0.5-second steps can be programmed.

Backlight Level (Mobiles Only) - Selects the back-
light brightness as Off, Mid, or High whenever
power is on. This setting can be overridden by the
Backlight option switch if it is programmed.

Controller Type (53xx Only) - Selects the type of
control head being used. “Normal” is selected with
the standard front or remote mount control head, and
“Handheld” is selected with the Handheld Control
Unit.
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Volume Ticks (51xx Only)** - When a System
Specific Volume Up/Down button is programmed on
the Radio Wide screen, the volume control is
disabled when a channel programmed for that oper-
ating mode is selected. This then selects the number
of button presses (ticks) required to change from
minimum to maximum volume. From 1-50 steps can
be programmed. See also preceding “ Permanent
Keypad L ockout”

Menu Enabled (51xx Only) - Enablesthe menu mode
with 51xx portables. The F1 and F2 keys then
become menu exit and select keys instead of
programmable option keys. If this parameter is not
selected, the menu modeis not available and F1 and
F2 are programmabl e option keys.

Channel Selector Enabled (51xx Only) - Enablesthe
channel select knob in the top panel. If thisis not
checked, the channel select knob is disabled and
channels can be selected only by the Channel Select
option button or menu parameter. See also preceding
“Permanent Keypad L ockout”.

Ignore Clear/Secure Switch When Strapped* - When
selected, the mode selected by the switch (or menu
parameter with the 51xx) isignored and the transmis-
sion aways occursin the strapped mode. |n addition,
theerror toneand* Sec Only” or “Clear Only” are not
indicated when the switch is selecting a different
mode than what is strapped.

NOTE: If all channelg/talk groups are strapped
Clear or Secure and no Clear/Secure option switch
or menu parameter is used, this parameter must
always be selected (see following).

Without the Clear/Secure switch/menu, theradio is
awaysin the last known state (usually Clear) and
there is no way to change it. For example, if the last
known state is Clear and this parameter is not
selected, it is never possible to transmit a Secure
message on a channel strapped Secure because all
that happensistransmitting isdisabled, an error tone
sounds, and “ Sec Only” is displayed.

Surveillance Mode - Disables the transmit/receive
LED indicator, display and keypad backlight, and all

* Thisfeature available only in 51xx models with Flash code Version
1.9.0 or later and 53xx models with ARM code 1.22.0 or |ater.

** This feature available only in 51xx models with Flash code
Version 1.11.0 or later and 53xx models with ARM code 1.24 or later. 23 3.2.1or later.

alert tones. This provides a quick way of totally
disabling these functionsin all operating modes. It
overrides any other programming of these functions
such as a Tone or Backlight option switch.

LED Disabled w/Backlight Off (5300 Only)*** -
When selected, the front panel transmit indicator is
disabled whenever the display backlight isoff. If itis
not checked, thisindicator operates normally regard-
less of the backlight state (except when the surveil-
lance mode is selected).

4.3 PAGE 2 DESCRIPTION (53XX ONLY)

With the 53xx mobile only, a second Global

screen which follows is opened/closed by clicking the

»> buttonsin the upper right corner of the screen.

These additional parameters are then displayed:

Global / &dditional Parameters

P Other

[v RxAudio to External PA Avgilliary B Output: | Dizabled i
[ Esternal P& Display Indication Augiliarg B Input | PA Broadeast |+

Rx Audio to External PA - Microphone audiois
always routed to the Ext PA line of the accessory
cable. If this parameter is selected, the receive audio
signal is aso routed to thisline.

External PA Display Indication - If thisis selected,
“Ext PA On” isindicated continuously in the display
when the external PA function is enabled by the Ext
PA option button. If itisnot selected, “ Ext PA On/Off
is flashed in the display when a button is pressed.

Auxiliary B Output - Determines the function
controlled by the horn output of the microcontroller.
“Backlight” is selected to control the backlight of the
Siren Controller, “Horn” is selected to control the
horn aert, and “Disabled” is selected if neither is
used.

Auxiliary B Input - Ext Emergency is selected if an
external emergency switch such as afoot activated
typeisused (not currently supported). The PA
Broadcast selection is used with the Transit Bus PA
system only, and Disabled is selected if neither is
used.

*** This feature available only with code Version 1.24.1/2.2.1/
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SECTION 5 RADIO WIDE SCREEN
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Figure 5-1 Radio Wide Conventional Screen

5.1 INTRODUCTION

The Radio Wide screen programs parameters that
are the sasmefor al Conventional, Project 25 Trunked,
and SMARTNET/SmartZone systems (a different
screen is displayed for each system type). These
screens are shown in Figures 5-1, 5-3, and 5-4.

5.2 RADIO-WIDE SCAN LIST PROGRAMMING

NOTE: The radio-wide scan list cannot be
programmed until all channelsto beincluded in it
have been set up in the Zone screens (see Section 6).

The Radio Wide scan list isthe same for al
system types and can include up to sixteen channels
from any system. This scan list is programmed by
clicking the ‘= Edit Sean List | button on this screen or
in the toolbar. The following Radio Wide Scan
List screen isthen displayed.

To select the channels that are in the radio wide
scan list, click the | 1 button to display the

Modify Scan List screen. Select the desired zones
from the drop-down list and then check the channelsto
be included from each zone in the list.

T 5o oo 5o Channols
Sean Tak Back Tyow o 0% I
Soan Lt | Mnﬂvj

Me Zone Abat

Radio Wide Scan List Screen
Modify Scan List Screen

Radio-Wide Scan List Screens

Scan Talk Back Type

When a call is received while radio wide scanning,
this determinesif a response occurs on the Selected
Channel or the channel of the call (Active Channel)
when they are not the same.

24
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Fadio Wide Function Buttons

i~ Conventionat

Click Button
Here To
Program It

W Dizplay Information
= Emergency
Ml Hardware Key
S Hi/La Pawer

Function Button Aszignments;

F1: Unprogrammed
F2: Unprogrammed
F3 Unprogrammed
F4: Unprogrammed
F5: Unprogrammed

F&; Unprogrammed

x Cancel | ? Help |

Figure 5-2 Assign Function Buttons Screen (53xx Series Shown)

Scan Hold Time

When Radio Wide scanning is occurring, this
programs the delay that occurs after amessageisno
longer being received or transmitted before scanning
resumes. Times of 0 - 7.5 seconds can be
programmed.

5.3 MENU ITEMS PROGRAMMING (5100 ONLY)

Radio Wide Menu tems
~Conventional

Awailable [bems: Programmed ltems:

Alert Tones Alert Tones

BackLight Clone

Channel Select HiLo Power

Clear/Secure Haome Zone t
Clare

Config

Digital TG Select 1 |
Dizplay Information

Emergency

Hi/Lo Power

o DK | X Cancel | ? Help |

The menu function is available with 51xx porta-
bles only. The menu mode can be user selected if the
“Menu Enable” box on the Global screen is checked.
Clicking the | Bk assignJtems ... | button displays the
preceding screen which is used to select the functions
that are selectable in the menu mode. To move afunc-
tion to the other list, double click it or select it and
click one of the single arrow buttons. Clicking a
double arrow button move all items to the other list.
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A separate set of menu parameters can be
programmed for each system type similar to the func-
tion buttons described in the next section. The system
type being programmed is selected in the “ System
Specific” box of the Radio Wide screen. Functions can
be controlled by both the menu and a function button
if desired. The available 51xx menu functions are
shown in Table 5-1.

5.4 FUNCTION BUTTON PROGRAMMING

Clicking |i -1 in the Radio Wide screen
displays a screen similar to the one shown in
Figure 5-2 that programs the function buttons for the
radio selected by Radio > Series.

Each button can be programmed with up to three
different functions. One function can be programmed
for Conventional systems, a second for SMARTNET/
SmartZone systems, and athird for Project 25 Trunked
systems. The system type is selected in the “ System
Specific” box of the Radio Wide screen. The available
51xx/53xx option button functions are shown in
Table 5-1.

NOTE: To view the functions programmed for each
button in the various modes, select Radio > View
Programmed Radio Wide Functions (see Section 3.2).

Program the function buttons as follows:

1. Click the white “Fx” button being programmed in
the photo and adrop-down list is displayed showing
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Table 5-1 51xx/53xx Programmable Option Switch and 51xx Menu Mode Functions

_ Availablein Mode: 5100 M enu
Function )
Conv. P25 Trk |[SMARTNET|SmartZone Display

Alert tones On-Off X X X X Tones
Backlight On-Off (51xx), Hi/Med/Off (53xx) X X X X Backlight
Call Alert Select (Paging) X X X X Call Alert
Call Response Select X X X Cdl Rsp
Change Keyset (OTAR) X X X X Chg Keyset
Channel Select X X X X Chan Selct
Clear/Secure Encryption Select X X X X Security
Clone Programming Select (51xx menu only) X X X X Clone
Configure (51xx menu only, not curr used) X X X X Config
Digital (P25) Talk Group Select X Select TG
Display Information Select (freq or chan disp) X Display
Emergency Mode Select X X X X Emergency
Erase Keys, OTAR (menu only w/51xx) X X X X Erase Keys
External Public Address (53xx only) X X X X -
High/Low Power Select X X X X Tx Power
Home Zone Select X X X X Home Zone
Horn Honk Select (53xx only) X X X X -
Key Select, OTAR X Key Select
Keypad Lock Select (51xx only) X X X X (Opt sw only)
Keypad Programming Select X Keypad Prg
Messaging Select X X X Message
Monitor Mode Select X Monitor
Normal/Selective Squelch Select X Squelch
OTAR Rekey Request X OTAR Rekey
P25 Packet Data X Data Modes
Phone Call Select X X Phone
Priority Channel Select X Priority
Private Call Select X X Priv Call
Radio Wide Scan Select X X X X RW Scan
Remote Access (Pyramid Repeater) 53xx only X X X X -
Repeater Talk-Around Select X Talk Arnd
RWS List Edit X X X X RWS Edit
Scan Mode Select X X X X Scan
Scan List Edit Select X X X X Scan Edit
Scan List Select X (5100 only) X X X Scan Selct
Set User Password X X X X Set Paswd
Squelch (Code) Select List X Sqglch Code
Single Tone Encoder (51xx only) X Tone Encdr
Site Lock Select X X Site Lock
Site Search Select X X Site Srch
Status Select X X X X Status
Surveillance Mode Select X X X X Surv Mode
Tone Volume Edit X X X X Tone Vol
Unit Call Select X X Unit Call
Unprogrammed (not used) X X X X -
Volume Down (51xx only) X X X X (Opt sw only)
Volume Up (51xx only) X X X X (Opt sw only)

NOTE: Several functionsin thistable are available only in

radios with later versions of firmware .
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the functions that can be assigned (with the 51xx
portable, almost all buttons are programmable).

To select afunction, doubleclick itinthedrop-down
list. The functions that have been assigned to each

button are displayed in the bottom part of the screen.

Repeat for all function buttons that are to be
programmed. Then click OK to exit and save the
changes or Cancel to exit without saving the
changes. Then select the other system type if
applicable and repeat this procedure.

5.5 RADIO WIDE CONVENTIONAL
PARAMETERS

Clicking “Conventional” in the “ System
Specific” box displaysthe screen shown in Figure 5-1.
This screen programs the functions that are the same
for al Conventional systems. Refer to Section 5.6 for
information on programming SMARTNET/SmartZone
systems, and to Section 5.7 for information on
programming Project 25 Trunked systems.

IDs

Digital Unit ID - When operating on a Project 25
(digital) channel, this number identifies the radio.
Each radio must have a different ID, and it must be
between 1 and 16,777,216.

DTMFPTTID - The PTT ID is used on achannel
programmed for pre- or post-transmit ANI. ThisID
consistsof eight digitsfrom 0-9. The ANI functionis
programmed on the channel screen described in
Section 7.2 or 7.3.

Unit RSl - This setsthe individual Radio Set Identi-
fier of theradio that isused for OTAR (Over-the-Air
Rekeying). Initialy, it can be set to the Digital Unit
ID only, but later changed by OTAR if desired.

* Thisfeature available only in 51xx models with Flash code Version

1.9.0 or later and 53xx models with ARM code 1.22.0 or later.
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DTMF Emergency ID - This setsthe ANI number
transmitted if the “Emergency ANI Call” and/or
“Emergency Alarm” analog emergency features are
selected on the conventional Per System screen (see
Section 7.1).

Clear Alert Tone

If checked, a short beep sounds to indicate that
the clear (non-encrypted) mode is selected. This tone
sounds with SecureNet and digital OFB encryption
only.

Display Options
These functions select if anything is displayed
aternately with the selected channel alias or frequency

when Project 25 group calls are received.

None - Only the selected channel alias or frequency
is displayed.

Both (51xx/53xx only) - Both of the following are
displayed.

P25 PTT ID (51xx/53xx only) - The D of themobile
placing the call isdisplayed. ThetimethisID is
displayed is programmable for 0.5-7.0 seconds* or
infinite. When “infinite” is selected, thisID is
displayed for the entire call and none of the other
parameters are displayed.

P25 Talk Group on Rx (51xx/53xx only) - The dlias
of the talk group on which the call is being received
isdisplayed. This can also be displayed for 0.5-7.0
seconds* or infinite as just described.

User Group ID (51xx/53xx only)** - If the ID of the
call being received isincluded in a User Group 1D
list (see page 37), the alias of that group isdisplayed.
This alias can aso be displayed for 0.5-7.0 seconds
or infinite as just described.

** Thisfeature available only in 51xx models with code 1.12.1/2.2.1/
3.2.1 or later and 53xx models with code 1.24.1/2.2.1/3.2.1 or later.
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Figure 5-3 Radio Wide SMARTNET/SmartZone Screen

5.6 RADIO WIDE SMARTNET/SMARTZONE
PARAMETERS

Clicking “ SmartNet/SmartZone” in the “ System

Specific” box (if applicable) displaysthe screen shown
in Figure 5-3. This screen programs the functions that

arethe samefor all SMARTNET and SmartZone
systems. Refer to Section 5.5 for information on
programming Conventional systems, and to Section
5.7 for information on programming Project 25
Trunked systems.

Full Spectrum CC Scan

If al potential control channel frequencies have
been searched, the radio enters a channel-by-channel
search across the full spectrum the radio covers. The
timer sets the length of time this scan is performed

before checking the expected frequencies again. After
these frequencies are checked, full spectrum scanning

resumes. This cycle repeats until a control channel is
found.

Full Spectrum CC Scan - Checking the box enables

full spectrum scan.

Scan Time - Setsthetimethat full spectrum scanning
occursasjust described. The selectablerangeis5-31

seconds and the default is 5 seconds.
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Display Options - Same as conventional P25 display
options described on page 27. The “Both” selectionis
not available with the 7780/9883.

Trunking

Display Site Trunking - If thisis selected, “Display
Site Trunking” isdisplayed if the affiliated site loses
communication with the zone controller and is oper-
ating in the “ Site Trunking” mode.

Alert Site Trunking - If thisis selected, an alert tone
sounds and “ Site Trunking” is displayed if the affili-
ated site loses communication with the zone
controller and is operating in the “ Site Trunking”
mode.

Failsoft | nactivity - Programsfail soft operation. If the
radio remains inactive (no receive or transmit activity
on channel) while operating in the failsoft mode for
the programmed time, the radio momentarily leaves
the failsoft mode and attempts to find a control
channel. If “0” is programmed, the radio does not
leave the fail soft mode.

Affiliation Hold Off - With SmartZone operation, this
isthe delay time that occurs after acquiring the control
channel before it sends an affiliation ISW. This
prevents all radios on the system from sending affilia-
tion ISWs at the same time.
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Figure 5-4 Radio Wide Project 25 Trunking Screen

Talkback Scan - When acall isreceived while scan-
ning, this determinesif a response made before scan-
ning resumes occurs on the Selected talk group or the
talk group of the call (Active) when they are not the
same. The Scan Hold Time is programmed on the Per
System screen.

Out-of-Range I ndication - Selectsif the periodic tone
sounds, “Out of Rng” (or “NO SYS") is displayed, or
if both or neither of these indications occur when an
out-of-range condition exists.

5.7 RADIO WIDE PROJECT 25 TRUNKED
SYSTEM PARAMETERS

Clicking “Project 25 Trunked” in the “ System
Specific” box displays the screen shown in Figure 5-4.
This screen programs the functions that are the same
for all Project 25 trunked systems. Refer to Section 5.5
for information on programming Conventional
systems, and to Section 5.6 for information on
programming SMARTNET/SmartZone systems.
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RSS| Threshold

This sets the RSSI (Receive Signal Strength Indi-
cator) levels which determine when searching for and
switching to another site occurs. Clicking the “ Restore
Defaults’ button restores these levels to the default
setting. If the “Hex” box is checked, the RSSI levels
are displayed in the hexadecimal instead of decimal
notation.

NOTE: The default RSS levels should not be changed
unless you are familiar with how this levels affect
radio operation.

Full Spectrum CC Scan

If al potential control channel frequencies have
been searched, the radio enters a channel-by-channel
search across the full spectrum the radio covers. The
timer sets the length of time this scan is performed
before checking the expected frequencies again. After
these frequencies are checked, full spectrum scanning
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resumes. This cycle repeats until a control channel is
found.

Full Spectrum CC Scan - Checking the box enables
full spectrum scan.

Scan Time - Setsthetimethat full spectrum scanning
occursasjust described. The selectablerangeis5-31
seconds with a default of 5 seconds.

Failsoft

Programs fail soft operation which occurs when
there isa controller or other major system failure.

Failsoft Inactivity Duration - Sets the time the radio
must remain inactive (no receive or transmit activity
on channel) inthefailsoft modefor it to momentarily
leave the fail soft mode and attempt to find a control
channel. If “0” is programmed, the radio does not
leave the fail soft mode.

Emergency Blocked - If thisis checked, emergency
calls are disabled when in the fail soft mode.

Ring Time

Individual Call Maximum Target Ring - Sets the
maximum ring time of the target mobile when
receiving phone and unit-to-unit calls. When this
time expires, the call is automatically discontinued.
Times of 61-120 seconds can be programmed with
61 seconds the defaullt.

Private Call Maximum Int Ring - Sets the maximum
time the initiating mobile rings when placing a unit
call (phone calls not included). Ringing stops if the
target mobile answers before this timer expires.
Times of 1-255 seconds or infinite can be
programmed with 30 seconds the default. If infinite
isprogrammed, ringing occursuntil thetarget mobile
answers.

Hold Off Time

Radio Random Hold Off Time - When afailure
occurson asite, this setsthe delay that occurs before
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amobile leavesthat site and registers on another. It
also setsthe delay that occurs before amobilereturns
to asite that has returned to normal operation. A
random timeis cal cul ated between 0 and the sel ected
time. Thistimer starts only when the following
Holdoff delay timer expires. Times of 0-60 minutes
can be programmed with 10 minutes the default.

Holdoff Delay - Setsthe delay in registration or affil-
iation that occurs before starting the preceding
random hold off time. During this delay, monitoring
for over-the-air packets occurs. Times of 5-60
seconds can be programmed with a default of 5
seconds.

Trunking

Display Site Trunking - If thisis selected, “ Site
Trunking” is displayed if the affiliated site loses
communication with the zone controller and is oper-
ating in the site trunking mode. This message is
displayed until the zone controller returns to normal
operation.

Alert Site Trunking - If thisis selected, an alert tone
sounds when entering the site trunking mode just
described.

Other

Display Options - Same as conventional P25 display
options described on page 27.

Talkback Scan - When acall is received while scan-
ning, this determinesif aresponse occurs on the
Selected talk group or the talk group of the call
(Active Group) when they are not the same. The
Scan Hold Time is programmed on the Per System
screen.

Out-of-Range Indication - Selectsif the periodic
tone sounds, “Out of Rng” (or “NO SYS") is
displayed, or if both or neither of these indications
occur when an out-of-range condition exists.
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SECTION 6 SETTING UP ZONES AND CHANNELS

Edit Zones & Channels DOUb|e C“Ck Hel’e
Current zone: Enabled Charnels: [ Al TO D|Sp|ay Screen Below
| Channel | System £ Type~ i
Alias: [ZOMET 1 _T - Corentional
. 2 03: SmariZone
Paszword: 00000000 3 01 Covvsitiohal Diztribute channel 1 of zone ZOMET to:
4 02 : Smarth et g
T -
5 03: SmartZone Ziie g
Os 01 : Canventional Uninitislized Channels:
arz 01 : Corventional #
O:= 01 : Corwventional __éanne
Oa 01 : Corwentional Oe
O1n 01 : Conventional ar
O 01 : Conventional Os
01z 01 : Corwentional Os
O3 01 : Conventional 0o
04 01 : Conventional O
Add new zone az copy of: O+ 0 : Conventional E::g
O1s 01 : Corwventional
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. mﬂne_zl onventional System Specific O
€ Anlog = Digital (P25) O1s
| ]| ] =] Zone 1 0f 1 |
 OK l X Cancel l 7 Help | X Cancel |

Figure 6-1 Edit Zones and Channels Screen

6.1 INTRODUCTION

The following information describes how to set
up zones and assign channelsto each zone. A zone can
include up to 16 channels of any type (conventional
analog, Project 25 conventional, SMARTNET/Smart-
Zone, or Project 25 Trunked).

With al radios except the 51xx portable, up to 16
zones can be programmed for up to 256 channels.
With the 51xx portable, up to 32 zones for up to 512
channels can be programmed if the “512 Talkgroups/
Channels’ option is enabled (see page 13). Otherwise,
up to 16 zones can be programmed.

6.2 SETTING UP ZONES

1. Select the Zone screen (see Figure 7-2). Then click
K EditZane .. | to display the Edit Zones and Chan-
nelsscreen shown in Figure 6-1. Alternatively, click

{1 inthetoolbar.

2. Toadd anew blank zone, select “None” inthe Zone
drop-down list and then click the ﬂ button. To
make a copy of a current zone, select the desired
zone in the Zone drop-down list instead. To delete
the current zone, click the j button.
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3. Todisplay thefirst zone, click ﬂ thelast zone ﬂ;
the previous zone | ; and the next zone, ».

4. Program the alias (identification) that is briefly
displayed when the zone is selected by entering up
to 10 characters in the Alias box.

5. With 53xx mobiles and 51xx portables, aZone
Password can be programmed which must be
entered to perform keypad programming of the zone
(see Section 11.1). If this password is desired, enter
any eight numbers from 0-9. If no password is
desired for the zone, simply leavethisfield all zeros.

6.3 SETTING UP CHANNELS

NOTE: When channels are assigned to zones, the
system of the channel is also selected. Therefore,
before assigning channels to zones, all necessary
systems must be set up as described in Section 1.10.

Channels are set up by assigning them to a zone
in the Edit Zones and Channels screen shown in
Figure 6-1. Proceed as follows to set up any type of
channel (Conventional Analog, Conventional Digital,
Project 25 Trunked, SMARTNET/SmartZone).
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. If necessary, select the Zone screen (see Figure 7-2)

andthenclick | §i Edizore.. | to display the Edit
Zones and Channels screen shown in Figure 6-1.

Alternatively, click yi in the toolbar.

. To assign the channel to a system (if applicable),
select the drop-down list in the “ System/Type”
column and select the desired system.

. Select thedesired zone asdescribed in the preceding
section.

. To add achannel to the displayed zone, check the
applicable box in the “ Channel” column. To select
or de-select al channelsin the box, check or
uncheck the “All” box.

For Conventional channdls, also select the channel
type of each channel by clicking Analog or Digital
(P25) in the “ Conventional System Specific” box.

To copy an enabled channel to unprogrammed chan-
nels of the current zone or other zones, double click
the shaded area of the channel as shown in
Figure6-1. The“ Distribute Channel Data” screenis
then displayed to select the desired channels.

Repeat the preceding steps until the desired chan-
nels are set up in each zone.

To program individual system and channel informa-
tion, refer to Section 7 (Conventional), Section 8
(SMARTNET/SmartZone), or Section 9 (Project 25
Trunked).

SECTION 7 CONVENTIONAL SYSTEMS AND CHANNELS

Global | Fadiowide Per System | Zane |

Systems

Corrrentional
Index_Twoe______ Alias
Carventional S5 TEH

2 Smarthet_1 SYSTEM1

3 SmartZone_1

4 P25 Trunking 1 Per Suster Scan List Settings
Scan Hold Time: 3 ﬁ ls]
Friority Lookback Time A 1 ﬁ 5]
Friority Lookback Time B: 15 j ls]

Def. User Selected Scan List  |None
Individual Call List Settings

i . =
Encryption ke 1D: |1 =i

=

I~
Emergency
[v Emergency Alamm: | Mormal -

[ Ack Alert Tane
[v Emergency Call - Digital

[ Emergency ANI Call - Analog

[~ Emergency Hot Mic  Hat Mic Time: Wﬁ[s]

>

Other
[ Busy Channel Override [ Radio Inhibit
[~ Keppad CTC55/DCS [ Radio Check
Timers
T« Time Out; 0 j‘ (5]
Penalty: 0 ﬁ (]
Corversation: a ﬁ [s]
AM
Iitial D elay: 0 j [ms)
Crigit Duration: ﬁ [mz)
Inter Digit Delaw: 50 ﬁ [mig]
OTaR
OTAR Enabled: On =

Data Feqistration Enabled: A

OTAR Time Out; :ll 5]

Single Tone Encoder

7.1 INDIVIDUAL CONVENTIONAL SYSTEM
PARAMETERS

Spstem Lists : = I =
l—_|8tatus Aims List |+ 5=; EdtList . Frequency: | 1050 = [Hz] Duratior: {1.5 =i [z]
4 b
Figure 7-1 Individual Conventional System Screen

Individual system parameters are programmed by
the “Per System” screen shown in Figure 7-1. These
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parameters can be programmed after the desired
systems have been set up as described in Section 1.10.

There are also radio wide parameters that are

programmed by the Radio Wide screen as described in



CONVENTIONAL SYSTEMS AND CHANNELS

Section 5.5. For information on programming
individual SMARTNET/SmartZone and Project 25
Trunked system parameters, refer to Sections 8.1
and 9.1. The parametersin the individual Conven-
tional System screen are as follows:

Per System Scan Lists Settings

These parameters set various timers that control
standard scanning when a channel assigned to the
system is selected.

Scan Hold Time - Sets the delay that occurs before
scanning resumes after asignal isno longer received.
Times of 0 -7.5 seconds can be programmed.

Priority Lookback Time A - Thistime determines
how often the priority channel ischecked for activity.
Times of 0.25-4.00 secondsin 0.25-second steps can
be programmed.

Priority Lookback Time B - Thistime determines
how often the priority channel is checked once an
incorrect Call Guard (CTCSS/DCS) or NAC codeis
detected. Since it takes much longer to detect an
incorrect Call Guard signal than a carrier, thistime
should berelatively long to prevent the interruptions
from making a message difficult to understand.
Times of 0.5-8.0 seconds can be programmed in
0.5-second steps.

Default User Selected Scan List - Selectsthe scan list
that is always selected on power up. A different scan
list can be temporarily selected using the Scan List
option switch or menu parameter (if applicable).

Individual (Unit) Call List Settings (P25 Only)

Encryption Key ID - Selects the location from 0-15
(PID/ASN mode) or 1-16 (SLN/CKR mode) of the
key used for secureindividua calls on the system if
applicable.

Cdll Timer - Used with 5300, Rev 4, logic board only
to set the maximum time the radio remainsin the
individual call mode after an individual cal is
received. A response must be made before thistimer
expires. With Rev 6 and later boards and other
radios, the call is ended by pressing the Call button.

* Thisfeature available only in 51xx models with Flash code Version

1.8.0 or later and 53xx models with ARM code 1.21.0 or later.

Emer gency (Conventional)*

Emergency Alarm - If this box is checked, emer-
gency alarms are sent by pressing the Emergency
option switch. In the P25 mode, an emergency alarm
isaspecial P25 data transmission. In the analog
mode, itisaDTMF Emergency ID that issent. This
ID is programmed on the Conventional Radio Wide
screen described in Section 5.5.

Normal/Silent - When “Normal” is selected and an
emergency alarm is sent, the red transmit indicator
lights, an emergency tone sounds, and EMERGNCY
flashes in the display. EMERGNCY continues to
flash until power iscycled, the channel ischanged, or
the Emergency switchispressed and held. If “ Silent”
is programmed, none of these indications occur.

Acknowledge Alert Tone - If selected, an alert tone
sounds when the emergency alarm is acknowledged
by the dispatcher.

Emergency Call - Digital - EnablesEmergency Calls
on conventional P25 channels. When the Emergency
button and then the PTT switch are pressed, an emer-
gency cal istransmitted. To exit the emergency
mode, change the channel, cycle power, or pressand
hold** the Emergency switch.

Emergency ANI Call - Analog - Enables Emergency
Calls on conventional analog channels. When the
Emergency button and then the PTT switch are
pressed, the Emergency DTMF ID is sent every
transmission (in place of the DTMF PTT ID if
applicable). To exit the emergency mode, change the
channel, cycle power, or press and hold** the Emer-
gency switch.

Emergency Hot Mic - When this box is checked and
an emergency alarm is sent by pressing the Emer-
gency switch, automatic transmitting occurswith the
microphone audio unmuted (without user interven-
tion) for the time specified by the following Emer-
gency Hot Mic Time. If it isnot checked or if an
emergency call isnot selected, automatic transmis-
sions do not occur. This feature isinitiated only by
the first press of the Emergency switch. Subsequent
presses do not trigger automatic transmissions. To
reset this function, the channel must be changed or
power cycled.

** Thisfeature available only in 51xx models with code 1.12.1/2.2.1/
3.2.1 or later and 53xx models with code 1.24.1/2.2.1/3.2.1 or later.
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Emergency Hot Mic Time - Defines the period
during which automatic transmissions occur. Times
of 10-120 seconds in 10-second steps can be
selected.

System Lists

~System List:

|Call List =1

= EditList ... |

The various conventional system lists are
programmed by selecting them in the System Lists
drop-down list shown above and then clicking the Edit
List button. Descriptions of the various lists and the
information they program follow.

SatusAliasList (P25 Only)*

No  [alias | &dd |
1 OFF DUTY
2  JoNDUTY Delete |
3 AT LUMCH
4 0OM PATROL|

x Cancel |

? Help |

b ax Entries: 8

The Status Alias List screen shown above programs
the aliasfor each of up to eight status conditions that
can be sent. The meaning of each status number is
defined by the system manager.

To display this screen, on the Conventional Per
System screen, select Status Alias List in the drop-
down list and then click the = EedtList... | button (see
Figure 8-1).

To add an dlias, click the | & | button, and to
delete an alias, simply select it and click the Delete
button. To edit an alias, select it and change it as
desired. Up to 10 characters can be entered that iden-
tify the status. Thisidentification is displayed when
the user selects a status condition.

* Thisfeature available only in 51xx models with Flash code Version

1.8.0 or later and 53xx models with ARM code 1.21.0 or later.

Message Alias List (P25 Only)*

The Message Alias List screen shown below associ-
ates an alias (name) with each message number. The
meaning of each message number is defined by the
system manager.

No  [alias | Add

1 QT OF CaR
Delete |

2 AT OFFICE|

x Canicel |
? Help |

tdax Entries: 16

To display this screen, on the Conventional Per
System screen, select Message AliasList inthe drop-
down list and then click the ' = EdtList... | button (see
Figure 8-1).

To add an dlias, click the | | button, and to
delete an alias, smply select it and click the Delete
button. To edit an alias, select it and change it as
desired. Up to 10 characters can be entered that iden-
tify the status. Thisidentification is displayed when
the user selects a message.

Call List (P25 Only)

Mo [alias [ID | Add
1 |G BLaCK 1
2 [k sMiTH 3 ﬂl
2 |TAvaN B
o 0K
x Cancel |
? Help |
Max Entnes: 16

This Call List screen shown above sets up the IDs
used to placeindividual calls on conventional digital
(Project 25) channels. Thislist is not used with
conventional analog channels.
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To display this screen, on the Conventiona Per
System screen, select Call List in the drop-down list
and then click the = EdiLit... | button (see

Figure 8-1).

Toadd acal, clickthe | au | button, and to delete
an call, smply select it and click the Delete button.
To edit an Aliasor ID, select it and enter the desired
information as follows:

Alias- Uptoten characters can be entered to identify
the user being called. Thisidentification and the ID
are dternately displayed when the call is selected by
the user. Only uppercase letters can be entered, so
lowercase |etters are automatically converted to
uppercase by the program.

ID - Thisisthe ID of the radio being called. Valid
entriesare 0 - 16,777,216.

Talk Group List (P25 Only)

Cornventional Talk Groups

rGrowp D

—Selected Group e
1D I‘I ™ HexID ;I
Aliaz: ITﬁLKG ROUP1

Security Parameter

mmhwmi

Strapping Mode;

Encryption Kew 1D: |0 =

Total & tax Groups: 255 rr

The Talk Group screen shown above sets up the Talk
Groups used to place group calls on conventional
digital (Project 25) channels. Talk groups are not
used with conventional anal og channels. Talk groups
are assigned to channels on the channel program-
ming screen described in Section 7.3.

To display this screen, on the Conventiona Per
System screen, select Talk Group List in the drop-
down list and then click the = EdiList... | button (see
Figure 8-1).

To add atalk group, click the [ aa | button, and to
delete an talk group, simply select it and click the
Delete button.
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To add an entire block of talk group IDs or a specific
ID, click the arrow button | »» inthe lower right
corner of the screen. The following screen isthen

displayed:

Add Mod

| Multiple =l

kultiple Ad

Start [D: I'l O]
D Caunt: |2
|0 Step: |1

Add Mode Drop Down List - “Single” adds the next
available ID similar to the preceding “Add” button.
“Multiple” addsablock of IDsasfollows. To initiate
the selected add operation, click the preceding “ Add”
button. If the specified ID range resultsin duplicate
IDs, an error message is displayed and no IDs are
added.

Start ID - Specifies the starting 1D of the block.
ID Count - Specifies the number of IDs to be
added.

ID Step - Specifiesif consecutive | Ds are added or
some other step rateis used.

For example, if Start ID =10, ID Count =5, and ID
Step = 10, the IDs added are 10, 20, 30, 40 and 50.

Toeditan ID or Alias, select it and enter the desired
information as follows:

Alias- Theadliasistheidentification that isdisplayed
when the Talk Group is selected, and up to 10 char-
acters can be entered. Thisdrop-down list selectsthe
Talk Group to be edited if applicable.

Group ID - Group IDs can be any number from 1-

65535. Group IDs can be entered as decimal or hexa-
decimal numbers (if “Hex ID” is checked).

Strapping Mode

Clear - All transmissions on the group occur in the
clear (unscrambled) mode.

Secure - All transmissions occur in the secure
(scrambled) mode.
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Systern Scan List
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Standard Scan List Programming Screens

each scan list. In addition, it selectsif priority
sampling is used and also the type of priority
channel. The following modes are available:

Switched - The clear or secure status of the group
is selected by the Clear/Secure option switch.

Encryption Key ID - Selects the location from 0-15
(PID/ASN mode) or 1-16 (SLN/CKR mode) of the
key used for secure calls on the group if applicable.

Priority Scan List

NOTE: It may be necessary to define specific
channel parameters before programming the
conventional scan lists as follows (see Sections 7.2
and 7.3).

Clicking the = EdiScanList... | button displays the
preceding screen which programs the standard scan

lists that are selected on the system.

List Number - This drop-down list selects which of
the scan liststo program. Click the “Add” button to
add ascan list and “Delete” to delete a scan list.

User Editable - If thisbox ischecked, user editing of
the scan list is allowed. The Scan Edit function
switch is then required. User editing can be enabled
or disabled on each scan list.

NOTE: With the 51xx and 53xx, Priority 1 and 2
channelscan be programmed. ThePriority 1 channel
is sampled while listening to a call on the Priority 2
channel but not vice versa. Priority sampling does
not occur while listening to any type of digital call.

Scan Mode - Sets the channel on which transmis-
sions occur when the PTT switch is pressed while
scanning. A different mode can be programmed for
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No Priority - Priority sampling does not occur (all
channels are scanned in sequence). Theradio
transmits on the selected channel.

Priority/Tx Selected - Priority sampling occurs
and the priority channel(s) are those programmed
in the selected scan list. The radio transmits on
the selected channel.

Priority/Tx Priority (1) - Priority sampling
occurs and the priority channel(s) are
programmed in the selected scan list. Theradio
transmits on the priority (1) channel.

Priority (1) on Sel Chan - The priority (1)
channel is always the selected channel. The radio
transmits on the selected channel.

Talkback - No priority sampling occurs. The
radio transmits on the channel of a call while
scanning is halted. Then when scanning resumes,
it transmits on the selected channel.

If the" Priority/Tx Priority” or * Priority/Tx Selected”
mode is programmed, the priority channel must then
be chosen for the scan list. To do this, click the box
next to the desired channel.

Select the Priority 1 channel in the Priority 1 column
and if aPriority 2 channel isalso used, select it inthe
Priority 2 column.



CONVENTIONAL SYSTEMS AND CHANNELS

(Modify) - To add or delete channelsfrom
aligt, click this button to display the Modify Scan
List screen shown in the preceding illustration.
Select the channels from each zone that are to be
included in the selected list (up to 16 channels
maximum).

O | - (OK) - Clicking this button closes the
screen and saves the changes.

X cancel | (Cancel) - Clicking this button closes the
screen without saving any changes.

CTCSS/DCSNAC List

This displaysthe following screen that programs the
list of CTCSS/DCS (Call Guard) and NAC (P25)
codes that can be selected if the Selective Squelch
option switch is programmed or the Keypad CTCSS/
DCS function which follows is programmed.

CTCSS/DCS,/NAL Lisk

x|

No [ T#CTCSS/DCS | TwNAC [ R#CICSS/DCS [ RuNAC [ o Ok, |

1 67.0 [CTCSS) 53(D)/293[H) 670 [CTCSS) 659 D)/ 293 H)

2 None £53 (0)/ 233(H]  Hone £53 (D) 293 [H) X Corcel |

3 E2h LTSS E55 (D 27 [H] ] £S5 [D)) 293 [H]

4 948 (L1C55) B59(D)/ 293(H) 670 (CTCSS) 653 (D) 299 H) o |
Edit CTCSS/DSC/NAC x| / =
Walues for (i ~ 7 0% I /&I

Delete |
NAC [Deck  [659 NAC Hen: [233 X Cancel |

“? Help |
 CTCSS/DCS 7 -
[ CTess 525 7

Total: 4

wraw Entiies. 64

To add acodeto thelist, click the Add button and an
additional screen like the one shown aboveis
displayed. Different codes can be programmed for
thetransmit and receive modes by sel ecting the mode
inthedrop down list. In addition, carrier squelch can
be programmed instead of a CTCSS/DCS code by
unchecking the CTCSS/DCS box. To change acode,
select it and then click the Modify button. Up to 64
different codes can be programmed. A CTCSS/DCS
code table is shown on page 79.

User Group ID List**

This User Group ID List screen which follows
programs aliases that can be displayed if acall is
received on atalk group 1D within the programmed
block. For example, with the following screen, if a
group call isreceived on group IDs234-264, thealias
“Fire” can be displayed. The display of thisdiasis

* Thisfeature available only in 51xx models with Flash code Version

1.8.0 or later and 53xx models with ARM code 1.21.0 or later.
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controlled by the “User Group ID” parameter on the
Radio Wide screen.

£
Mo |Alias [Start 1D [5tap 1D [ fidd
1 FIRE 234 264
2 |PoLICE 265 275 Delete |
x Cancel I
P Help |
tax Entries; 32
Other

Busy Channel Override - If selected, the busy
channel lockout feature can be overridden by quickly
releasing and then pressing the PTT switch.

Keypad CTCSS/DCS- If selected, a code for the
selected channel can be directly selected from the
programmed CTCSS/DCS/NAC list using the
keypad. For example, pressing the “3” key selects
code number 3 from thetable. No other functionscan
then be assigned to the keys. If thisis not selected,
these codes can be selected only by the option button
or menu parameter for that function.

Radio Inhibit (P25 only)* - If selected, the dispatcher
can send a command which disables the radio.

Radio Check (P25 only) * - If selected, the dispatcher
can send a message requesting a response from the
radio (to check if it isin operation, for example).

Timers

Tx Time-Out - Thistimer limits the length of indi-
vidual transmissions. Times up to 3 minutes, 45
seconds can be programmed in 15-second steps.

Penalty - Thistimer disables transmitting after the
time-out timer disables the transmitter. Times up to
3 minutes, 45 seconds can be programmed in
15-second steps.

Conversation - Thistimer limitsthe total length of a
conversation. Times up to 7.5 minutes can be
programmed in 0.5-minute steps.

* This feature available only in 51xx models with code 1.12.1/2.2.1/
3.2.1 or later and 53xx models with code 1.24.1/2.2.1/3.2.1 or later.
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ANI

NOTE: The eight-digit DTMF PTT ID is programmed
on the Radio Wide Conventional screen, and pre and
post ANI is enabled on the analog channel screen.

Initial Delay - Setsthe delay before ANI is sent for
0-620 ms.

Digit Duration - Sets the duration of each digit for
50-800 msin 50 ms steps.

Inter Digit Delay - Setsthe delay between digits for
50-800 msin 50 ms steps.

OTAR

NOTE: The SLN (CKR) key management mode must
be selected on the global screen to select the OTAR-
related parameters which follow.

OTAR Enabled - Select “On” to enable OTAR
(Over-the-Air Rekeying) of encryption keys. Select
“Off” to disable this feature.

Data Registration Enabled - Select “On” if OTARis
used. Theradio then registerswith the datasystem on
achannel change (P25 channels only)

OTAR TimeOut* - When rekeyingisinitiated by the
radio (OTAR Rekey Request message sent), this
setting determines how long the radio waits for a
response from the Key Management Facility (KMF).
Times of 20-180 seconds can be programmed.

* This feature available only in 51xx/53xx models with Flash
code 2.x or 3.x (see Section 16).

Single Tone Encoder (51xx Only)

NOTE: Thisfeatureis available only with 51xx radios
that have Flash code Version 1.8.0. or later.

This programs the single tone encoder frequency
and tone duration. Thisfeature is availableif the
Single Tone option button or menu parameter is
programmed. Tone frequencies of 500-2500 Hz at a
duration of 0.5-2.5 seconds can be programmed.

Conventional System Page 2 Screen Description

An additional conventional system screenis
opened/closed by clicking the *> buttonsin the
upper right corner of the screen. The following addi-
tional parameters are then displayed:

Conventional # Additional Parameters
Call Alert Oither
[ Call Alett Decode [~ Call Alert Encode

Call Alert (P25 Only)**

Cdll Alert Decode - If selected, enables call alert
messages (pages) to be received.

Call Alert Encode - If selected, enables call dert
messages (pages) to be sent.

** Thisfeature available only in 51xx models with Flash code
38 ersion 1.8.0 or later and 53xx models with ARM code 1.21.0 or |ater.
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Global | Fadio wide | Per Syste  Zone
rZones <% 3
) Channel Parameter
Alias: IEDN\IENTIDN vl .
—Channel Type —Security
ki EditZone .. | Corventional Analog Strapping Mode:  |SE R
B Security Tepe: ISecurenet ;I
(Channels——————— ICH.‘-\NNEL'I Seramtl g lymEe: |4ED LI
Mumber of Channels: 5§ T« DES: IDES ;I
T rarzmit =
Nc-| System | FewPID: I1 =
—— - Power: |L0w Power ;l
1 01 : Corventional Rx Auta Detect
2 01 : Corventional Tirme Out: Ifo - I
3 01 Comventional - ™| Secuie [~ Proper key
4 01 Corventional Modulation Level |wide 5.0 = [KHz]
@ U1 Cenveniens! Frequency: [e51.0125 fhdHz) I Disabled
Othe
™ CTCSS/DCS '
Busy Channel LockOut [0 =
(r s BRI |l o [ b for =]
I~ Keypad DTHMF
FEEE Pre TN [0F =
: 851.0125
Frequency: (MHz] PostTwaNE [0F =
[~ CTCS5/0CS
’7|_ ETCSS:IE?.D vI il DES:|E|23 vl

Figure 7-2 Conventional Analog Channel Screen

7.2 CONVENTIONAL ANALOG CHANNEL
PARAMETERS

After the desired channels have been set up as
described in Section 6.3, individual channel parame-
ters can be programmed. Select the Zone screen shown
in Figure 7-2 and then select the desired Zone using
the drop-down list in the “Zones’ box. Screens which
program individual channel parameters are selected by
clicking the channel in the “ Channels’ box.

The parameters displayed when a Conventional
Analog channel is selected are as follows. Refer to
Section 7.3 for information on Conventional Digital
(P25) channels. SMARTNET/SmartZone and Project

25 Trunked channels are described in Sections 8 and 9.

Channél Type
Indicates the type of channel (Conventional Analog
or Conventional Digital) that is currently selected in
the “Channels’ box.

Channel Alias

Programs the alias (identification) that is displayed
when the channel is selected.

39

Transmit

Power - Fixes the transmit power on the channel for
the high or low level or makesit selectable (the high/
low power option switch is then required).

Time Out - Enables or disables the transmit time-out
timer on the channel. The time-out timer timeis
programmed on the Per System programming screen
(see Section 7.1).

Modulation Level - Thisselectsif the channel modu-
lationiswideband (5 kHz), narrowband (2.5 kHz), or
NPSPAC (4 kHz). NPSPAC (public safety) modula-
tion applies to 800 MHz models only.

Freguency - Programs the transmit frequency of the
channel.

Disabled - Checking this box disables transmitting
on the channel so that it isreceive only.

CTCSS/DCS - Checking thisbox enables Call Guard
(CTCSS/DCS) squelch control transmission on the
channel. If this box is not checked, no codeistrans-
mitted and squelch is carrier controlled.
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CTCSS - If thisbox is checked, tone Call Guard
(CTCSS) squelch control isused and the desired tone
is selected by the drop-down list. NOTE: A CTCSY
DCScode table is shown on page 79.

DCS - If thisbox is checked, digital Call Guard
(DCS) sguelch control isused and the desired codeis
selected by the drop-down list.

Receive

Freguency - Programs the receive frequency of the
channel.

CTCSS/DCS- Checking thisbox enables Call Guard
(CTCSS/DCS) sguelch control onthe channel. If this
box is not checked, no squelch control coding is
used, and squelch is carrier controlled.

CTCSS - If this box is checked, tone Call Guard
(CTCSS) squelch control isused and the desired tone
is selected by the drop-down list.

DCS - If thisbox is checked, digital Call Guard
(DCS) sguelch control isused and the desired codeis
selected by the drop-down list.

Security

NOTE: \oice encryption is an optional feature that
requires factory programming and possibly special
hardware.

Strapping Mode

Strapped Clear - All transmissions on the channel
occur in the clear (unscrambled) mode.

Strapped Secure - All transmissions occur in the
secure (scrambled) mode selected by Security

Type.

Switched - The clear or secure status of the channel
is selected by the Clear/Secure function switch.

Security Type

Securenet - Selects Motorola SecureNet™ DES
type secure communication when either the
Strapped Secure or Switched strapping modes
are selected.
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Scrambling - Selects Transcrypt 460 scrambling
when either the Strapped Secure or Switched
strapping modes are selected (not available with
5100 and later 5300 models).

Scrambling Type

When the Transcrypt 460 scrambling typeis
selected, 460 scrambling is always enabled.

Tx DES/IDES-XL

When the Motorola SecureNet secure communica
tion is selected, enables either the DES or DES-XL
type (with the 51xx, DES-XL isavailable only in
later models equipped with the UCM module).

Key PID

Selects the location from 0-15 (PID/ASN mode) or
1-16 (SLN/CKR mode) of the key used for secure
calls on the channel if applicable.

Rx Auto Detect

With the SecureNet protocol, selecting “ Secure”
enabl es automatic detection of encrypted receive
signals (not available with 5100 models). This may
increase the response time of theradio to an
incoming signal. Selecting “Proper Key” causes the
radio to search the available SecureNet keys until it
finds a match for the current transmission.

Other

Busy Channel Lockout

Off - Disables this feature.

Noise - Transmitting is disabled if acarrier is
detected.

Tone - Transmitting is disabled if an incorrect Call
Guard (CTCSS/DCS) tone or codeis
detected (one not programmed for current
channel).

Keypad DTMF

If this box is checked, manual dialing of numbers
using the DTMF keypad is allowed.
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Figure 7-3 Conventional Digital (P25) Channel Screen

ANI

Thisdrop-down list selects Pre Tx or Post Tx ANI. If
“PreTx” isselected, aDTMF-coded ID issent at the
beginning of each transmission. If “Post TX” is
selected, aDTMF coded ID is sent at the end of each
transmission. ThisID is set in the Radio Wide
Conventional screen by “DTMF PTT ID” (see
Section 5.5), and ANI timing is set in the Per System
Conventional screen (see Section 7.1).

7.3 CONVENTIONAL DIGITAL (P25) CHANNEL
PARAMETERS

After the desired channels have been set up as
described in Section 6.3, individual channel parame-
ters can be programmed. Select the Zone screen shown
in Figure 7-3 and then select the desired Zone using
the drop-down list in the “Zones’ box. Screens which
program individual channel parameters are selected by
clicking the channel in the “ Channels’ box.

The parameters displayed when a Conventional
Digital channel is selected are as follows. Refer to
Section 7.2 for information on Conventional Analog
channels. SMARTNET/SmartZone and Project 25
Trunked channels are described in Sections 8 and 9.
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Channél Type

Indicates the type of channel (Conventional Analog
or Conventional Digital) that is currently selected in
the “Channels’ box.

Channel Alias

Programs the alias (identification) that is displayed
when the channel is selected. Up to ten characters
can be programmed.

Mixed M ode

Mixed analog and digital (Project 25) operation can
be programmed on a channel. With mixed mode
operation, both typesof callscan bereceived, and the
Tx Typedeterminesif NAC or CTCSS/DCSistrans-
mitted. With anal og operation, channel modulation,
coded squelch, and ANI signaling may require
programming similar to that described in Section 7.2.

Enable - Checking this box selects both analog and
digital operation on the current channel.
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Tx Type - When “Analog” is selected, CTCSS/DCS
istransmitted, and when “Digital” is selected, NAC
istransmitted.

Transmit

Power - Fixesthe transmit power on the channel for
the high or low level or makesit selectable (the high/
low power function switch is then required).

Time Out - Enables or disablesthe transmit time-out
timer on the channel. The time-out timer timeis
programmed on the Per System programming screen
(see Section 7.1).

Modulation Level - If the Mixed Mode and Tx
Type = Analog is selected, the modulation level is
programmed. This selects if the channel modulation
iswideband (5 kHz), narrowband (2.5 kHz), or
NPSPAC (4 kHz).

Freguency - Programs the transmit frequency of the
channel.

Disabled - Checking this box disables transmitting
on the channel so that it is receive only.

NAC - Programsthetransmit NAC (Network Access
Code). These codes can be 0-4095, and either
decimal or hexadecimal numbers can be entered.

CTCSS/DCS - If the Mixed Mode and Tx Type =
Analog isselected, the transmit Call Guard (CTCSY
DCS) squelch coding can be programmed (see
Section 7.2).

Receive

Freguency - Programs the receive frequency of the
channel.

NAC - Programsthe receive NAC (Network Access
Code). These codes can be 0-4095, and either
decimal or hexadecimal numbers can be entered.

Digital Sguelch - When checked, carrier squelchis
enabled which resultsin all digital traffic, regardless
of NAC or talk group ID, being received. This does
not program NAC F7E which is now used the same
as other NAC codes.
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CTCSS/DCS - If the Mixed Mode is selected, the
receive Call Guard (CTCSS/DCS) squelch coding
can be programmed (see Section 7.2). Both analog
and digital (P25) calls can be received in the mixed
mode.

Talk Group

Group ID - Thisselectsthe Project 25 talk group that
is assigned to the channel. Thetalk group includes
the Talk Group ID, talk group alias, secure strapping
mode, and encryption key address. Talk Groups are
programmed in the Per System screen (see

Section 7.1).

Group Selection

Strapped To Selected Group - The talk group on
the channel is always the programmed talk group
and cannot be changed.

List Selectable - Thetalk group may be changed
using the Digital TG Select function button.

Other

Busy Channel Lockout

Off - Disables this feature.

Noise - Transmitting is disabled if acarrier is
detected.

NAC - Transmitting isdisabled if an incorrect NAC
codeis detected (or CTCSS/DCS if mixed
mode is enabled). Anincorrect codeis any
code not programmed for the current channel.

Keypad DTMF

If this box is checked, manual dialing of numbers
using the DTMF keypad isalowed. Thisisavailable
in the mixed mode only.

ANI
If the Mixed Mode and Tx Type = Analog are

selected, ANI can be programmed similar to that
described in Section 7.2.
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Override Talkgroup Security Settings*

This allows the encryption strapping mode and
key location to be set on a per channel basisinstead of

just on aper talk group basis. If “Yes" isselected in
the drop down menu, the selected strapping mode and
key location overrides the talk group programming if
applicable (conventional digital channels only).

SECTION 8 SMARTNET AND SMARTZONE SYSTEMS AND CHANNELS
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Figure 8-1 SMARTNET/SmartZone System Screen

8.1 INDIVIDUAL SMARTNET/SMARTZONE
SYSTEM PARAMETERS

NOTE: Some SMARTNET/SmartZone trunking param-
eters can be edited only if the proper systemkey is
detected. A key isbeing detected if a yellow key iconis
indicated as shown in Figure 8-1. If thereisared“ X”
through thisicon, a key is not being detected. Refer to
Section 13 for more information.

Individual system parameters are programmed by
the “Per System” screen shown in Figure 8-1. These

* This feature available only in 51xx/53xx models with Flash
code 2.x or 3.x (see Section 16).
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parameters can be programmed after the desired
systems have been set up as described in Section 1.10.

There are also radio wide system parameters that
are programmed by the Radio Wide screen as
described in Section 5.6. For information on program-
ming individual Conventional and Project 25 Trunked
system parameters, refer to Sections 7.1 and 9.1.

The parametersin theindividual SMARTNET/
SmartZone System screen are as follows:
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IDs

NOTE: These | Ds can be entered in either decimal or
hexadecimal format (see Section 1.9.4)

System ID - This drop down list selects the system

ID of the system. ThisID comesfrom the system key
inthe “Keys’ folder (see above “Note”). System ID

numbers can be 1-65535 or 0001-FFFF hex. If a

valid system key is not detected, only adefault ID of

“1" can be selected.

Individual ID - Uniquely identifiestheradio on a
particular system. Each radio must have a different
Unit ID. Valid Unit IDs are 1-65535. If the “Hex”

box is checked, the Individual ID can be entered asa

hexadecimal number instead of a decimal number.

Keys

Programs the following encryption key 1D (hard-

ware location) that is used for all except group calls.

System Wide - Key used for system-wide calls (typi-

cally originated by the dispatcher).
Failsoft - Key used in failsoft conditions.
Patch - Key used in patch calls.

Unit To Unit - Key used for unit-to-unit (private)
cals.

Interconnect - Key used for telephone interconnect
cals.

System Lists - Refer to page 47 for information on
these lists.
Emergency

Emergency Alarm

Disabled - No emergency signal is sent when the

user presses the Emergency option switch.

Normal - An emergency alarm is sent when the
user presses the Emergency option switch. If the
Emergency Call is disabled, the alarm always
occurs on the selected group. If the Emergency
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Call isenabled, it occurs, in order of preference, on
the Emergency group, selected group, and
Announcement group. When an emergency condi-
tion is sent, the red transmit indicator lights, an
emergency tone sounds, and EMERGNCY flashes
in the display. EMERGNCY continuesto flash
until power iscycled, the channel is changed, or
the Emergency switch is pressed and held**.

Silent - Same as “Normal” except none of the
above audio or visual indications occur.

Emergency Call

Enable - When this box is checked, if the Emer-
gency option switch and then the PTT switch are
pressed, an emergency call istransmitted on the
Emergency group. The emergency modeis
canceled by cycling power or pressing and
holding** the Emergency switch.

Disable - When this box is not checked, an emer-
gency group call is not authorized.

Emergency Hot Mic

Enable - When this box is checked and an emer-
gency alarm is sent by pressing the Emergency
switch, automatic transmitting occurs with the
microphone audio unmuted (without user inter-
vention) for the time specified by the following
Emergency Hot Mic Time. If it isnot checked or if
neither emergency call is selected, automatic
transmissionsdo not occur. Thisfeatureisinitiated
only by thefirst press of the Emergency switch.
Subsequent presses do not trigger automatic trans-
missions. This function resetsif the channel is
changed.

Disable- When thisbox isnot checked, automatic
transmissions do not occur.

Emergency Hot Mic Time - Defines the period
during which transmissions occur. Times of 10-120
seconds in 10-second steps can be selected.

Emergency Retry Counter - When “Infinite” is
checked, an emergency call is repeated until
acknowledged or canceled. When it is not checked,
calls are attempted only the specified number of
times.

** Thisfeature available only in 51xx models with code 1.12.1/2.2.1/
3.2.1 or later and 53xx models with code 1.24.1/2.2.1/3.2.1 or later.
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SmartZone Customized Roaming Properties Screen (SmartZone/P25 Trunked Only)

Time/Timers Customized Roaming Properties
Time-Out Timer - Programs the time-out timer
setting for the system. It can be programmed for
15-225 seconds in 15-second steps or it can be
disabled (0).

SmartZone and Project 25 Trunked roaming
properties can be customized by clicking the | gusemize .. |
button. The screen shown above is then displayed.
Information programmed in this screen is described in
the “Notes” window that is displayed. The RSSI Filter
dlider bar controls how quickly the radio reacts to
dropoutsin the RSS! level. The more aggressive the
setting, the quicker site switching occurs.

ISW Delay Time - Increasing or decreasing this
value changes the transmission timing of ISWs
relative to the reception of OSWs.

Scan Hold Time - Programs the delay that occurs
after amessageisno longer received before scanning
resumes. Times of 2-10 seconds can be programmed.

Other

PTT ID Enable - When selected, the radio can key
during the programmed hang time and continue the
conversation on the active channel (similar to

Phone DTMF Timing (Analog Only)

Initial Delay - Delay from 10-500 millisecondsfrom
when atraffic channel is granted for phone intercon-
nect to the start of the dialing out of the phone
number.

Digit Duration - Duration from 10-500 milliseconds
of each phone number digit.

Inter-Digit Delay - Delay from 10-500 milliseconds
between each digit of a phone number.
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message trunking). If a user keys during the hang
time, re-affiliation with the system occurs before
using the voice channel. The voice channel is held
while this re-affiliation occurs, and the call is then
routed to the open voice channel. Thisresultsin all
traffic being logged, even the radios which transmit
during the hang time.

If neither PTT ID Enable or Transmission Trunking
which followsis selected, operation issimilar to that
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above except that re-affiliation does not occur during
the hang time. Therefore, radios that key up during
the hangtime do not affiliate and are not logged and
only theradio initiating the call is logged.

Splinter Channels - When checked, the receive and
transmit frequencies are 12.5 kHz lower than the
normal frequencies. Splinter channels are used only
as required in the Mexico and Canada border areas
for frequencies between 806 and 820.975 MHz.

Dynamic Regrouping - When checked, a dynamic
regrouping channel can be programmed. Thisisa
SMARTNET/SmartZone channel which hasthetalk
group dynamically set by thedispatcher. Itisselected
on the channel screen (see Section 8.3).

Transmission Trunking - Hangtime is not used and
the radio must affiliate and receive a new channel
grant on every PTT. When aradio unkeys, the
channel isimmediately availablefor other users, and
all trafficislogged. If this parameter is not selected,
see preceding PTT 1D Enable description.

Connect Tone - The tone expected by the controller
on thetraffic channel to verify that a subscriber trans-
mission is occurring. This tone should be set the
same asit isin the controller.

Private Call Usage

Disabled - Private cals cannot be placed or
received.

Response Only - Private calls can be received but
not placed.

List Only - Private calls can be placed and
received, and numbers can be recalled from a
preprogrammed list only.

Unlimited - Private calls can be placed and
received, and numbers can be recalled from a
preprogrammed list or dialed using a microphone
keypad. Thismaodeis currently not supported with
5300 radios and the preceding “List Only” mode
should be used instead. NOTE: To enter thismode
with the 51xx, the key must be pressed and held for
a short time until a tone sounds.
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Private Call 2

Sandard - Selectsthe standard Private Conversa-
tion mode in which the user does not receive any
feedback when the called radio is not activein the
system. Only a“No Answer” isreceived if the
called radio does not answer.

Enhanced - Selects the Enhanced Private Conver-
sation™ mode. When a call is placed with this
mode, the system tells the user if the called radio
iscurrently active in the system and within range.
The calling radio displays“No Ack” if the called
radio isnot active in the system and “No Answer”
if it is active but does not answer.

Phone I nterconnect Usage - Programs operation of
telephone calls same as “ Private Call Usage” above.

Affiliation Type (SMARNET Only)

Automatic- Theradioimmediately affiliateswith
the central controller as soon asit isturned on and
automatically re-affiliates each timethetalk group
is changed.

On PTT - Theradio affiliates with the central
controller each time the PTT switch is pressed,
even when pressed during the hang time. Also,
when the radio is keyed during the hang time, the
currently active channel is held active during the
re-affiliation and the re-affiliated radio continues
traffic on this channel.

Channel Bandwidth - Selects the channel bandwidth
as 25, 20, or 12.5 kHz. When “20 kHz" is enabled,
the radio operates with a4 kHz maximum deviation
between 821.000 and 824.975 MHz and 5 kHz
maximum deviation for al other frequencies. When
12.5 kHz is selected, deviation is 2.5 kHz with all
frequencies.

Transmit Power - Fixes the transmit power on the
system for the high or low level or makes it select-
able (the high/low power function switch isthen
required).

RSSI Threshold (SmartZone/P25 Trunked Only) -
Sets the RSSI (Receive Signal Strength Indicator)
levelsthat determine when searching for and switch
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to another site occurs. Do not change the default
levelsunlessyou arefamiliar with how these settings
affect operation.

Hot DTMF - When enabled, DTMF digits are sent
when buttons are pressed when transmitting in the
SMARTNET/SmartZone anal og mode.

STAR Trunking - Selects this feature which is avail-
ablewith SmartZone systems. The system selectedin
the“ System ID” box isthen regarded asthe “Home"
system and no other system information is required
to use this feature. The talk groups must be entered
as with non-Omnilink systems, and all other
programming occurs on the infrastructure side. All
required roaming information is received via adja-
cent site control channel data.

SMARTNET/SmartZone System Page 2 Screen
Description

An additional system screen is opened/closed by
clicking the »> buttonsin the upper right corner
of the screen. The following additional parameters are
then displayed:

SmartZone / Additional Parameters

Analog Tx DESADES =L Other
Uit Call: DE¥+L =

Intercannest: -

Anaog Transmit DES/DES-XL* - Allows the type
of encryption to be specified individually for Unit
and Interconnect calls made in the analog mode.
DES-XL isavailable only with the Motorola encryp-
tion modul e (see Section 16).

8.2 SMARTNET/SMARTZONE SYSTEM LISTS

The various SMARTNET/SmartZone lists are
selected by the System Lists drop-down list on the
SMARTNET/SmartZone Per system screen (see Figure
8-1). After the desired list is selected, it is edited by
clicking the | = edtList.. | button. Descriptions of the
various lists and the information they program follow.

Control Channel List

The Control Channel List screen which follows
allowsthe system manager to view and edit the control
channels. Each SMARTNET system can have up to

* This feature available only in 51xx/53xx models with Flash
code 2.x or 3.x (see Section 16).

four control channels, and each SmartZone system can
have up to 48 control channels. With the 5300 Rev 4
or earlier logic board, up to 32 SmartZone entries are
allowed. Only one control channel is active at atime.

Mo |Ts [MHz]
1 060125
2 307.0125
3 F08.0125
4 209.0125

[Rx MHz) |

8520125 Delete
8530125
854.0125

X Cancel

I= o e

Max Entries: 4 T« =Rz - 45 MHz

To display this screen, on the SMARTNET/
SmartZone Per System screen, select Control Channel
List in the drop-down list and then click the

= EdtLis... | button (see Figure 8-1).

To add achannel, click the " & | button, and to
delete a channel, simply select it and click the Delete
button. To edit achannel, select the digitsto be changed
and edit them as desired. For the 800 MHz band, only
the receive channel frequency can be changed and the
transmit frequency isautomatically calculated (45 MHz
below the receive frequency). These are the mobile
frequencies, not the repeater frequencies. Only multi-
plesof 5 kHz and 6.25 kHz are valid.

Status Alias List

Status Alias
Mo |alias | Add |
1 OFF DUTY
2 [N DUTY %
3 AT LUMCH
4 Ok PATROL|
o OK
X Cancel |
? Help
b aw Entries: 8

The Status Alias List screen shown above
programs the alias for each of up to eight status condi-
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tions that can be sent. The meaning of each status
number is defined by the system manager.

To display this screen, on the SMARTNET/
SmartZone Per System screen, select Status Alias List
in the drop-down list and then click the | = EdiList... |
button (see Figure 8-1). To add an dlias, click the

ad | button, and to delete an alias, smply select it
and click the Delete button. To edit an aias, select it
and change it asdesired. Up to 10 characters can be
entered that identify the status. Thisidentification is
displayed when the user selects a status condition.

Message Alias List

The Message Alias List screen which follows
associates an alias (name) with each message number.
The meaning of each message number is defined by
the system manager.

iz |
1 [0UTOFCaR
2 |AT OFFICE]

Delete |

x Canicel |
? Help |

Message Alias List Screen

tax Entries: 16

To display this screen, on the SMARTNET/
SmartZone Per System screen, select Message Alias
List in the drop-down list and then click the

= EdtList.. | button (see Figure 8-1). To add an alias,
clickthe| aw | button, and to delete an alias,
simply select it and click the Delete button. To edit an
adlias, select it and changeit as desired. Up to 10 char-
acters can be entered that identify the message. This
identification is displayed when the user selects a

message.
Call List

The Call List screen which follows programs the
list of IDs used for private calls. A maximum of 255
IDs can be programmed. To display this screen, on the
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[caraios /0
iz |[E |

FRED SHABE 1

LARRY WOLF 2

DON SMITH 3

MEW ALIAS 1

lwlr] ==
o

Ok |
X Cancel |
? Help |

Max Entries: 255

SMARTNET/SmartZone Per System screen, select
call list in the drop-down list and then click the
= Edtlist.. | button (see Figure 8-1).

Toadd acdll, clickthe | aw | button, and to
delete an call, simply select it and click the Delete
button. To edit an Aliasor ID, select it and enter the
desired information as follows:

Alias- Uptoten characters can be entered to identify
the user being called. Thisidentification isdisplayed
when the mobile to be called is selected by the user

fromthelist. Inaddition, whenacall isreceived from
aunitinthislist, thealiasof theunitisthen displayed
instead of the unit ID number. Only uppercase |l etters
can beentered, so lowercase |l ettersare automatically
converted to uppercase by the program.

ID - Thisisthe ID of theradio being called. Valid
entriesare 0 - 65535. A “0" is detected as no entry.

Phone List
[svstem ias /phone 51
Mo  |Alias |Ph0ne | Add |
1 EFJOHMNSON S078356222
2 [FRED SMITH sovazstzad] ﬂl
I
B
i
i
x Cancel |
? Help |
Max Entrigs: 255

The Phone List screen shown above programs the
telephone number list used for placing telephone calls
if applicable. A maximum of 255 numbers can be
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programmed. To display this screen, on the

SMARTNET/SmartZone Per System screen, select

Phone List in the drop-down list and then click the
= Edtlist.. | button (see Figure 8-1).

To add acall, click the | 4 | button, and to
delete an call, simply select it and click the Delete
button. To edit an alias or number, select it and enter
the desired information as follows:

Alias- Uptoten characters can be entered to identify

the number being called. Thisidentification is

displayed when the number to be called isselected by
the user from the list. Only uppercase letters can be

entered, so lowercase letters are automatically
converted to uppercase by the program.

ID - Thisis the telephone number dialed when the

locationisselected. The 3-digit areacode and 7-digit
telephone number are entered using the numbers 0-9.

Talk Group List

ne Talk Groups

D | Selected Group

D: [&5 I HexID

Add

- Group Typ e Sys Prefened Sie List ¥ 4o Site Lists
IAnaIng - List to Lse: IList 1 - - |
—Securib

Strapping Mode:  |Stapped Secure - I Pt Auto Detest———
¥ Secue
Security Type: m

I~ Proper Key

Soramblinglpess | 460 s

% DES/DESKL: [DES —| SmartZone
Key PID: 2 = Only
Failzoft Frequencie:
Tk (dHa) R (MH2) o it
B06.0125 Tx=Rx-45MHz
rTalk Group Specific Preferred Site:
Selected Site
Prefened Site 1 ol 7
Prefened Site 2 e
Prefened Site 3 Freference: [Mone -
Prefened Site 4 X Concel
ancel
7 k|

Tatal: 2 Max Groups: 255 5

]Igg Delete

The Talk Group List screen shown above sets up

SMARTNET/SmartZone talk groups and programs
unique talk group information. To display this screen,
on the SMARTNET/SmartZone Per System screen,
select the Talk Group List drop-down system list and
then click the ' = edtList.. | button (see Figure 8-1).

The parameters programmed in this screen are as
follows:

Group ID - Thislist displays the talk group IDs
currently contained in the Talk Group list. To edit a
talk group ID in thislist, select it and then changeit in
the Selected Group box. Thisisthe actual 1D of the
talk group. Talk groups are assigned to channelsin the
Zone screen (see page 55). NOTE: This|ID can be
entered in either the decimal or hexadecimal format as
described in Section 1.9.4.

s | - Clicking this button adds the next avail-
abletalk group ID to the list. Each SMARTNET/
SmartZone system can be programmed with up to
255 talk groups.

To add an entire block of talk group IDs or a specific
ID, click the arrow button ' s» inthe lower right
corner of the screen. The following screen isthen
displayed:

—Add Mod

| Multiple =l

hLaltiple &d

Start [D: I'l O]
ID Count: |2
ID Step: I'l

Add Mode Drop Down List - “Single” adds the next
available ID similar to the preceding “Add” button.
“Multiple” addsablock of IDsasfollows. Toinitiate
the selected add operation, click the preceding “ Add”
button. If the specified ID range results in duplicate
IDs, an error message is displayed and no IDs are
added.

Sart ID - Specifiesthe starting ID of the block.
ID Count - Specifies the number of IDsto be
added.

ID Step - Specifiesif consecutive |Dsare added or
some other step rate is used.

For example, if Start ID =10, ID Count =5, and ID
Step = 10, the IDs added are 10, 20, 30, 40 and 50.

pelete | - Clicking this button deletes the talk
group that is currently selected in the list.

49



SMARTNET AND SMARTZONE SYSTEMS AND CHANNELS

Group Type - Selects either Analog or Digital
signaling on the talk group.

Use System Preferred Site List (SmartZone Only) -
Selects one of the preferred sites for the talk group.
Refer to the “Preferred Sites’ description which
follows for more information.

Strapping Mode

Srapped Clear - All transmissions on the talk
group occur in the clear (unscrambled) mode.

Srapped Secure - All transmissions on the talk
group occur in the secure (scrambled) mode
selected as follows.

Switched Mode - Theclear or secure status of the
talk group is selected by the Clear/Secure option
switch.

Security Type

NOTE: \oice encryption is an optional feature
that requires factory programming and possibly
special hardware.

SecureNet - Selectsthe Motorola SecureNet DES
type of secure communication when either the
coded or switched strapping mode is sel ected.

Scrambling - Selects the Transcrypt 460 type of
secure communication when either the coded or
switched strapping modeis selected (not available
with 5100 and later 5300 models).

Scrambling Type

When Transcrypt scrambling is selected, selects
the type. Currently, only the 460 typeisavailable.

Tx DES/IDES-XL

With analog channels, when SecureNet secure
communication is selected, selects either the DES
or DES-XL type. (With the 51xx, DES-XL is
available only in later models equipped with the
UCM module.) Ondigital channels, thetypeisnot
selectable and both DES-OFB and AES* encryp-
tion are supported. The actual type used is deter-
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mined by the encryption key that is selected by the
talk group (see following).

Key PID - Selectsthe location from 0-15 (PID/ASN
mode) or 1-16 (SLN/CKR mode) of the key used for
secure calls on the group if applicable.

Rx Auto Detect

Secure - If this option is checked, an encrypted
signal isautomatically detected and received. This
option may increasetheresponsetimetoincoming
signals. If it isnot checked, those signals are
detected only if they are coded like the transmit
signals.

Proper Key - If thisoption is checked, theradio
will search the avail able encryption keys until it
finds a match for the current transmission.

Failsoft Enable - If this box is checked, afailsoft
channel isenabled on thetalk group if acontroller or
other mgjor failure occurs. If thisbox is not checked,
the failsoft mode is not entered if afailure occurs.

Tx/Rx Frequency - Programs the failsoft channel
frequency if “Enable” is checked.

Preferred Sites (SmartZone Only)

With SmartZone systems, up to four Preferred
Sites and/or a Preferred Site List* can be associated
with each talk group. Thisforcesacall on the talk
group to access the specified sites. The system
manager can then keep mobiles on specific sites even
if the “Site Search” feature has not been enabled. The
preference for each site can be programmed for Least,
None, Preferred, or Always as follows.

The Preferred Site Lists are programmed by the
System Preferred Site List screen described on
page 52. Up to 16 lists can be programmed, and each
site can include up to 16 sites.

If both a Preferred Site List and one or more
Preferred Sites (selected at bottom of screen) are asso-
ciated with atalk group, the Preferred Sites at the
bottom are searched first. Thefirst entry found for a
given siteis used. If the same siteisin both lists, the
entry inthelist at the bottom of the screen is used first.
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Use Sys Preferred Site List* - When thisbox is
checked, thetalk group isassociated with aPreferred
Site List. The specific sitelist is selected by the drop
down list.

it Site Lists | - Displays the Preferred Site List
screen described on page 52 as a quick referenceto
determine which sites are included in each sitelist.
This screen isfor informational purposes only, so
lists can be viewed but not be edited. Clicking the
“Select into Talk Group” button setsthe “List To
Use” field in the main screen to the selected list.

Talk Group Specific Preferred Sites- Up to four indi-
vidual sites can also be associated with each talk
group (see preceding information). Sites are enabled
using the checkbox, the applicable site ID is entered
in the Site ID box, and the drop down list programs
the selected site preference for Least, None (no pref-
erence), Preferred, or Always (preferred).

Announcement Group List

Ed

SmartZone Announcement Groups
Group ID Selected Group

o: i

Add

Group Type Use Sys Prefened Sits Lisk v
[raog =1 Listtallse: Lst1  =

Secuily Talk Gioup List

Stiapping Mode:  [Stiapped Clear 5 | [ Tak Grovp ID
E
|Securenet ! 1
- 2
DES

14z Site Lists

=
= Selected Enfries: 1
Arnouncement Graup Spesifc Preferied Sites
Selected Site 01
StelD 1
o
X Cancel
7 Help

Total: 1 Mar Groups: 255 ¥

The Announcement Group List screen which
follows sets up SMARTNET/SmartZone announce-
ment groups that are used to communicate with severa
talk groups simultaneously. Each announcement group
can have up to 15 talk groups.

To display this screen, on the SMARTNET/
SmartZone Per System screen, select the Announce-
ment Group List in the drop-down list and then click
the | '= edtList.. | button (see Figure 8-1). The parame-
ters programmed in this screen are as follows:

Group ID - Thislist displays the Announcement
group IDs currently contained in the Announcement

* Thisfeature available only in 51xx models with Flash code Version
1.8.0 or later and 53xx models with ARM code 1.21.0 or |ater.

Grouplist. ToeditanID inthislist, select it and then
changeit in the Selected Group box. Thisisthe
actual ID of the announcement group. Announce-
ment groups are assigned to channels in the Zone
screen (see page 55). NOTE: This|D can be entered
in either the decimal or hexadecimal format as
described in Section 1.9.4.

asd | - Clicking this button adds the next avail-
able announcement group 1D to thelist. Each
SMARTNET/SmartZone system can be
programmed with up to 255 announcement groups.

To add an entire block of announcement group IDsor
aspecificlD, click thearrow button ' :» inthelower
right corner of the screen. The following screenis
then displayed. Refer to the preceding “ Talk Group
List” description for more information on this screen.

—&dd Mod
| Multiple =l
kultiple Ad
statiD: [I (D)
|0 Count; |2_
ID Step: I'l—

Dete | - Clicking this button deletes the
announcement group that is currently selected in the
list.

Group Type - Selects either Analog or Digital
signaling on the announcement group.

Use System Preferred Site List (SmartZone Only) -
Selects one of the preferred sites for the announce-

ment group. Refer to the preceding Talk Group List
description for more information.

Security - Programs the secure communication oper-
ation on each announcement group similar to talk
groups described in the preceding “ Talk Group List”
description.

Talk Group ID - Selects the talk groupsthat are
included in each announcement group.

Preferred Sites (SmartZone Only) - Programs the
preferred site information similar to talk groups
described in the preceding “Talk Group List”




SMARTNET AND SMARTZONE SYSTEMS AND CHANNELS

description. Up to four Preferred Sites and/or a
Preferred Site List a can be associated with each
announcement group.

Priority Scan List

Scan Lint Charnels ([Check ho st priority]
Prcity | Hp Zone Abas Channel | System/ Tipe:
[m} 1 ZONE 3 1
2 "

3 Smaonn

ZONET 1
3 ZONE 3 J
ZONE 2

Select Scan Channels
o R =] (e m5enit 7

on Programmed” from the drop down list. If priority
scanning is not used, select “Non Priority Scan”. If
“Priority on Programmed” is selected, check the
priority box of the desired priority channel.

NOTE: Priority talk group scanning must also be
supported at the system level for it to occur as
programmed. Talk Groups programmed as “ Priority”
in PCConfigure must also be designated as Priority
Monitor Groups by the System Control software.

Site List (SmartZone Systems Only)

G 2
E :' ZONET e E =
5 a3 R ]
T =
Add |
NOTE: Before the priority monitor scan lists can be  Deee |

programmed as follows, the channelsto beincluded in
these lists must be set up in the Zone screen as
described in Section 8.3 on page 54.

The Priority Scan List screen shown above sets
up the Priority (Standard) Scan lists that can be
programmed on each SMARTNET or SmartZone
system. Each scan list can include up to 16 channels,
one of which may be a priority channel. These chan-
nels must be from the same SMARTNET or Smart-
Zone system. Channels from other systems are not
allowed. With the 5300 Rev 6 logic board and 51xx
portables, up to as many lists can be programmed as
can be stored in the available memory. With other
radios, up to three lists can be programmed.

To display this screen, on the SMARTNET/
SmartZone Per System screen, select Priority Scan
List in the drop-down list and then click the

= Edelist... | button (see Figure 8-1).

List Number - This drop-down list selects the scan
list to edit. Click the “Add” button to add a scan list
and “Delete” to delete a scan list.

i - Clicking this button displays the screen
shown on the right above which is used to edit the
selected scan list. Check the channelsin each zoneto
be included in the selected scan list. Repeat for the
other scan lists if applicable.

Scan Mode - If priority scanisused on alist, select
“Priority on Selected” (51xx/53xx only) or “Priority

* Thisfeature available only in 51xx models with Flash code Version
1.8.0 or later and 53xx models with ARM code 1.21.0 or |ater.
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x Eance.lu |
P Help |

Max Ertries: 48

Sitesin a SmartZone system are designated by a
number. The Site List screen shown above programs
an alias for each site number that is displayed when
using the Site Search feature.

To display this screen, on the SmartZone Per
System screen, select Site List in the drop-down list
and then click the = EditList... | button (see Figure 8-1).
Toadd an dlias, click the | s | button, and to
delete an alias, simply select it and click the Delete
button. To edit an aliasor ID, simply select it and
make the desired changes.

Alias - Programs up to 10 aphanumeric characters
that identify the site.

ID - Site ID from 0-48. With the 5300 Rev 6 logic
board, up to 255 entries are supported.

System Preferred Site List (SmartZone
Systems Only)*

The Preferred Site List screen which follows
programs up to 16 Preferred Site Lists. These lists can
be associated with individual talk groups on the Talk
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Group List screen described starting on page 49. This
forces callson atalk group to access specific sites. The
preference for each site in alist can be set for Least,
None, Preferred, or Always as follows.

Sy Wide Preferred Site Lists

r—Site List

ok
[t =] Add Delete | l‘/—l
XK Cancel |
rSitegInList——— 7 [ Selected Site
Prefemed Site 1 Site [D: |45
Preferred Site 2

Preference: IPreferred vI

Prefemed Site 3
Prefemed Site 4
Prefered Site 5
O Prefered Sit= &
O Prefemed Site 7
O Prefered Site &
O Prefered Sit= 9
[ Prefemed Site 10
O Prefermed Site 11
O Prefermed Sits 12
[ Prefemed Site 13
O Prefered Site 14
O Frefered Site 15
[ Prefened Site 16

b2 Lists: 16

Each list can be programmed with up to 16 sites.
Therefore, the use of Preferred Site Listsallows up to
16 sites to be associated with a group instead of just 4
available on the Talk Group List screen. In addition, if
several talk groups are associated with the same sites,
alist can simply be selected instead of separate sites.

Site Lists- This drop down list selectsthelist to be
edited. To add anew list, click the“Add” button. To
delete the selected list, click the “Delete” button.

Sites|n List - To add/delete asite from thelist, click
the checkbox.

Site ID - Enter the site ID from 0-48.

Preference - Select the site preference in the drop
down list. A default weighting is usually assigned to
these preference levels which resultsin the most
preference given to “ Always’ and the least prefer-
enceto “Least” asfollows:

1. Always (preferred)
2. Preferred

3. None (no preference)
4. Least (preferred)

Other Band Trunking List (VHF/UHF Only)

Cither Band Trunking
~Split 1 |
v ok |
| Spacing [KHz] | Start Freq MHz End Freg [MHz
Tiansmit [25 < |[13 0000 145 4750 _ X cancel |
Fieceive: |25 [=|[135.0000 |145.4750 7 Help |

—Split2——1 Enable

| Spacing [KHz] | Start Freq [MHz End Freq [MHz !
Tranzmit: |25 ~ ||000.0000 000.0000

Receive: [25 [=[0o0.0000 000.0000

4

| SEacinE FHz] | Start Freq [MH= l End Freg [MHz !

T

- !:_.: =

The Other Band Trunking screen shown above
can be displayed only when programming channelsin
the VHF and UHF frequency bands. It isused to
define the relationship between transmit and receive
channel frequenciesin these bands. With 800 MHz
systems, thisis not required because the difference
between transmit and receive frequency is always 45
MHz.

To display this screen, on the SMARTNET/
SmartZone Per System screen, select the Other Band
Trunking in the drop-down list and then click the

= EdtLit.. | button (see Figure 8-1).
oo ]

This screen organizes the available frequency
band into three sub-bands, called splits. Each split is

defined by a start frequency, stop frequency, and
channel spacing as follows. Frequencies outside the
defined split cannot be accessed by the radio. These
frequency splits must be defined the same way they
are defined for the trunking controller.

Tx and Rx Spacing - Spacing in kHz between each
potential transmit and receive frequency.

Tx and Rx Start Frequency - Startin MHz of theband
split for transmit and receive frequencies.

Tx and Rx Stop Freguency - Stopin MHz of the band
split for transmit and receive frequencies.
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User Group ID List*

x
Mo [alias [Start 1D |5tap 1D [ fdd |
1 FIRE 234 264
2 FOLICE 265 275 Delete |

XK Cancel
P Help
Max Entries: 32

This User Group ID List screen shown on the left
programs aliases that can be displayed if acall is
received on atalk group ID within the programmed
block. For example, with the preceding screen, if a
group call isreceived on group | Ds 234-264, the alias
“Fire” can be displayed. The display of thisdliasis
controlled by the “User Group ID” parameter on the
Radio Wide screen.

Global | Radiowide | Per System Zone

CZahe

—Channel Parameter

Alias: I DIG MODE "I

Channel Type

Wi Edit Zone .. |

Smarthet / SmartZone

—Other

[v Talk Permit Tone

—Channel Alia [~ Make Dynamic Regrouping Channel
~Channel |CHAN1 [~ TxDisabled
MNurnber of Channels: 2
—Scan List
No | ;..anz.:.r.e — List Selection: Mo List =l
2 02 : SmartMet_1 ™ Auto Scan
-0
Talk Group 1D Iﬁ
Announcement Group 10: Im
Emergency Group [0 Im

Figure 8-2 SMARTNET/SmartZone Channel Screen

8.3 SMARTNET/SMARTZONE CHANNEL
PARAMETERS

After the desired channels have been set up as
described in Section 6.3, individual channel parame-
ters can be programmed. Select the Zone screen shown
in Figure 8-2 and then select the desired Zone using
the drop-down list in the “Zones” box. Screens which
program individual channel parameters are selected by
clicking the channel in the “ Channels’ box.

The parameters displayed when a SMARTNET/
SmartZone channel is selected are as follows. Conven-
tional and Project 25 Trunked channels are described
in Sections 7 and 9.

Channel Parameters

Channdl Type - Indicates the type of channel that is
currently selected in the “Channels’ box.

Channel Alias - Programs the alias (identification)
that is displayed when the channel is selected. Up to
ten characters can be programmed.

Scan List - Selects the priority (standard) scan list
selected by the channel. If “No List” is selected,
scanning is not selectable on that channel.

Auto Scan - When thisis checked, the radio automat-
ically begins scanning the scan list associated with

* This feature available only in 51xx models with code 1.12.1/2.2.1/
3.2.1 or later and 53xx models with code 1.24.1/2.2.1/3.2.1 or later.
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the channel whenever the channel is selected. When
it is not checked, scanning must be started manually
by the Scan option switch.

IDs

Operation with the various combinations of Talk
Groups (TGs) and Announcement Groups (AGS) isas
follows:

Talk Group Only - Transmit on TG, receiveon TG,

Announcement Group Only - Transmit on AG,
receiveon al TGsin AG

Talk and Announcement Groups - Transmit on
TG and receive on TG plus AG but not the TGs
assigned tothe AG.

NOTE: These IDs can be entered in either the decimal
or hexadecimal format as described in Section 1.9.4.

Talk Group ID - Selects the talk group selected by
that channel. Talk Groups are programmed by
selecting “ Talk Group List” onthe Per System screen
(see page 49).

Announcement Group ID - Selects the receive-only
announcement group selected by that channel.
Announcement Groups are programmed by selecting
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“Announcement Group List” on the Per System
screen (see page 51).

Emergency Group ID - Selects the talk group used
for emergency calls on the channel.

Other

Talk Permit Tone - When this feature is checked, a
short tone sounds after arequest for agroup call has
been approved by the main controller. Thisindicates
that speaking can begin. When not checked, no audio
feedback is used to indicate when speaking can

begin.

M ake Dynamic Regrouping Channel - Checking this
box designates the channel as the dynamic
regrouping channel. The talk group isthen
programmed over the air, so the Talk Group ID and
Announcement Group ID are not programmable.

Dynamic Regrouping must be enabled on the System
screen to program a dynamic regrouping channel.
The dynamic talk group does not need to be a
programmed group.

Transmit Disable* - When this feature is checked,
transmitting is disabled on the channel, and it can be
used for monitoring only.

* This feature available only in 51xx models with code 1.12.1/2.2.1/
3.2.1 or later and 53xx models with code 1.24.1/2.2.1/3.2.1 or later.
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SECTION 9 PROJECT 25 TRUNKED SYSTEMS AND CHANNELS

Global | Fiadiowide Per System | Zane |

Syztems
P25 Trunking 7
Index  Tupe
. ID

1 Conventional

2 Smarthet 5330 System: pc: =

3 SmarZone_£330 I I

4 P25 Trunking_DC3

e WACH 1046574 ]

i =
Siter 1 =

= EditList ...

Emergency

Emergency Alarm:
[ Emergency Call
[ Emergency Hot Mic

Emer. Haot Mic Time: |10 j‘[s]

. =
Urit  [1E777215 j e ID_;I " Conversation Type: |PTT-ID =
Time / Timers [ Status Aliaging
Inf.
Keys T [ Dynamic Regrouping
Failzoft: I ﬁ Time Out Timer: 1] j [z]
I—;I : = Default RCH Addr.: |FFFFFC
eteh ° = FFSS Respore Tins: |22 = s Frivate Call Usage: | Dizabled -
Private Call: |0 i Force Unmute Time: 1200 j [mz] ' l—_|
Interconnect: |0 ﬁ PTT “/aming Time: 0o j [ms) _
I—J . = ~ Call Alert Usage: Dizabled -
= pusy Hpdate Timet = . Transmit Power: Low -
System Lists Resp. Pending Timer; |6 j 5] :
ISP Sequence Length: |5 s [ :I
Chanrel ID List =] -

Quick Fade Pratect: 2000 ﬁ [mz)

Scan Hold Time:

Oither
m v Talk Permit Tone
[~ Radio Inhibit
[~ Radio Check

[~ SmartZone Coverage Type

Cuztomized Roaming Properties

LCustomize ...

El=

Figure 9-1 P25 Trunked System Screen

9.1 INDIVIDUAL P25 TRUNKED SYSTEM
PARAMETERS

NOTE: Some P25 trunking parameters can be edited
only if the proper systemkey is detected. A key isbeing
detected if a yellow key icon isindicated as shown in
Figure 8-1. If thereisared “ X" through thisicon, a
key is not being detected. Refer to Section 13 for more
information.

Individual system parameters are programmed by
the “Per System” screen shown in Figure 9-1. These
parameters can be programmed after the desired
systems have been set up as described in Section 1.10.

There are also radio wide system parameters that
are programmed by the Radio Wide screen as
described in Section 5.7. For information on program-
ming individual Conventional and SMARTNET/
SmartZone system parameters, refer to Sections 7.1
and 8.1.
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The parametersin the individual P25 Trunked
System screen are as follows:

IDs

NOTE: These IDs can be entered in either the decimal
or hexadecimal format as described in Section 1.9.4.

System ID - This drop down list selects the Home
System ID of theradio. This must be aunique ID
within a Wide Area Communications Network
(WACN). ThisID comes from the system key in the
“Keys’ folder (see above“Note” at beginning of this
section). System ID numbers can be 1-4094 (001-
FFE hex). If avalid system key is not detected, only
adefault ID of “1” can be selected.

WACN - This D determines the home Wide Area
Communications Network to which theradiois
assigned. One or more systems make up a WACN.
Valid WACN IDs are 1-1048574 (00001-FFFFE
hex).
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Site - Specifiesthe home site of theradio. If the Zone
Fail SiteLock featureisenabled, thisalso determines
the site to which the radio is restricted.

RFSS - Specifiesthe RF subsystem (zone controller)
that is used as the default, or that theradio is
restricted to if the SmartZone coverage option is
enabled. One or more RF Subsystems make up a
system. Vaid IDs are 0-254.

Unit - Providesauniqueidentification of theradioon
asystem. Therefore, each radio must have adifferent
Unit ID. Valid Unit IDs are 1-16,777,215 (000001-

FFFFFF hex). The decimal version of thisID isthe
private call 1D of the radio.

Keys

Programs the following encryption key ID (hard-
ware location) that is used for all except group calls.

Failsoft - Key used in failsoft conditions.
Patch - Key used in patch calls.

Private Call - Key used for unit-to-unit (private)
cals.

Interconnect - Available with afuture release.

Dynamic Talk Group - Available with a future
release.

System Lists - Refer to page 59 for more information.
Emergency

Emergency Alarm

Disabled - No emergency signal is sent when the
user presses the Emergency option switch.

Normal - An emergency alarm is sent when the
user presses the Emergency switch. If the Emer-
gency Call isdisabled, the dlarm always occurson
the selected group. If the Emergency Call is
enabled, it occurs, in order of preference, on the
Emergency group, selected group, and Announce-
ment group. When an emergency conditionis sent,

the red transmit indicator lights, an emergency
tone sounds, and EMERGNCY flashesin the
display. EMERGNCY continues to flash until
power is cycled, the channel is changed, or the
Emergency switch is pressed and held.*

Silent - Same as“Normal” except none of the
above audio or visual indications occur.

Emergency Call

Enable - When this box is checked, if the Emer-
gency option switch and then the PTT switch are
pressed, an emergency group call istransmitted on
the Emergency group. The emergency mode is
canceled by cycling power or pressing and
holding* the Emergency switch.

Disable - When this box is not checked, an emer-
gency group call is not authorized.

Emergency Hot Mic

Enable - When this box is checked and an emer-
gency alarm is sent by pressing the Emergency
switch, automatic transmitting occurs with the
microphone audio unmuted (without user inter-
vention) for the time specified by the following
Emergency Hot Mic Time. If itisnot checked or if
neither emergency call is selected, automatic
transmissionsdo not occur. Thisfeatureisinitiated
only by thefirst press of the Emergency switch.
Subsequent presses do not trigger automatic trans-
missions. This function resetsif the channel is
changed.

Disable- When thisbox isnot checked, automatic
transmissions do not occur.

Emergency Hot Mic Time - Defines the period
during which transmissions occur with the micro-
phone audio unmuted (without user intervention).
Times of 10-120 seconds in 10-second steps can be
selected.

Emergency Retry Counter - When “Infinite” is
checked, an emergency call is repeated until
acknowledged or canceled. When it is not checked,
calls are attempted only the specified number of
times.

* This feature available only in 51xx models with code 1.12.1/2.2.1/
3.2.1 or later and 53xx models with code 1.24.1/2.2.1/3.2.1 or later.
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TimeTimers

Time-Out Timer - Thistimer determines the
maximum length of acontinuoustransmission. It can
be programmed for 15-225 secondsin 15-second
steps or it can be disabled (0).

RFSS Response Time - Specifies the time between
attempts to affiliate on RFSS sites. Times of 625-
7000 ms can be programmed with a default of 625
ms.

Force Unmute Time - Specifies the maximum time
theradio remains muted after transmitting because of
probable system throughput delay. If it isdetermined
that the incoming audio signal is from some other
radio, thisdelay isdisregarded. Times of 25-6375ms
can be programmed with a default of 1200 ms.

PTT Warning Time - Specifies the time the radio
waits before sounding the PTT Prohibit Tonetowarn
the user that the PTT request is being processed and
the PTT switch should bereleased. Times of 25-6375
ms can be programmed with a default of 4000 ms.

Busy Update Timer - Specifies the time the radio
waitsin abusy state for areject, grant, or another
busy update from the radio system. When this timer
expires, aresponse is no longer expected from the
system and the transmission is retried. Times of 15-
945 seconds can be programmed with adefault of 30
seconds.

Response Pending Timer - Specifies the time the
radio waits when expecting a further response from
the radio system to arequest. This occurs when the
system sendsaresponseindicating that therequest is
being processed and aresponseiscoming. When this
timer expires, aresponse is no longer expected and
the radio returnsto theidle state. Times of 1-255
seconds or infinite can be programmed with adefault
of 6 seconds.

I SP Sequence L ength - Specifies the time allowed
per site for an ISP retry request. Theradio retries
until thistimer expires (at least five retries are made
regardless of thistimer setting). Times of 1-255
seconds or infinite can be programmed with adefault
of 5 seconds.
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Quick Fade Protect - Specifiesthetimethe radio will
stay on the control channel when synchronization is
lost before resynchronizing. This allows recovery
without performing afull resynchronization of the
channel. Times of 200-6575 ms can be programmed
with adefault of 2000 ms.

Scan Hold Time - Specifies the delay that occurs
after amessageisno longer received before scanning
resumes. Times of 2-10 seconds can be programmed
with adefault of 3 seconds.

Other

Talk Permit Tone - When selected, a short tone
sounds after arequest for agroup call has been
approved by the main controller. Thisindicates that
speaking can begin. When not checked, no audio
feedback is used to indicate when speaking can

begin.

Radio Inhibit - When selected, the dispatcher can
disable/enable the radio. When this command is
received by the radio, an acknowledgment is sent to
the dispatcher and then it is disabled asfollows. The
radio can be enabled again by the dispatcher or by
reading and then re-writing the programming data
using PCConfigure.

® Receive audio is muted and transmit audio
disabled

® All radio controls are inoperative

® Scanning is disabled on the selected mode (P25
trunking)

® The transmit indicator is disabled and the display
is blanked

Radio Check - When selected, the radio will respond
to aremote check command. This command can be
sent by the dispatcher to confirm that theradio is
activeand operational onthe system. If thisfeatureis
not enabled, this command is ignored.

SmartZone Coverage Type - When sel ected, roaming
islimited to the selected RFSS controller. If not
selected, roaming can occur across all available
RFSS controllersin the WACN system.




PROJECT 25 TRUNKED SYSTEMS AND CHANNELS

Conversation Type

M essage Trunking - Not available with P25
trunking.

PTT - 1D - Thismode is always sel ected with P25
trunking. This mode is aways selected with P25
trunking. The radio can key during the
programmed hang time and continue the conversa-
tion onthe active channel. If auser keysduring the
hang time, re-affiliation with the system occurs
before using the voice channel. The voice channel
isheld whilethisre-affiliation occurs, and the call
is then routed to the open voice channel. This
resultsin all traffic being logged, even the radios
which transmit during the hang time.

Transmission Trunking - Not available with P25
trunking.

Status Aliasing - Enables and disables Status
Aliasing for the system. This function permits
customization of status numbers and allows an alias
name to be assigned to each number.

Dynamic Regrouping - When checked, a dynamic
regrouping channel can be programmed. Thisisa
Project 25 trunked channel which has the talk group
dynamically set by the dispatcher. It is selected on
the channel screen (see Section 9.3).

Default RCM Address - Specifiesthe Radio Control
Manager used as the target address of Inbound
Signaling Packet (1SP) transmissions such as Status
and Message transmissions. Hexadecimal addresses
from 000000-FFFFFF can be programmed, and the
default is FFFFFC.

Private Call Usage

Disabled - Private calls cannot be placed or
received.

Response Only - Private calls can be received but
not placed.

List Only - Private calls can be placed and
received, and numbers can be recalled from a
preprogrammed list only.

Unlimited - Private calls can be placed and
received, and numbers can be recalled from a
preprogrammed list or dialed using a microphone
keypad. Thismodeis currently not supported with
5300 radios and the preceding “List Only” mode
should be used instead. NOTE: To enter thismode,
the key must be pressed and held for a short time
until a tone sounds.

Cdll Alert Usage - Programs operation of Call Alert
calls(pages) the same as* Private Call Usage” above.

Transmit Power - Fixes the transmit power on the
system for the high or low level or makes it select-
able (the high/low power function switch isthen
required).

Customized Roaming Properties - Same as with
SmartZone operation. Refer to description on

page 45.

9.2 P25 TRUNKED SYSTEM LISTS

The various P25 trunking lists are selected by the
“System Lists’ drop-down list on the P25 Trunking
Per system screen (see Figure 9-1). After the desired
listis selected, it is edited by clicking the | = EdiList..
button. Descriptions of the various lists and the infor-
mation they program follow.

Channel Identifiers

No Bandwidth (KHz) [ T+ Offset Sign (+/-) [ T Difset (MHz] [Spacing [KHz) [Base Frequency (MHz] | o 0K
1 v |~ _~|/001.0000 006, 2500 137.00000

2 T 125 - 0 0 0 X Cancs
a I |125 0 0 0

4 T |28 0 a g 7 Hei
5 T [125 0 0 0

6 [ |125 0 0 0

2125 0 0 0

8 [ |125 0 0 0

ERRES 0 0 0

0 [125 0 0 0

T |125 o o [

12 T |125 0 0 0

13 [ 125 0 o [

14 [ |125 0 0 0

15 T |125 0 o 0

16 [ 125 0 0 0

Channel ID List (VHF/UHF Only)

The Channel 1D List screen shown above can be
displayed only when programming channelsin the
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VHF and UHF frequency bands (Other Band
Trunking). Both Explicit* and Implicit addressing is
now available.

With Implicit Addressing, only the receive
frequency is sent by the control channel and informa-
tionin thistable is used to determine the transmit
frequency. With Explicit Addressing, both the receive
and transmit frequencies are sent. Both types reference
information in thistable. Thistableis not required
with 800 MHz systems because the difference between
transmit and receive frequency is always 45 MHz.

Control Channel List

Ma [Tx [MHz] [Rx MHz) | oiele |
1 5060125 [551.0125
2 307.0125 852.0125 Delete |
3 B08.0125 853.0125
4 509.0125 854.0125
X Cancel |
“? Help |
Max Entries: 4 T« =Rz - 45 MHz

The Control Channel List screen shown above
allowsthe system manager to view and edit the control
channels. Each P25 trunking system can have up to
255 control channels. Only one control channel is
active at atime.

To display this screen, on the P25 Trunking
System screen, select Control Channel List in the
drop-down list and then click the ' ‘= EdiList... | button
(see Figure 9-1).

To add achanndl, click the | s | button, and
to delete a channel, simply select it and click the
Delete button. To edit a channel, select the digits to be
changed and edit them as desired. For the 800 MHz
band, only the receive channel frequency can be
changed and the transmit frequency is automatically
calculated (45 MHz below the receive frequency).
These are the maobile frequencies, not the repeater
frequencies. Only multiples of 5 kHz and 6.25 kHz are
valid.

Status Alias List

Mo [édias | Add
1 OFF DUTY
2 OM DUTY Delete |
3 AT LUMCH
4 OM PATROL|
x Cancel

? Help |

bl ax Entries: &

The Status Alias List screen shown above
programs the alias for each of up to eight status condi-
tions that can be sent. The meaning of each status
number is defined by the system manager.

To display this screen, on the P25 Trunking Per
System screen, select Status Alias List in the drop-
down list and then click the = EdtList... | button (see
Figure 9-1). To add an dlias, click the | s« | button,
and to delete an dias, simply select it and click the
Delete button. To edit an dlias, select it and change it
as desired. Up to 10 characters can be entered that
identify the status. Thisidentification is displayed
when the user selects a status condition.

Call List
=
Ho  [alias & |
1 FRED SHABE 1 =
2 LARFY WOLF 2 Delete |
3 |DONSMITH 3 e
4 |MEw aLlAS 1
— o]
[
[
W 0K I
x Cancel I
7 Help I
tax Entries: 255

The Call List screen shown above programs the
list of IDs used for unit calls. A maximum of 16 IDs
can be programmed. To display this screen, on the P25
Trunking Per System screen, select call list in the
drop-down list and then click the | ‘= EdiList...
(see Figure 9-1).

* This feature available only in 51xx models with code 1.12.1/2.2.1/
3.2.1 or later and 53xx models with code 1.24.1/2.2.1/3.2.1 or later.
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To add acall, click the | 4 | button, and to
delete an call, simply select it and click the Delete
button. To edit an Aliasor ID, select it and enter the
desired information as follows:

Alias- Upto ten characters can be entered to identify
the user being called. Thisidentification isdisplayed
when the mabile to be called is selected by the user
fromthelist. Inaddition, when acall isreceived from
aunitinthislist, thealiasof theunitisthen displayed
instead of the unit ID number. Only uppercase letters
can beentered, solowercaselettersare automatically
converted to uppercase by the program.

ID - Thisisthe ID of the radio being called. Valid
entriesare 1-16,777,215. “0" is detected as no entry.

Talk Group List

The Talk Group List screen which follows sets up

entered in either the decimal or hexadecimal format
as described in Section 1.9.4.

s | - Clicking this button adds the next avail-
able talk group ID to thelist. Each P25 trunking
system can be programmed with up to 255 talk
groups.

To add an entire block of talk group IDs or a specific
ID, click the arrow button | »» inthe lower right
corner of the screen. The following screen isthen

displayed:

Add Maod

| Muliple
Multiple Ad

Start [D: I'l (O]
|0 Count: |2
ID Step: I'l

[

P25 Trunking talk groups and programs unique talk
group information. To display this screen, on the P25
Trunking Per System screen, select the Talk Group
List drop-down system list and then click the

= Edelist... | button (see Figure 9-1).

Add Maode Drop Down List - “Single” adds the next
available ID similar to the preceding “Add” button.

“Multiple” addsablock of IDsasfollows. Toinitiate
the sel ected add operation, click the preceding “ Add”

e s button. If the specified ID range results in duplicate
larou 1 [ Selectes 1oy . .
o sk IDs, an error message is displayed and no IDs are
% Delete ajded.
g —Security Parameter: Use Sys Preferred Site List ¥ — “z Site Lists
12
1apping Mode; Secure List tor lse: i - L. i
i Sl ot b _H Start 1D - Specifies the starting 1D of the block.
ncryphion Key _'I —_— .
ID Count - Specifies the number of IDs to be
r~Failzoft Frequencie:
Tx MHz] Fix (MHz] [~ Enabled wde(j.
000.0000 Tx =Fix - 45 MHz
e EETE ID Step - Specifiesif consecutive |Dsare added or
cleche e H H
e Ceeseast — some other step rate is used. For example, if Start
Preferred Site 2
[ Freferred Site 3 sie;: [T ID 210, ID Count = 5, and ID Step = 10, the IDs
o X conel added are 10, 20, 30, 40 and 50.
7 e |
T # e Brovs 259 % Delte | - Clicking this button deletes the talk

group that is currently selected in thelist.
The parameters programmed in this screen are as
follows: Strapping Mode
Group ID - Thislist displays the talk group IDs
currently contained in the Talk Group list. To edit a
talk group ID inthislist, select it and then change it
inthe Selected Group box. Thisistheactual ID of the
talk group. Talk groups are assigned to channelsin
the Zone screen (see page 65). NOTE: ThisID canbe

Srapped Clear - All transmissions on the talk
group occur in the clear (unencrypted) mode.

Strapped Secure - All transmissions on the talk

group occur in the secure (encrypted) mode
selected asfollows.
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Switched M ode - The clear or secure status of the
talk group is selected by the Clear/Secure option
switch.

Use System Preferred Site List - Selects one of the
preferred sites for the talk group. Refer to the
“Preferred Sites” description which followsfor more
information.

Encryption Key ID - Selects the location from 0-15
(PID/ASN mode) or 1-16 (SLN/CKR mode) of the
key used for secure calls on the group if applicable.

Failsoft Enable - If this box is checked, afailsoft
channel isenabled on thetalk group if acontroller or
other major failure occurs. If thisbox isnot checked,
the failsoft mode is not entered if afailure occurs.

Tx/Rx Frequency - Programs the failsoft channel
frequency if “Enable” is checked.

Preferred Sites

With P25 trunked systems, up to four Preferred
Sites and/or a Preferred Site List* can be associated
with each talk group. Thisforces a call on the talk
group to access the specified sites. The system
manager can then keep mobiles on specific sites even
if the “ Site Search” feature has not been enabled. The
preference for each site can be programmed for Least,
None, Preferred, or Always as follows.

The Preferred Site Lists are programmed by the
System Preferred Site List screen described on
page 64. Up to 16 lists can be programmed, and each
site can include up to 16 sites.

If both a Preferred Site List and one or more
Preferred Sites (selected at bottom of screen) are asso-
ciated with atalk group, the Preferred Sites at the
bottom are searched first. Thefirst entry found for a
given siteis used. If the same siteisin both lists, the

entry in thelist at the bottom of the screen is used first.

Use Sys Preferred Site List* - When thisbox is
checked, thetalk group isassociated with aPreferred
SiteList. The specific sitelist is selected by the drop
down list.

i Site Lists | - Displays the Preferred Site List
screen described on page 64 as a quick referenceto

* Thisfeature available only in 51xx models with Flash code Version

1.8.0 or later and 53xx models with ARM code 1.21.0 or later.

determine which sites are included in each site list.
This screen isfor informational purposes only, so
lists can be viewed but not be edited. Clicking the
“Selectinto Talk Group” buttoninthisscreen setsthe
“List ToUse” field in the main screen to the selected
list.

Talk Group Specific Preferred Sites- Up to four indi-
vidual sites can also be associated with each talk
group (see preceding information). Sites are enabled
using the checkbox, and the following informationis
programmed for each site:

RFSS/Site ID No. - Designate a controller/site to
which the talk group is allowed to roam.

Preference - Least, None (no preference),
Preferred, or Always (preferred) is aweighting
for steering to different sites.

Announcement Group List

The Announcement Group List screen which
follows sets up P25 Trunking announcement groups
that are used to communicate with several talk groups
simultaneoudly. Each announcement group can have
up to 15 talk groups.

P25 Trunking Announcement Groups E]
Group D Selected Group e
1| o [ et

Security Parameters Use Syz Preferred Site List [v "
iz Site Lists
Strapping Mode: Clear - List tor Llse: List 1 -

Encryption Key I ’1_j

Announcement Group S pecific Prefened Sites
Selected Site 1

Preferred Site 1 S 0

Prefered Site 2

Preferred Site 2 Gite D 1

]

Prefered Site 4 S ,m

Talk Group List
Talk Group ID

B -,/ oK
X Cancel
Selected Entries: 1
P Help

Toatal: 1 Max Groups: 255 33

To display this screen, on the P25 Trunking Per
System screen, select the Announcement Group Listin
the drop-down list and then click the = EdiList... |
button (see Figure 9-1).

Group ID - Thislist displays the Announcement
group IDs currently contained in the Announcement
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Grouplist. ToeditanID inthislist, select it and then
changeit in the Selected Group box. Thisisthe
actual ID of the announcement group. Announce-
ment groups are assigned to channelsin the Zone
screen (see page 65). NOTE: This|D can be entered
in either the decimal or hexadecimal format as
described in Section 1.9.4.

s | - Clicking this button adds the next avail-
able announcement group 1D to the list. Each P25
Trunked system can be programmed with up to 255
announcement groups.

To add an entire block of announcement group IDsor
aspecificlD, click thearrow button ' :» inthelower
right corner of the screen. The following screenis
then displayed. Refer to the preceding “ Talk Group
List” description for more information on this screen.

Add Maod

[

| Multiple
kultiple Ad

Start 1D I‘l D]
ID Count: |2
ID Step: I'l

Delete I - Clicking this button deletes the
announcement group that is currently selected in the
list.

Security Parameters - Programs the secure communi-
cation operation on each announcement group
similar to talk groups described in the preceding
“Talk Group List” description.

Use System Preferred Site List*- Selects one of the
preferred sitesfor the announcement group. Refer to
the preceding “Preferred Sites’ description for more
information.

Preferred Sites- Programsthe preferred site informa-
tion similar to talk groups described in the preceding
“Talk Group List” description. Up to four Preferred

* Thisfeature available only in 51xx models with Flash code Version
1.8.0 or later and 53xx models with ARM code 1.21.0 or |ater.
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Sitesand/or a Preferred Site List a can be associated
with each announcement group. Refer to the
preceding Talk Group List description for more
information.

Talk Group ID - Selects the talk groups that are
included in each announcement group.

Site List

Aliaz Site ID
1 MORTH SITE 1
2 |SOUTHSITE 2
3 EST SITE 3
4 [EAST SITE 4

10
20
a0

RFSS ID | Add |

M ax Entries: 255

Sitesin a P25 Trunking system are designated by
asite number and RF subsystem (RFSS) number. The
Site List screen shown above programs an alias for
each site that is displayed when using the Site Search
feature.

To display the preceding screen, on the P25
Trunking Per System screen, select Site List in the

drop-down list and then click the ' ‘= EdiList... | button
(see Figure 9-1).
Toadd an adlias, click the | s | button to

display the Add Alias/ID screen, and to delete an dlias,
simply select it and click the Delete button. To edit an
aliasor ID, smply select it and make the desired
changes.

Alias - Programs up to 10 a phanumeric characters
that identify the site.

SiteID - Site ID from 0-48.

RFSSID - ID from 0-254 of the site controller that
will be used.
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Priority Scan List

0oOo0ooooo@o g &

rg
g
ra
g

NOTE: Before the priority monitor scan lists can be
programmed as follows, the channels to be included in
these lists must be set up in the Zone screen as
described in Section 9.3 on page 65.

The Priority Scan List screen shown above sets
up the Priority (Standard) Scan lists that can be
programmed on each P25 Trunking system. Each scan
list can include up to 16 channels, one of which may
be a priority channel. These channels must be from the
same P25 Trunking system. Channels from other
systems are not allowed. Up to as many lists can be
programmed as can be stored in the available memory.

To display this screen, on the P25 Trunking Per
System screen, select Priority Scan List in the drop-
down list and then click the = EdtList... | button (see
Figure 9-1).

List Number - This drop-down list selects the scan
list to edit. Click the “Add” button to add a scan list
and “Delete’ to delete ascan list.

1| - Clicking this button displays the screen
n the right above which is used to edit the
selected scan list. Check the channelsin each zoneto
be included in the selected scan list. Repeat for the
other scan listsif applicable.

Scan Mode - If priority scanisused on alist, select
“Priority on Selected” (51xx/53xx only) or “Priority
on Programmed” from the drop down list. If priority
scanning is not used, select “Non Priority Scan”. If

“Priority on Programmed” is selected, check the box
of the desired priority channel.

NOTE: Priority talk group scanning must also be
supported at the system level for it to occur as
programmed. Talk Groups programmed as “ Priority”
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in PCConfigure must also be designated as Priority
Monitor Groups by the System Control software.

System Preferred Site List

The Preferred Site List screen which follows
programs up to 16 Preferred Site Lists. These lists can
be associated with individual talk groups on the Talk
Group List screen described starting on page 61. This
forces calls on atalk group to access specific sites. The
preference for each site in alist can be set for Least,
None, Preferred, or Always as follows.

Each list can be programmed with up to 16 sites.
Therefore, the use of Preferred Site Listsalows up to
16 sites to be associated with a group instead of just 4
available on the Talk Group List screen. In addition, if
several talk groups are associated with the same sites,
alist can simply be selected instead of separate sites.

r—Site List
QK.
[t =] Add Delete | [ o |
x Cancel |

rSitesInLisk——— 1 [ Selected Site

Prefemed Site 1 Site 1D |45

Prefemed Site 2 T m
Prefered Site 3
Prefemed Site 4
Prefemed Site &
O Prefered Site &
O Prefered Site 7
O Prefemed Site &
O Prefered Site 9
O Prefermed Sits 10
O Prefemed Site 11
O Prefered Site 12
O Prefered Site 13
O Prefered Sits 14
O Prefered Site 15
O Frefered Site 16

Max Lists: 16

Site Lists- This drop down list selectsthelist to be
edited. To add anew list, click the“Add” button. To
delete the selected list, click the “Delete” button.

SitesIn List - To add/delete asite from thelist, click
the checkbox.

Site ID - Enter the site ID from 0-48.
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Preference - Select the site preference in the drop
downlist. A default weighting is usually assigned to
these preference levels which results in the most
preference given to “ Always’ and the least prefer-
enceto “Least” asfollows:

block. For example, with the preceding screen, if a
group call isreceived on group I1Ds 234-264, the dias
“Fire” can be displayed. The display of thisaliasis
controlled by the “User Group ID” parameter on the
Radio Wide screen.

1. Always (preferred) x
2. Preferred No [Bias [satiD  [StopiD | fdd
3. None (no preference) [ 234 264
4 LeaS[ (preferl‘ed) 2 FOLICE 265 275 Delete |
User Group ID List* « Ok
X Cancel |
This U_ser Group ID List screen Whlch follpws 2 1o I
programs aliases that can be displayed if acall is
f ) Max Entries: 32
received on atalk group ID within the programmed
Global | FiadioWide | Per System Zane |
rZones | [ Channel Parameter
Alias: Im Channel Type . r— Other
P28 Trunking [~ Make Dynamic Begrouping Channet
FF EditZone ... | =y [~ T=Dizabled
[P25 TwWO
rChanngls—————
Murmber of Channels: 5 Scan List
List Selection: -
No| Syztem |
1 04 : P25 Trunking_1
2 P25 Trunking_1 I Auto Sean
3 04 : P25 Trunking_1
4 04 : P25 Trunking_1 ; _
5 04:P25 Tiunking 1 o G E
Talk Group |D: |1 vI
Announcement Group 10: INnne vI
Emergency Group [D: INDne b I

Figure 9-2 P25 Trunked Channel Screen

9.3 P25 TRUNKED CHANNEL PARAMETERS

After the desired channels have been set up as
described in Section 6.3, individual channel parame-
ters can be programmed. Select the Zone screen shown
in Figure 9-2 and then select the desired Zone using
the drop-down list in the “Zones” box. Screens which
program individual channel parameters are selected by
clicking the channel in the “ Channels’ box.

The parameters displayed when a P25 Trunking
channel is selected are as follows. Conventional and

SMARTNET/SmartZone Trunked channels are
described in Sections 7 and 8.

Channel Parameters

Channel Type - Indicates the type of channel
(Conventional Analog, Conventional Digital,
SMARTNET/SmartZone, Project 25 Trunked) that is
currently selected in the “Channels’ box.

Channel Alias - Programs the alias (identification)
that is displayed when the channel is selected. Up to
ten characters can be programmed.

* This feature available only in 51xx models with code 1.12.1/2.2.1/
3.2.1 or later and 53xx models with code 1.24.1/2.2.1/3.2.1 or later.
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Scan List - Selects the priority (standard) scan list
selected by the channel. If “No List” is selected,
scanning is not selectable on that channel.

Auto Scan - When thisis checked, the radio automat-
ically begins scanning the scan list associated with
the channel whenever the channel is selected. When
it is not checked, scanning must be started manually
by the Scan option switch.

IDs

The possible combinations of Talk Groups (TGS)
and Announcement Groups (AGs) provide the
following operation:

Talk Group Only - Transmit on TG, receiveon TG

Announcement Group Only - Transmit on AG, receive
onal TGsin AG

Talk and Announcement Groups - Tx on TG and rx on
TG plus AG but not the TGs assigned to the AG.

NOTE: These IDs can be entered in either the decimal
or hexadecimal format as described in Section 1.9.4.

Talk Group ID - Selects the talk group selected by
that channel. Talk Groups are programmed by
selecting “ Talk Group List” onthe Per System screen
(see page 61).

Announcement Group ID - Selects the announce-
ment group selected by that channel. Announcement
Groups are programmed by selecting “ Announce-
ment Group List” on the Per System screen (see

page 62).

Emergency Group ID - Selects the talk group used
for emergency calls on the channel.

Other

M ake Dynamic Regrouping Channel - Checking this
box designates the channel as the dynamic
regrouping channel. The talk group isthen
programmed over the air, so the Talk Group ID and
Announcement Group ID are not programmable.

Dynamic Regrouping must be enabled on the System
screen to program a dynamic regrouping channel.
The dynamic talk group does not need to be a
programmed group.

Transmit Disable* - When this feature is checked,
transmitting is disabled on the channel, and it can be
used for monitoring only.

* This feature available only in 51xx models with code 1.12.1/2.2.1/
3.2.1 or later and 53xx models with code 1.24.1/2.2.1/3.2.1 or later.
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SECTION 10 PASSWORD DESCRIPTION

10.1 NEW PASSWORD ENHANCEMENTS
10.1.1 INTRODUCTION

NOTE: Passwords are not available with the 7780
portable and 9883 maobile.

A new enhanced password feature is now avail-
ablefor 5100 portables and 5300 mobiles. The number
of passwords have been increased along with the
number of functions that can be under password
control. The single Power-On password has been
replaced by the following passwords:
® Four Power-On (User x) Passwords
® Download and Upload Passwords
® Master Password
10.1.2 SOFTWARE VERSIONS REQUIRED

Thefollowing revised PCConfigure and radio
software is required for these new enhanced password
features:

PCConfigure - Version 1.21.8 or later
5100 Portable
Version 1.x Models- 1.12.1 or later

Version 2.x Models - 2.2.1 or later
Version 3.x Models - 3.2.1 or later

5300 Mobile

Version 1.x Models- 1.24.1 or later ARM
Version 2.x Models- 2.2.1 or later
Version 3.x Models - 3.2.1 or later

NOTE: Refer to Section 16 for more information on
the preceding radio firmware versions.

10.1.3 AVAILABILITY WITH EARLIER
VERSIONS

The Power-On password feature available with
earlier versions of radio firmware is no longer
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programmable using the latest versions of PCCon-
figure (1.21.2.8 or later). To program that feature in
earlier radio models, an earlier version of the PCCon-
figure software must be used. It is programmed using
the “Password at Power Up” function on the Global
screen.

Otherwise, PCConfigure 1.21.2.8 or later can be
used to program earlier radio models with the limita-
tion that any new features which require updated firm-
ware are not available.

10.2 PROGRAMMING PASSWORDS
10.2.1 GENERAL

With new versions of PCConfigure, the “Pass-
word at Power Up” parameter has been removed from
the Global screen asjust described. Passwords are now
programmed using a password management screen
displayed by the Tools > Password Management menu
(see Section 3.4). The applicable radio must be
connected to the computer and powered up to display
this screen.

Password datais transferred and stored in an
encrypted format for security purposes. In addition,
actual passwords are never displayed. They are always
indicated by eight asterisks (********) Therefore, it
is not possible to determine what passwords arein a
radio using the PCConfigure software.

Passwords must be 1-8 charactersin length and
consist of the numbers 0-9. Zeros are valid characters
in any location, even asleading characters. Initialy, all
passwords are null (deleted) characters. Therefore,
when initially programming a password, no entry is
required in the “ Original/Master Password” box.

10.2.2 LOST PASSWORDS

If apassword islost, it can be changed using
PCConfigure by entering the Master password (see
following). If even the Master password islost or was
not used, al passwords (and other radio programming)
can be erased using the PCTune software as follows:
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1. WithPCTune1.1.1.0 or later, smply select Radio >
Reset Passwords.

2. With earlier versions of PCTune, after starting the
PCTune program, press SHIFT CTRL E to toggle
thefollowing Erase EEPROM function (otherwiseit
isgrayed and not selectable). Then Select Radio >
Erase EEPROM > Params Only. NOTE: DO NOT
SELECT “COMPLETE” because that erases all
information and the radio must then be sent back to
the factory to make it usable again.

10.2.3 CHANGING PASSWORD

An assigned password can be changed by the user
if the “Set User Password” option button or menu
parameter (5100 only) is programmed. Selecting this
function displays prompts for entering and confirming
anew password.

NOTE: Wth the 5100 portable and 5300 Handheld
Control Unit, it is recommended that a number key not
be used for this function because the password modeis
exited if that key is pressed to enter a number.

10.2.4 PASSWORD ENTRY PROCEDURE

Whenever a password isrequested, it isentered as
follows:

53xx Mobile - Rotate and press the Select switch.

51xx Portable - With DTMF keypad models, enter
each number using the keypad and pressthe F2 (Enter)
key after the last digit is entered. With limited keypad
models, enter each number by pressing the Up/Down
switch and press the F2 key after each digit.

10.3 PASSWORD DESCRIPTION
10.3.1 USER (POWER-ON) PASSWORDS

When a User Password is enabled, it must be
entered each time radio power isturned on. Up to four
different User Passwords (User 1/User 2/User 3/

User 4) can be programmed. Currently, the same radio
features are enabled for each. Entering any User Pass-
word at power up enables normal radio operation.
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10.3.2 DOWNLOAD/UPLOAD PASSWORDS

Separate Download (write) and Upload (read)
passwords can be programmed to prevent unautho-
rized downloading or uploading of radio programming
parameters (see Section 3.3). When one or both of
these passwords are used, the proper password must be
entered to perform the operation. A “User” password
is not required to upload or download parameters.

10.3.3 MASTER PASSWORD

The Master Password overrides all the preceding
passwords. It can be used by a system administrator as
a“pass key” to apassword controlled function or to
change alost or inadvertently changed password.
Master passwords are set up and changed the same as
the other passwords. It does not override the following
Zone Password.

10.4 ZONE PASSWORD

NOTE: The programming and usage of this password
has not changed. It is independent from the preceding
passwords, and programmed in the Zone > Edit Zones
and Channels screen.

A zone password can also be programmed with
the 53xx mobile and 51xx portable. It prevents unau-
thorized reprogramming of zones by keypad program-
ming. When this password is used, it must be entered
before system or channel parametersin that zone can
be changed. The zone password is programmed in the
Edit Zones and Channels screen. Thisscreenis
displayed by clicking the Edit Zone button on the
Zone screen (see Section 6.2).

A different password can be programmed for
each zone. When a password protected zone is
selected, “PASSWORD?” isflashed the first time an
attempt is made to select a system or channel
parameter in that zone. Each digit of the password is
then entered as previously described. The password is
aways eight digitslong, and after the eighth digitis
entered, system and channel parameters for that zone
can be reprogrammed normally.
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SECTION 11 KEYPAD PROGRAMMING (53xx MOBILE)

11.1 INTRODUCTION

NOTE: Keypad programming is permitted by Federal
Government users only. It is not permitted by any user
regulated by the FCC (Federal Communications
Commission). Radios with ARM code 1.22.0 or later
requirethat the Keypad Programming option befactory
enabled to program this feature (see Section 3.3).

Since keypad programming is permitted by
Federa Government users only, only Federal models
of thistransceiver can be programmed with this
feature. It isthen available if a conventional mode
option switch is programmed for the “Keypad
Programming” function.

Keypad programming is then selected by simply
pressing this switch (password entry is not required).
The keypad programming mode isindicated by
“CHNG ZONE" and atrianglein the display as
follows:
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Keypad programming allows conventional
channel parameters such as the transmit and receive
frequency and Call Guard squelch code to be changed.
In addition, several conventional mode timers can be
changed. It cannot be used to reprogram disabled
channels or P25 Trunked and SMARTNET/SmartZone
information.

11.2 MENU DESCRIPTION

A menu system is used to select parametersto be
changed in the keypad programming mode. Rotate and
press the Select switch to scroll through and select the
available parameters. The available parameters and the
section in which each is described are as follows:

CHNG ZONE (11.3)
CHNG CHAN (11.4)
SYSPARMS (11.5)
CHAN PARMS (11.6)
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Press the Select switch to select the displayed
parameter. Press the Keypad Programming option
switch from one of the main menusto exit keypad
programming or from another menu to exit back one
level. Pressing it in the other menus returns to the
previous menu. A flowchart showing the keypad
programming mode menu structure is located below.

Change Change | System Channel
Zone || Channel [*™| Parameters [*"| Parameters
A A
! !
Select Select
Zone Channel Rx Code/NAC [P
: Tx Code/NAC |-~
| Scan Hold Timer l‘—» -
[Tx (Time-Out) Timer ||
[ Penalty Timer |9 Ch Spacing* |-
| Conver. Timer |<—> Squelch Adj*
* Analog only ~ ** Digital only Tlk Grp ID Sel™

*** Mixed Mode Ch Only Tx Type Sel***

Figure 11-1 53xx Keypad Programming Menu
Flowchart

11.3 ZONE CHANGE PARAMETER

The“CHNG ZONE" menu parameter selects the
zone containing the conventional channel to be repro-
grammed. It does not change the zone selected for
normal operation.

Press the Select switch to select the “CHNG
ZONE" parameter and then scroll through the
programmed zones by rotating that switch. When the
desired zone is displayed, select it by pressing the
Select switch.

11.4 CHANNEL CHANGE PARAMETER

The“CHNG CHAN" menu parameter selects the
conventional channel to be reprogrammed. Disabled or
P25 Trunked/SMARTNET/SmartZone channels
cannot be selected. This does not change the channel
selected for normal operation.

Press the Select switch to select the “CHNG
CHAN" parameter and then scroll through the
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programmed channels by rotating that switch. When
the desired channel is displayed, select it by pressing
the Select switch.

11.5 SYSTEM PARAMETERS

NOTE: If “ ENTER PSWD” is briefly displayed when
attempting to select one of the following parameters,
the zone password must be entered before changes can
be made. Refer to Section 10.4 for more information.

The"SYSPARMS’ menu parameter selects the
conventional mode timer to be reprogrammed (see
following). Press the Select switch to select the“SY'S
PARMS’ parameter and then rotate that switch to
display the desired parameter. Then press the Select
switch again to select it.

SCAN TIMER - Selects the Scan Hold timer.
Rotate the Select switch to decrement/increment
the timer in 0.5-second steps (“0” disablesiit).
When the desired value is displayed, storeit by
pressing the Select switch.

TX TIMER - Selects the transmit time-out timer.
Rotate the Select switch to decrement/increment
thetimer in 15-second steps (“0” disablesit). When
the desired value is displayed, store it by pressing
the Select switch.

PEN TIMER - Selects the penalty timer. Rotate
the Select switch to decrement/increment the timer
in 15-second steps (“0” disablesit). When the
desired value is displayed, store it by pressing the
Select switch.

CONV TIMER - Sdlects the conversation timer.
Rotate the Select switch to decrement/increment
the timer in 30-second steps (“0” disablesit). When
the desired valueis displayed, storeit by pressing
the Select switch.

11.6 CHANNEL PARAMETERS

NOTE: If“ ENTER PSWD” isbriefly displayed when
attempting to select one of the following parameters,
the zone password must be entered before changes can
be made. Refer to Section 10.4 for more information.

The“CHAN PARMS’ menu parameter selects
the following conventional channel parameters that
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can be reprogrammed. Press Select switch to select the
“CHAN PARMS’ parameter and then rotate that
switch to display the desired parameter. Then press the
Select switch again to select it.

NOTE: If a mixed mode channd is selected, both the
Rx Code (analog) and Rx NAC (P25) which follow can
be programmed. In addition, if the Tx Type which
follows is Analog, a Tx Code is programmed, and if it
isDigital (P25), a Tx NAC is programmed.

RX FREQ - Setsthe receive channel frequency. To
select the digit to change or move the cursor to the
right, press the Select switch. Then to display the
desired digit, rotate the Select switch. The frequency is
stored after programming the last digit. If aninvalid
frequency is entered, a beep sounds, “INVALID” is
briefly displayed, and the frequency editing mode
continues to be selected.

TX FREQ - Selects the transmit frequency the same
as RX FREQ above.

Squelch Control (Analog Channel)

RX CODE - Setsthereceive Call Guard (CTCSY
DCS) code. Rotate the Select switch to select the
desired type (CTCSS and DCS). Then press and
rotate the Select switch to select the desired code.
The displayed code is stored after the last digit is
programmed. If an invalid code is entered, a beep
sounds, “INVALID” is briefly displayed, and the
editing mode continues to be selected.

TX CODE - Selects the transmit codes the same as
RX CODE above.

Squelch Control (Project 25 Channel)

RX NAC - Selects the Network Access Code
(NAC) which can be any number from 0-4095.
Rotate and press the Select switch to enter the
desired code. The displayed code is stored after the
last digit is programmed. If an invalid codeis
entered, a beep sounds, “INVALID” isbriefly
displayed, and the NAC editing mode continues to
be selected.

TX NAC - Selects the transmit NAC the same as
RX NAC above.
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TX POWER - Selects the desired power output level.
Rotate the Select switch to scroll through the
following choices. When the desired setting is
displayed, store it by pressing the Select switch.

® POWER HI - High transmit power

® POWER LO - Low transmit power

® POWER SW - Switchable power selectable by
the High/Low power switch. This choiceisnot
availableif that switch is not programmed.

TX TIMER - Enables or disables the time-out timer
on the current channel. Rotate the Select switch to
toggle between the on and off mode, and when the
desired setting is displayed, store it by pressing the
Select switch.

CHAN SPACE (Analog Only) - Selects either wide
or narrow band channel spacing on analog channels
only. Rotate the Select switch to toggle between
“WIDE” and “NARROW", and when the desired

setting is displayed, storeit by pressing the Select
switch.

SQ ADJUST (Analog Only) - Changes the preset
squelch setting on that channel. The default setting is
“0" and values of —7 to +7 can be selected. Increasing
this setting toward +7 causes the squelch to open
sooner so that weaker signals can be received, and
decreasing it toward —7 causes the opposite to occur.

TG ID (P25 Only) - Selects the talk group for the
selected channel. Rotate the Select switch to display
the aias of each preprogrammed talk group and then
press it to store the desired talk group.

Transmit Type (P25 Mixed Mode Only) - If the
selected channel is a mixed mode, analog and P25
channel, this selects the transmit type. Either Analog
or Digital (P25) can be selected. This then determines
if aTx Code or Tx NAC is programmed above.

SECTION 12 KEYPAD PROGRAMMING (51xx PORTABLE)

12.1 INTRODUCTION

NOTE: Refer to Section 11.1 for information regarding
the restricted availability of keypad programming.

Keypad programming is available if a conven-
tional mode option switch or menu parameter is
programmed for the “Keypad Programming” func-
tion. It isthen selected by simply pressing that switch
or selecting that menu parameter. The keypad
programming mode isindicated by “CHNG ZONE”

and L_llrl in the display.

Keypad programming allows conventional
channel parameters such as the transmit and receive
frequency and Call Guard squelch code to be changed.
In addition, several conventional mode timers can be
changed. It cannot be used to reprogram disabled
channels or any P25 Trunked and SMARTNET/Smart-
Zone information.

12.2 MENU DESCRIPTION

A menu system is used to select parametersto be
changed in the keypad programming mode. A
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Figure 12-1 51xx Keypad Programming Menu
Flowchart
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flowchart showing the keypad programming mode
menu structure is located in Figure 12-1. When the
keypad programming mode is selected by the Keypad
Programming option button or menu parameter, the
first menu parameter “CHNG ZONE” is displayed as
just described. Press the Up/Down switch to scroll
through the available parameters which are listed
below.

CHNG ZONE (12.3)
CHNG CHAN (12.4)
SYSPARMS (12.5)
CHAN PARMS (12.6)

Press the F2 (Select) key to select a highlighted
parameter, and press the F1 key from one of the main
menus to exit keypad programming. Pressing it in the
other menus returns to the previous menu. Additional
information on this parametersislocated in the
following sections.

12.3 ZONE CHANGE PARAMETER
General

The“CHNG ZONE” menu parameter selects the
zone containing the conventional channel to be repro-
grammed. It does not change the zone selected for
normal operation.

Press the F2 switch to select the “ZONE CHG”
parameter and then scroll through the programmed
zones by pressing the Up/Down switch. When the
desired zone is displayed, select it by pressing the F2
switch.

12.4 CHANNEL CHANGE PARAMETER

The“CHNG CHAN” menu parameter selects the
conventional channel to be reprogrammed. Disabled or
P25Trunked/SMARTNET/SmartZone channels cannot
be selected. This does not change the channel selected
for normal operation.

Press the Select switch to select the “*CHNG
CHAN” parameter and then scroll through the
programmed channels by pressing the Up/Down
switch. When the desired channel isdisplayed, select it
by pressing F2 switch.
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12.5 SYSTEM PARAMETERS

NOTE: If “ PASSWORD” is briefly displayed when
attempting to select one of the following parameters,
the zone password must be entered before changes can
be made. Refer to Section 10.4 for more information.

The"“SYSPARMS’ menu parameter selects the
conventional mode timers to be reprogrammed (see
following). Press the F2 switch to select the“SY S
PARMS’ parameter and then press the Up/Down
switch to display the desired parameter. Then press the
F2 switch again to select it.

SCAN TIMER - Selects the Scan Hold timer.
Press the Up/Down switch to decrement/increment
the timer in 0.5-second steps or set it to 0 seconds
to disableit. When the desired value is displayed,
storeit by pressing the F2 switch.

TX TIMER - Selects the transmit time-out timer.
Press the Up/Down switch to decrement/increment
the timer in 15-second steps or disable it by
selecting 0 seconds. When the desired valueis
displayed, store it by pressing the F2 switch.

PEN TIMER - Selects the penalty timer. Press the
Up/Down switch to decrement/increment the timer
in 15-second steps. When the desired valueis
displayed, store it by pressing the F2 switch.

CONV TIMER - Selects the conversation timer.
Press the Up/Down switch to decrement/increment
the timer in 30-second steps or disable it by
selecting 0 seconds. When the desired valueis
displayed, store it by pressing the F2 switch.

12.6 CHANNEL PARAMETERS

NOTE: If “ PASSMORD” is briefly displayed when
attempting to select one of the following parameters,
the zone password must be entered before changes can
be made. Refer to Section 10.4 for more information.

The“CHAN PARMS’ menu parameter selects
the following conventional channel parameters that
can be reprogrammed. Press F2 switch to select the
“CHAN PARMS’ parameter and then pressthe
Up/Down switch to display the desired parameter.
Then press the F2 switch to select it. The squelch
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control parameters are unique to the type of conven-
tional channel selected (analog or Project 25).

NOTE: If a mixed mode channel is selected, both the
Rx Code (analog) and Rx NAC (P25) which follow can
be programmed. In addition, if the Tx Type which
follows is Analog, a Tx Code is programmed, and if it
isDigital (P25), a Tx NAC is programmed.

RX FREQ - Programs the receive channel frequency.
The digit being changed flashes, and press the Up/
Down switch to select the desired number for that
digit. Then press the F2 switch to move to the next
digit. If an invalid frequency is entered, a beep sounds,
“INVALID" isbriefly displayed, and the number must
be re-entered.

TX FREQ - Programs the transmit frequency the
same as RX FREQ above.

CTCSS/DCS Squelch Control (Analog Channel)

RX CODE - Programs the receive Call Guard
(CTCSS/DCS) code. The currently selected code
and isinitialy displayed. Press the Up/Down
switch to select the desired code type (CTCSS
analog or DCSdigital Call Guard). Then press F2
to select it and enter the code number similar to
programming a channel frequency as just
described.

TX CODE - Selects the transmit codes the same as
RX CODE above.

NAC Squelch Control (Project 25 Channel)

RX NAC - Programs the Network Access Code
(NAC) which can be any number from 0-4095. The
procedure is similar to programming aRX FREQ
just described. If an invalid code is entered, a beep
sounds, “INVALID” isbriefly displayed, and the
code must be re-entered.
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TX NAC - Sdlects the transmit NAC the same as
RX NAC above.

TX POWER - Selects the desired power output level.
Press the Up/Down switch to scroll through the
following choices. When the desired setting is
displayed, store it by pressing the F2 switch.

® POWER HI - High transmit power

® POWER LO - Low transmit power

® POWER SW - Switchable power selectable by
the High/Low power switch. Thischoiceis not
availableif that switch is not programmed.

TX TIMER - Enables or disables the time-out timer
on the current channel. Press the Up/Down switch to
select the on and off mode, and when the desired
setting is displayed, storeit by pressing the F2 switch.

CHAN SPC (Analog Only) - Selects either wide or
narrow band channel spacing on analog channels only.
Press the Up/Down switch to select “WIDE” or
“NARROW?”, and when the desired setting is
displayed, store it by pressing the F2 switch.

SQ ADJ (Analog Only) - Changes the preset squelch
setting on that channel. The default setting is“0” and
values of —7 to +7 can be selected. Increasing this
setting toward +7 causes the sgquelch to open sooner so
that weaker signals can be received, and decreasing it
toward —7 causes the opposite to occur.

TG ID (P25 Only) - Selectsthe talk group for the
selected channel. Pressthe Up/Down switch to display
the alias of each preprogrammed talk group and then
press F2 to store the desired talk group.

Transmit Type (P25 Mixed Mode Only) - If the
selected channel is a mixed mode, analog and P25
channel, this selects the transmit type. Either Analog
or Digital (P25) can be selected. This then determines
if aTx Codeor Tx NAC is programmed above.
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SECTION 13 SYSTEM KEY

13.1 GENERAL

To program certain SMARTNET/SmartZone and
Project 25 Trunking parameters, the proper System
Key must be detected by PCConfigure. The System
Key is provided by the EFJohnson Company to autho-
rized users. It is not the same as the encryption (hard-
ware) key, and it is not required to program conven-
tional analog and conventional Project 25 parameters.

The parameters which are available only with the
System Key are described in the following informa-
tion. Other parameters associated with trunking, such
as Zones and Channels, continue to be editable. If a
System Key has no trunking parameters enabled, a
default trunking system of “One” is assigned and
disabled parameters are unavailable for assignment to
this system even though the radio is trunking capable.

13.2 SYSTEM KEY LOCATION

The system key should be copied by the user to
the “Keys’ folder of the PCConfigure directory. This
folder isautomatically created when PCConfigureis
installed. The default directory in which PCConfigure
isinstalled is asfollows. Some other location may also
have been selected.

Program Files\EF Johnson\PCConfigurel x.x.

The system key can also be loaded from other
folders using the Radio > Load System Keys function.
A dialog box isthen displayed which alowsthe folder
to be selected. When the program is restarted, either
the“Keys’ folder or the last selected folder is selected,
depending on the Tools > Preferences programming
(see Section 3.4).

Smarthlet— 4% - The yellow “Key” icon on the
system screen (see Figure 8-1) indicates that a system
key ispresent in thisfolder. If a system key is not
present, thisyellow key icon hasared “X” over it as
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shown above and none of the following parameters
can be programmed.

NOTE: Ifthered “ X" is till displayed after a key is
copied to the* keys’ folder, it may be necessary to
restart the PCConfigure program for it to recognize
the key. In addition, be sure to select the new system
ID contained in the key in the IDs > System drop down
list on the Per System screen.

13.3 DISABLED SMARTNET/SMARTZONE
PARAMETERS

Thefollowing SMARTNET/SmartZone
parameters cannot be Added or Deleted without the

proper System Key:

® System ID - Only the system IDs from available
keys can be selected.

Individual ID

Control channels

Talk groups

Announcement groups

Emergency groups

Connect tone

Splinter channel option

13.4 DISABLED PROJECT 25 TRUNKING
PARAMETERS

The following Project 25 Trunked parameters
cannot be Added or Del eted without the proper System
Key (conventional analog and Project 25 parameters
can still be edited).

WACN ID

Home system ID
SiteID

RFSSID

Individual ID

Control channels

Talk groups
Announcement groups
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SECTION 14 CLONING PROCEDURE (51xx ONLY)

14.1 INTRODUCTION
14.1.1 GENERAL

The Clone feature enables one radio to program
another with identical information. The PCConfigure
programming software is not required. Thisfeatureis
available with 51xx portables only. Other requirements
areasfollows:

® The Clone menu parameter must be enabled in the
master (sending) radio. This parameter is not
required with the slave (receiving) radio.

® The master and slave radios must be identical
models (same frequency range and options).

® Flash code Version 1.5.0/2.0.0/3.0.0 or higher is
required with both radios (see Section 16.1).
PCConfigure Version 1.17 or higher isrequired to
program the Clone menu parameter.

Only zones with conventional analog and P25
channels can be transferred using this function. Any
SMARTNET/SmartZone and P25 trunked informa-
tion is not transferred. In addition, the P25 Unit ID,
encryption keys, and the RSl ID and other OTAR
information are not transferred. Cloned zones are indi-
cated in the slave radio by an asterisk in the first char-
acter position of the zone alias (the first character is
replaced by this asterisk).

14.1.2 WIRELESS CLONING

A new wireless cloning feature is available that
allows one radio to program another using an RF link
instead of having to be physically connected by a
cloning cable. Only 5100 radios with the following
firmware or later have this feature. Refer to Section
16.1 for more information on 5100 versions.

Version 1 Radio- 1.12.1 or later
Version 2 Radios- 2.2.1 or later
Version 3 Radios- 3.2.1 or later

The wireless cloning feature utilizes the P25 data
functionality of the radio. Therefore, in both radios, a
conventional P25 channel must be programmed and
Data Registration must be enabled on the Per System
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screen. The slave radio must also be programmed with
a P25 Unit ID. Radios with wireless cloning capability
have a new selection in the cloning menu to select
either Clone N (Normal) or Clone W (Wireless). If
Wireless is selected, and additional menu is displayed
for entering the P25 Unit ID of the destination radio
(slave). The Zone/Complete mode is then selected.

14.2 CLONING PROCEDURE

1. With normal (non-wireless) cloning, connect the
master (sending) radio to the slave (receiving) radio
using Cloning Cable, Part No. 023-5100-930.

2. On the master radio, select the Clone menu param-
eter and pressthe F2 key. If applicable, select either
“Clone W” (Wireless) or “Clone N” (Normal). If
normal cloning was selected or if thisis not select-
able, proceed to step 4.

3. Withwirelesscloning, ascreenisthen displayed for
entering the P25 Unit ID of the destination (slave)
radio. Enter this ID using the keypad (or the Up/
Down keys) and F2.

4. Theclone mode “Zone’ or “Complete” isthen
selected. Select the desired mode. Operation is as
follows:

Zone - This mode allows channel information for
only the selected zoneto betransferred. Information
programmed on the Global, Radio Wide, and By
System screensis not changed. A list of the current
conventional zonesis displayed. Select the desired
zone by highlighting it and pressing the F2 key. A
selected zone isindicated by an asterisk (*). Scroll
to “OK” and press F2 to begin the datatransfer. The
selected zone in the dave radio is overwritten.
Previously, multiple zones could be selected and
they were appended to those in the slave radio.

Complete - This mode transfers all conventional
programming information. This includes informa-
tion on the Global, Radio Wide, and By System
screens. Simply highlight “ Complete” and pressthe
F2 key to begin the data transfer. This mode over-
writes al thisinformation currently in the slave
radio. None of the previous information is retained
except for the IDs as described in Section 14.1.1.
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SECTION 15 ANTI-CLONING FEATURES

NOTE: Theinformationwhichfollowsrefersto copying
of parameters from one radio to another using the
PCConfigure software. It is not referring to cloning
using two radios described in the preceding section.

15.1 INTRODUCTION

The latest releases of 5100 and 5300 radio and
PCConfigure software include safeguards to prevent
unauthorized cloning of radios programmed for
trunked operation using the PCConfigure software.
The trunked operating modes are SMARTNET, Smart-
Zone, and P25 Trunking.

Many trunking parameters are restricted and can
be programmed or edited only with the correct System
Key as described in Section 13. These new safeguards
prevent another radio from being cloned with restricted
trunking information without the correct System Key.

15.2 SOFTWARE VERSIONS

The following programmer and radio software
releases support these new cloning safeguards:

PCConfigure - Version 1.20 or later

5100 Portable - Flash Code Ver 1.9.0/2.0/3.0 or higher

5300 M obile - Flash Code Version 2.0/3.0 or higher;
ARM Code Version 1.22.0 or higher (early models).

The new version of PCConfigure (1.20 or later) is
required to program all 51xx/53xx radios with the
above software. The new PCConfigure software can
a so be used to program radios with earlier software.
However, 51xx/53xx radios with the earlier software
do not support the new cloning safeguards. The 7780
and 9883 models always require the correct System
Keysto write information to the radio.

15.3 DESCRIPTION OF CHANGES

All programming files uploaded from aradio
with the new version of PCConfigure will now include
information on the specific radio from which it was
read (uploaded). The ESN (Electronic Serial Number)
and other information is stored in an encrypted formin
the datafile. Thisinformation isalso included with file
when it is saved to disk, if applicable. Other operation
with these changesis as follows:
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Saving a New File

NOTE: Itisno longer possible to save any type of new
programming file to disk without a radio connected.

All files saved to disk must now be associated
with a specific radio. Therefore, when saving a new
filefor thefirst time, the radio must connected to the
computer so the ESN and other information can be
read and stored with the file. However, a previously
saved disk file can be opened and edited and then re-
saved to disk without aradio connected. In addition,
files containing trunking parameters can be saved
without the proper system key.

Writing a File To Radios Containing New Software

Correct System Key Available - A filewith
trunking parameters can be edited as desired and
written to any radio.

Correct System Key Not Available - Restricted
trunking parameters cannot be changed (see
Section 13). However, non-restricted trunking and
conventional parameters can still be changed. The
datafile can be written to the same radio only. If it
iswritten to a different radio, the data is scrambled
and “Params Fail” is displayed by the radio when
programming is finished.

File Containing Only Conventional Parameters
(P25 or Analog) - There are no editing restrictions
and data files can be written to any radio.

Radios With Earlier Software

When afile write operation isinitiated, the
PCConfigure software checks the software version of
theradio. If itisan earlier version thanislisted in
Section 15.2, thefile is written regardless of the
System Key or the source radio of the datafile.

Using Earlier Versions of PCConfigure

As described in Section 15.2, Version 1.20 or
later PCConfigure must be used to program radios
with the new software. This applies to both conven-
tional and trunked operation. Improper operation
resultsif earlier versions are used.
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SECTION 16 51xx/53xx FIRMWARE VERSIONS

Table 16-1 5100 Encryption Hardware Configurations

Radio Version [1]

Application
(Firmware)
Code Base

Analog Channel
Encryption

Digital Channel
Encryption

DES

DES-XL

DES-OFB

AES

Version 1 (No Module/Software Encryption)
Current standard version which usesthe -110 Logic
board and -410 Ul Board. Not FIPS approved.

1.xx

Yes No Yes Yes

Version 2 (uses EFJ SEM module)
New version which has the new EFJohnson SEM
(Subscriber Encryption Modul€) on the logic board.
This version uses the -150 Logic and -450 Ul
boards. All radios include the SEM, and the desired
encryption options (if any) are enabled by factory
programming. FIPS approved.

Initially same
as above, then
2.XX

Yes No Yes Yes

Version 3 (uses Motorola UCM module)
New version which has the Motorola UCM (Uni-
versal Crypto Module) on the logic board. This ver-
sion usesthe -160 Logic and -460 Ul boards, and is
ordered when DES-XL encryption isrequired. FIPS
approved.

3.XX

Yes Yes Yes Yes

[1] The version number is also indicated by the 13th digit of the radio part number (242-51xx-Xxx-xXV).

16.1 51XX PORTABLE FIRMWARE VERSIONS

General

Beginning in October 2003, two new versions of
the 51xx portable began shipping (Versions 2 and 3in
Table 16-1). These versions have new Logic and
Universal Interface boards, and each uses different
firmware (application code) that is not compatible
with earlier or other models. The three radio versions
now available are shown in Table 16-1.

Firmware Version Used

The firmware code base used by each of these
three versionsis shown in Table 16-1. Thisis oper-
ating code of the radio that may occasionally be
updated using the “ Transfer > Write Code To Radio”
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function (see Section 3.3). For example, if firmware
with new operating features or fixesisloaded into a
Version 2 radio, it would have a 2.xx version number.

Initially, Version 2 radios used Version 1.11.9
code which was the same as that used with the
Version 1 radios. However, later code releases for
Version 2 radios are not compatible with Version 1
radios, so Version 2.xx code will be used.

NOTE: The code version (and therefore radio version)
is briefly displayed when the radio powers up.

Programming Software Required

PCConfigure™ programming software, Version
1.21.0 or later isrequired to program radios with the
Version 2 and 3 boards. This software can a so be used
to program radios with the earlier boards.
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16.2 53XX MOBILE FIRMWARE VERSIONS
General

Beginning in November 2003, arevised logic
board began shipping in 5300 models. This board
utilizes a new control logic design similar to that used
in the 5100 portable. This board is availablein the
following configurations. All versions are FIPS
approved.

SEM Version - This version has the EFJohnson
SEM (Security Encryption Modul€) soldered to the
board. It is used whenever DES, DES-OFB, or
AES encryption is required. It does not provide
DES-XL encryption.

UCM Version - Thisincludes a plug-in Motorola
UCM encryption module. It is used whenever
DES-XL Motorola proprietary encryptionis
required. It also provides DES, DES-OFB, or AES
encryption.

No Encryption Version - If encryption is not
required, either the earlier logic board (see
following) or the UCM version without the UCM
moduleis used.

Early Unrevised Logic Board

Thisversionis Part No. 035-1800-4xx and is
being replaced by the above versions. Thisboard hasa
jack for plugging in Motorola encryption modul es that
provide DES/'DES-XL/DES-OFB and AES encryp-
tion. It does not use the SEM module.

Programming Software Required

PCConfigure programming software, Version
1.21.2.5 or later isrequired to program radios with the
revised board. This software can aso be used to
program radios with the unrevised board. The “5300”
Radio Seriesis selected for both boards. The software
automatically detects which board is used when
parameters are written to the radio.
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Firmware Required

Radios with the revised and unrevised logic
boards use different firmware (operating/Flash soft-
ware) as follows. When downloading code using the
PCConfigure software (such as when purchasing new
operating features), the radio must be powered up
when the password is entered so that the logic board
version can be detected.

Modelswith Revised Board - A single codefileis
used similar to the 5100 portable. SEM code has a
2.xx version number, and UCM code has a 3.xx
version number.

M odelswith Unrevised Board - Two code files
are used, one of which programs DSP parameters
and the other which programs ARM processor
parameters. These code sets have a 1.xx version
number.

Identifying Radios With Revised Logic Board

Refer to the radio Serial Number on the label on
the bottom cover to determineif it isaversion with the
revised logic board. Radios with the new revised logic
board have a Revision Letter (letter following 53xx0)
of “G” or higher. Radios with an A-F Revision Letter
have the early unrevised -4xx logic board just
described.

The board version can also be determined by
noting the software version number that is briefly
displayed when power isturned on. The version
numbers are as follows:

Software Version Displayed Board Version

Ver 1.xx Early unrevised
Ver 2.xx SEM version
Ver 3.xx UCM version
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SECTION 17 CALL GUARD (CTCSS/DCS) AND 800 MHz CHANNEL TABLES

Table 17-1 Call Guard (CTCSS/DCS) Codes

Recommended Tone Call Guard Codes

Code Freq Code Freq Code Freg Code Freq Code Freq

09 91.5 18 123.0 27 167.9 36* 233.6
01 67.0 10 94.8 19 127.3 28 173.8 37* 241.8
02 719 11** 97.4 20 131.8 29 179.9 38* 250.3
03 74.4 12 100.0 21 136.5 30 186.2 39** 69.3
04 77.0 13 103.5 22 141.3 31 192.8 40** 206.5
05 79.7 14 107.2 23 146.2 32 2035 41** 229.1
06 82.5 15 110.9 24 1514 33 210.7 42 * 254.1
o7 854 16 114.8 25 156.7 34* 218.1
08 88.5 17 118.8 26 162.2 35* 225.7
* These tones normally are not used because of their close proximity to the voice frequencies
** Thistone is normally not used because it may cause interference with adjacent tones.

Recommended Digital Call Guard Codes

023 065 131 172 261 346 431 532 654 743
025 071 132 174 263 351 432 546 662 754
026 072 134 205 265 364 445 565 664
031 073 143 223 271 365 464 606 703
032 074 152 226 306 371 465 612 712
043 114 155 243 311 411 466 624 723
047 115 156 244 315 412 503 627 731
051 116 162 245 331 413 506 631 732
054 125 165 251 343 423 516 632 734

SECTION 18 P25 PACKET DATA MODE

18.1 GENERAL

P25 packet data transmissions* are or soon will
be available with 5100 portable and 5300 mobile
radios. A P25 Packet Data option button or menu
parameter (5100 only) is used to toggle the data mode.

The P25 Packet Data mode allows a subscriber
unit to act as a packet data modem for a remote appli-
cation connected to the subscriber unit viaan RS-232
or SLIP (Serial Line Internet Protocol) connection.
The SLIP connection requires an Ethernet port which
is currently not available with either radio.

18.2 HARDWARE REQUIRED
18.2.1 5100 PORTABLE

The standard PCConfigure programming cable
provides the RS-232 port (female DB9 connector) for
connecting the external data equipment.

18.2.2 5300 MOBILE

A special data pigtail cable (Part No. 597-2002-
282) isinstalled in the radio to provide external access
to the RS-232 lines. This cable will a'so have afemale
DB9 connector for connecting the external equipment.

* This feature available only in 51xx models with code 1.12.1/2.2.1/
3.2.1 or later and 53xx models with code 1.24.1/2.2.1/3.2.1 or later.
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800 MHz Channdls
FCC Chan.| Mobile Rx| Mobile Tx FCC Chan.] Mobile Rx| Mobile Tx FCC Chan.] Mobile Rx| Mobile Tx
|_ No. Freg. Freq |_ No. Freq. Freq F No. Freq Freq

1 851.0125 806.0125 51 852.2625 807.2625 101 853.5125 808.5125
2 851.0375 806.0375 52 852.2875 807.2875 102 853.5375 808.5375
3 851.0625 806.0625 53 852.3125 807.3125 103 853.5625 808.5625
4 851.0875 806.0875 54 852.3375 807.3375 104 853.5875 808.5875
5 851.1125 806.1125 55 852.3625 807.3625 105 853.6125 808.6125
6 851.1375 806.1375 56 852.3875 807.3875 106 853.6375 808.6375
7 851.1625 806.1625 57 852.4125 807.4125 107 853.6625 808.6625
8 851.1875 806.1875 58 852.4375 807.4375 108 853.6875 808.6875
9 851.2125 806.2125 59 852.4625 807.4625 109 853.7125 808.7125
10 851.2375 806.2375 60 852.4875 807.4875 110 853.7375 808.7375
11 851.2625 806.2625 61 8525125 807.5125 111 853.7625 808.7625
12 851.2875 806.2875 62 852.5375 807.5375 112 853.7875 808.7875
13 851.3125 806.3125 63 852.5625 807.5625 113 853.8125 808.8125
14 851.3375 806.3375 64 8525875 807.5875 114 853.8375 808.8375
15 851.3625 806.3625 65 852.6125 807.6125 115 853.8625 808.8625
16 851.3875 806.3875 66 852.6375 807.6375 116 853.8875 808.8875
17 851.4125 806.4125 67 852.6625 807.6625 117 853.9125 808.9125
18 851.4375 806.4375 68 852.6875 807.6875 118 853.9375 808.9375
19 851.4625 806.4625 69 852.7125 807.7125 119 853.9625 808.9625
20 851.4875 806.4875 70 852.7375 807.7375 120 853.9875 808.9875
21 851.5125 806.5125 71 852.7625 807.7625 121 854.0125 809.0125
22 851.5375 806.5375 72 852.7875 807.7875 122 854.0375 809.0375
23 851.5625 806.5625 73 852.8125 807.8125 123 854.0625 809.0625
24 851.5875 806.5875 74 852.8375 807.8375 124 854.0875 809.0875
25 851.6125 806.6125 75 852.8625 807.8625 125 854.1125 809.1125
26 851.6375 806.6375 76 852.8875 807.8875 126 854.1375 809.1375
27 851.6625 806.6625 77 852.9125 807.9125 127 854.1625 809.1625
28 851.6875 806.6875 78 852.9375 807.9375 128 854.1875 809.1875
29 851.7125 806.7125 79 852.9625 807.9625 129 854.2125 809.2125
30 851.7375 806.7375 80 852.9875 807.9875 130 854.2375 809.2375
31 851.7625 806.7625 81 853.0125 808.0125 131 854.2625 809.2625
32 851.7875 806.7875 82 853.0375 808.0375 132 854.2875 809.2875
33 851.8125 806.8125 83 853.0625 808.0625 133 854.3125 809.3125
34 851.8375 806.8375 84 853.0875 808.0875 134 854.3375 809.3375
35 851.8625 806.8625 85 853.1125 808.1125 135 854.3625 809.3625
36 851.8875 806.8875 86 853.1375 808.1375 136 854.3875 809.3875
37 851.9125 806.9125 87 853.1625 808.1625 137 854.4125 809.4125
38 851.9375 806.9375 88 853.1875 808.1875 138 854.4375 809.4375
39 851.9625 806.9625 89 853.2125 808.2125 139 854.4625 809.4625
40 851.9875 806.9875 90 853.2375 808.2375 140 854.4875 809.4875
41 852.0125 807.0125 91 853.2625 808.2625 141 854.5125 809.5125
42 852.0375 807.0375 92 853.2875 808.2875 142 854.5375 809.5375
43 852.0625 807.0625 93 853.3125 808.3125 143 854.5625 809.5625
44 852.0875 807.0875 Y} 853.3375 808.3375 144 8545875 809.5875
45 8521125 807.1125 95 853.3625 808.3625 145 854.6125 809.6125
46 852.1375 807.1375 96 853.3875 808.3875 146 854.6375 809.6375
47 852.1625 807.1625 97 853.4125 808.4125 147 854.6625 809.6625
48 852.1875 807.1875 98 853.4375 808.4375 148 854.6875 809.6875
49 852.2125 807.2125 99 853.4625 808.4625 149 854.7125 809.7125
50 852.2375 807.2375 100 853.4875 808.4875 150 854.7375 809.7375
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800 MHz CHANNEL TABLE

800 MHz Channdls
FCC Chan.| Mobile Rx| Mobile Tx FCC Chan.] Mobile Rx| Mobile Tx FCC Chan.] Mobile Rx| Mobile Tx
|_ No. Freg. Freq |_ No. Freq. Freq F No. Freq Freq
151 854.7625 809.7625 201 856.0125 811.0125 251 857.2625 812.2625
152 854.7875  809.7875 202 856.0375 811.0375 252 857.2875 812.2875
153 854.8125 809.8125 203 856.0625 811.0625 253 857.3125 812.3125
154 854.8375 809.8375 204 856.0875 811.0875 254 857.3375 812.3375
155 854.8625 809.8625 205 856.1125 811.1125 255 857.3625 812.3625
156 854.8875 809.8875 206 856.1375 811.1375 256 857.3875 812.3875
157 854.9125 809.9125 207 856.1625 811.1625 257 857.4125 812.4125
158 854.9375 809.9375 208 856.1875 811.1875 258 857.4375 812.4375
159 854.9625 809.9625 209 856.2125 811.2125 259 857.4625 812.4625
160 854.9875 809.9875 210 856.2375 811.2375 260 857.4875 812.4875
161 855.0125 810.0125 211 856.2625 811.2625 261 857.5125 8125125
162 855.0375 810.0375 212 856.2875 811.2875 262 857.5375 812.5375
163 855.0625 810.0625 213 856.3125 811.3125 263 857.5625 812.5625
164 855.0875 810.0875 214 856.3375 811.3375 264 857.5875 812.5875
165 855.1125 810.1125 215 856.3625 811.3625 265 857.6125 812.6125
166 855.1375 810.1375 216 856.3875 811.3875 266 857.6375 812.6375
167 855.1625 810.1625 217 856.4125 811.4125 267 857.6625 812.6625
168 855.1875 810.1875 218 856.4375 811.4375 268 857.6875 812.6875
169 855.2125 810.2125 219 856.4625 811.4625 269 857.7125 812.7125
170 855.2375 810.2375 220 856.4875 811.4875 270 857.7375 812.7375
171 855.2625 810.2625 221 856.5125 811.5125 271 857.7625 812.7625
172 855.2875 810.2875 222 856.5375 811.5375 272 857.7875 812.7875
173 855.3125 810.3125 223 856.5625 811.5625 273 857.8125 812.8125
174 855.3375 810.3375 224 856.5875 811.5875 274 857.8375 812.8375
175 855.3625 810.3625 225 856.6125 811.6125 275 857.8625 812.8625
176 855.3875 810.3875 226 856.6375 811.6375 276 857.8875 812.8875
177 855.4125 810.4125 227 856.6625 811.6625 277 857.9125 812.9125
178 855.4375 810.4375 228 856.6875 811.6875 278 857.9375 812.9375
179 855.4625 810.4625 229 856.7125 811.7125 279 857.9625 812.9625
180 855.4875 810.4875 230 856.7375 811.7375 280 857.9875 812.9875
181 855.5125 810.5125 231 856.7625 811.7625 281 858.0125 813.0125
182 855.5375 810.5375 232 856.7875 811.7875 282 858.0375 813.0375
183 855.5625 810.5625 233 856.8125 811.8125 283 858.0625 813.0625
184 855.5875 810.5875 234 856.8375 811.8375 284 858.0875 813.0875
185 855.6125 810.6125 235 856.8625 811.8625 285 858.1125 813.1125
186 855.6375 810.6375 236 856.8875 811.8875 286 858.1375 813.1375
187 855.6625 810.6625 237 856.9125 811.9125 287 858.1625 813.1625
188 855.6875 810.6875 238 856.9375 811.9375 288 858.1875 813.1875
189 855.7125 810.7125 239 856.9625 811.9625 289 858.2125 813.2125
190 855.7375 810.7375 240 856.9875 811.9875 290 858.2375 813.2375
191 855.7625 810.7625 241 857.0125 812.0125 291 858.2625 813.2625
192 855.7875 810.7875 242 857.0375 812.0375 292 858.2875 813.2875
193 855.8125 810.8125 243 857.0625 812.0625 293 858.3125 813.3125
194 855.8375 810.8375 244 857.0875 812.0875 294 858.3375 813.3375
195 855.8625 810.8625 245 857.1125 812.1125 295 858.3625 813.3625
196 855.8875 810.8875 246 857.1375 812.1375 296 858.3875 813.3875
197 855.9125 810.9125 247 857.1625 812.1625 297 858.4125 813.4125
198 855.9375 810.9375 248 857.1875 812.1875 298 858.4375 813.4375
199 855.9625 810.9625 249 857.2125 812.2125 299 858.4625 813.4625
200 855.9875 810.9875 250 857.2375 812.2375 300 858.4875 813.4875
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800 MHz Channdls
FCC Chan.| Mobile Rx| Mobile Tx FCC Chan.] Mobile Rx| Mobile Tx FCC Chan.] Mobile Rx| Mobile Tx
|_ No. Freg. Freq |_ No. Freq. Freq F No. Freq Freq
301 858.5125 813.5125 351 859.7625 814.7625 401 861.0125 816.0125
302 858.5375 813.5375 352 859.7875 814.7875 402 861.0375 816.0375
303 858.5625 813.5625 353 859.8125 814.8125 403 861.0625 816.0625
304 858.5875 813.5875 354 859.8375 814.8375 404 861.0875 816.0875
305 858.6125 813.6125 355 859.8625 814.8625 405 861.1125 816.1125
306 858.6375 813.6375 356 859.8875 814.8875 406 861.1375 816.1375
307 858.6625 813.6625 357 859.9125 814.9125 407 861.1625 816.1625
308 858.6875 813.6875 358 859.9375 814.9375 408 861.1875 816.1875
309 858.7125 813.7125 359 859.9625 814.9625 409 861.2125 816.2125
310 858.7375 813.7375 360 859.9875 814.9875 410 861.2375 816.2375
311 858.7625 813.7625 361 860.0125 815.0125 411 861.2625 816.2625
312 858.7875 813.7875 362 860.0375 815.0375 412 861.2875 816.2875
313 858.8125 813.8125 363 860.0625 815.0625 413 861.3125 816.3125
314 858.8375 813.8375 364 860.0875 815.0875 414 861.3375 816.3375
315 858.8625 813.8625 365 860.1125 815.1125 415 861.3625 816.3625
316 858.8875 813.8875 366 860.1375 815.1375 416 861.3875 816.3875
317 858.9125 813.9125 367 860.1625 815.1625 417 861.4125 816.4125
318 858.9375 813.9375 368 860.1875 815.1875 418 861.4375 816.4375
319 858.9625 813.9625 369 860.2125 815.2125 419 861.4625 816.4625
320 858.9875 813.9875 370 860.2375 815.2375 420 861.4875 816.4875
321 859.0125 814.0125 371 860.2625 815.2625 421 861.5125 816.5125
322 859.0375 814.0375 372 860.2875 815.2875 422 861.5375 816.5375
323 859.0625 814.0625 373 860.3125 815.3125 423 861.5625 816.5625
324 859.0875 814.0875 374 860.3375 815.3375 424 861.5875 816.5875
325 859.1125 814.1125 375 860.3625 815.3625 425 861.6125 816.6125
326 859.1375 814.1375 376 860.3875 815.3875 426 861.6375 816.6375
327 859.1625 814.1625 377 860.4125 815.4125 427 861.6625 816.6625
328 859.1875 814.1875 378 860.4375 815.4375 428 861.6875 816.6875
329 8590.2125 814.2125 379 860.4625 815.4625 429 861.7125 816.7125
330 859.2375 814.2375 380 860.4875 815.4875 430 861.7375 816.7375
331 859.2625 814.2625 381 860.5125 815.5125 431 861.7625 816.7625
332 859.2875 814.2875 382 860.5375 815.5375 432 861.7875 816.7875
333 859.3125 814.3125 383 860.5625 815.5625 433 861.8125 816.8125
334 859.3375 814.3375 384 860.5875 815.5875 434 861.8375 816.8375
335 859.3625 814.3625 385 860.6125 815.6125 435 861.8625 816.8625
336 859.3875 814.3875 386 860.6375 815.6375 436 861.8875 816.8875
337 859.4125 814.4125 387 860.6625 815.6625 437 861.9125 816.9125
338 859.4375 814.4375 388 860.6875 815.6875 438 861.9375 816.9375
339 859.4625 814.4625 389 860.7125 815.7125 439 861.9625 816.9625
340 859.4875 814.4875 390 860.7375 815.7375 440 861.9875 816.9875
341 859.5125 814.5125 391 860.7625 815.7625 441 862.0125 817.0125
342 859.5375 814.5375 392 860.7875 815.7875 442 862.0375 817.0375
343 859.5625 814.5625 393 860.8125 815.8125 443 862.0625 817.0625
344 859.5875 814.5875 394 860.8375 815.8375 444 862.0875 817.0875
345 859.6125 814.6125 395 860.8625 815.8625 445 862.1125 817.1125
346 859.6375 814.6375 396 860.8875 815.8875 446 862.1375 817.1375
347 859.6625 814.6625 397 860.9125 815.9125 447 862.1625 817.1625
348 859.6875 814.6875 398 860.9375 815.9375 448 862.1875 817.1875
349 859.7125 814.7125 399 860.9625 815.9625 449 862.2125 817.2125
350 859.7375 814.7375 400 860.9875 815.9875 450 862.2375 817.2375
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800 MHz Channdls
FCC Chan.| Mobile Rx| Mobile Tx FCC Chan.] Mobile Rx| Mobile Tx FCC Chan.] Mobile Rx| Mobile Tx
|_ No. Freg. Freq |_ No. Freq. Freq F No. Freq Freq
451 862.2625 817.2625 501 863.5125 818.5125 551 864.7625 819.7625
452 862.2875 817.2875 502 863.5375 818.5375 552 864.7875 819.7875
453 862.3125 817.3125 503 863.5625 818.5625 553 864.8125 819.8125
454 862.3375 817.3375 504 863.5875 818.5875 554 864.8375 819.8375
455 862.3625 817.3625 505 863.6125 818.6125 555 864.8625 819.8625
456 862.3875 817.3875 506 863.6375 818.6375 556 864.8875 819.8875
457 862.4125 817.4125 507 863.6625 818.6625 557 864.9125 819.9125
458 862.4375 817.4375 508 863.6875 818.6875 558 864.9375 819.9375
459 862.4625 817.4625 509 863.7125 818.7125 559 864.9625 819.9625
460 862.4875 817.4875 510 863.7375 818.7375 560 864.9875 819.9875
461 862.5125 817.5125 511 863.7625 818.7625 561 865.0125 820.0125
462 862.5375 817.5375 512 863.7875 818.7875 562 865.0375 820.0375
463 862.5625 817.5625 513 863.8125 818.8125 563 865.0625 820.0625
464 862.5875 817.5875 514 863.8375 818.8375 564 865.0875 820.0875
465 862.6125 817.6125 515 863.8625 818.8625 565 865.1125 820.1125
466 862.6375 817.6375 516 863.8875 818.8875 566 865.1375 820.1375
467 862.6625 817.6625 517 863.9125 818.9125 567 865.1625 820.1625
468 862.6875 817.6875 518 863.9375 818.9375 568 865.1875 820.1875
469 862.7125 817.7125 519 863.9625 818.9625 569 865.2125 820.2125
470 862.7375 817.7375 520 863.9875 818.9875 570 865.2375 820.2375
471 862.7625 817.7625 521 864.0125 819.0125 571 865.2625 820.2625
472 862.7875 817.7875 522 864.0375 819.0375 572 865.2875 820.2875
473 862.8125 817.8125 523 864.0625 819.0625 573 865.3125 820.3125
474 862.8375 817.8375 524 864.0875 819.0875 574 865.3375 820.3375
475 862.8625 817.8625 525 864.1125 819.1125 575 865.3625 820.3625
476 862.8875 817.8875 526 864.1375 819.1375 576 865.3875 820.3875
477 862.9125 817.9125 527 864.1625 819.1625 577 865.4125 820.4125
478 862.9375 817.9375 528 864.1875 819.1875 578 865.4375 820.4375
479 862.9625 817.9625 529 864.2125 819.2125 579 865.4625 820.4625
480 862.9875 817.9875 530 864.2375 819.2375 580 865.4875 820.4875
481 863.0125 818.0125 531 864.2625 819.2625 581 865.5125 820.5125
482 863.0375 818.0375 532 864.2875 819.2875 582 865.5375 820.5375
483 863.0625 818.0625 533 864.3125 819.3125 583 865.5625 820.5625
484 863.0875 818.0875 534 864.3375 819.3375 584 865.5875 820.5875
485 863.1125 818.1125 535 864.3625 819.3625 585 865.6125 820.6125
486 863.1375 818.1375 536 864.3875 819.3875 586 865.6375 820.6375
487 863.1625 818.1625 537 864.4125 819.4125 587 865.6625 820.6625
488 863.1875 818.1875 538 864.4375 819.4375 588 865.6875 820.6875
489 863.2125 818.2125 539 864.4625 819.4625 589 865.7125 820.7125
490 863.2375 818.2375 540 864.4875 819.4875 590 865.7375 820.7375
491 863.2625 818.2625 541 864.5125 819.5125 501 865.7625 820.7625
492 863.2875 818.2875 542 864.5375 819.5375 592 865.7875 820.7875
493 863.3125 818.3125 543 864.5625 819.5625 593 865.8125 820.8125
494 863.3375 818.3375 544 864.5875 819.5875 594 865.8375 820.8375
495 863.3625 818.3625 545 864.6125 819.6125 595 865.8625 820.8625
496 863.3875 818.3875 546 864.6375 819.6375 596 865.8875 820.8875
497 863.4125 818.4125 547 864.6625 819.6625 597 865.9125 820.9125
498 863.4375 818.4375 548 864.6875 819.6875 598 865.9375 820.9375
499 863.4625 818.4625 549 864.7125 819.7125 599 865.9625 820.9625
500 863.4875 818.4875 550 864.7375 819.7375 600 865.9875 820.9875
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FCC Chan.| Mobile Rx| Mobile Tx FCC Chan.] Mobile Rx| Mobile Tx FCC Chan.] Mobile Rx| Mobile Tx
|_ No. Freg. Freq |_ No. Freq. Freq F No. Freq Freq

- 866.0000 821.0000 645 866.6000 821.6000 691 867.2000 822.2000
601 866.0125 821.0125 646 866.6125 821.6125 692 867.2125 822.2125
- 866.0250 821.0250 647 866.6250 821.6250 693 867.2250 822.2250
602 866.0375 821.0375 648 866.6375 821.6375 694 867.2375 822.2375
603 866.0500 821.0500 649 866.6500 821.6500 695 867.2500 822.2500
604 866.0625 821.0625 650 866.6625 821.6625 696 867.2625 822.2625
605 866.0750 821.0750 651 866.6750 821.6750 697 867.2750 822.2750
606 866.0875 821.0875 652 866.6875 821.6875 698 867.2875 822.2875
607 866.1000 821.1000 653 866.7000 821.7000 699 867.3000 822.3000
608 866.1125 821.1125 654 866.7125 821.7125 700 867.3125 822.3125
609 866.1250 821.1250 655 866.7250 821.7250 701 867.3250 822.3250
610 866.1375 821.1375 656 866.7375 821.7375 702 867.3375 822.3375
611 866.1500 821.1500 657 866.7500 821.7500 703 867.3500 822.3500
612 866.1625 821.1625 658 866.7625 821.7625 704 867.3625 822.3625
613 866.1750 821.1750 659 866.7750 821.7750 705 867.3750 822.3750
614 866.1875 821.1875 660 866.7875 821.7875 706 867.3875 822.3875
615 866.2000 821.2000 661 866.8000 821.8000 707 867.4000 822.4000
616 866.2125 821.2125 662 866.8125 821.8125 708 867.4125 822.4125
617 866.2250 821.2250 663 866.8250 821.8250 709 867.4250 822.4250
618 866.2375 821.2375 664 866.8375 821.8375 710 867.4375 822.4375
619 866.2500 821.2500 665 866.8500 821.8500 711 867.4500 822.4500
620 866.2625 821.2625 666 866.8625 821.8625 712 867.4625 822.4625
621 866.2750 821.2750 667 866.8750 821.8750 713 867.4750 822.4750
622 866.2875 821.2875 668 866.8875 821.8875 714 867.4875 822.4875
623 866.3000 821.3000 669 866.9000 821.9000 - 867.5000 822.5000
624 866.3125 821.3125 670 866.9125 821.9125 715 867.5125 8225125
625 866.3250 821.3250 671 866.9250 821.9250 - 867.5250 822.5250
626 866.3375 821.3375 672 866.9375 821.9375 716 867.5375 8225375
627 866.3500 821.3500 673 866.9500 821.9500 717 867.5500 822.5500
628 866.3625 821.3625 674 866.9625 821.9625 718 867.5625 822.5625
629 866.3750 821.3750 675 866.9750 821.9750 719 867.5750 8225750
630 866.3875 821.3875 676 866.9875 821.9875 720 867.5875 8225875
631 866.4000 821.4000 - 867.0000 822.0000 721 867.6000 822.6000
632 866.4125 821.4125 677 867.0125 822.0125 722 867.6125 822.6125
633 866.4250 821.4250 - 867.0250 822.0250 723 867.6250 822.6250
634 866.4375 821.4375 678 867.0375 822.0375 724 867.6375 822.6375
635 866.4500 821.4500 679 867.0500 822.0500 725 867.6500 822.6500
636 866.4625  821.4625 680 867.0625 822.0625 726 867.6625 822.6625
637 866.4750 821.4750 681 867.0750 822.0750 727 867.6750 822.6750
638 866.4875 821.4875 682 867.0875 822.0875 728 867.6875 822.6875
- 866.5000 821.5000 683 867.1000 822.1000 729 867.7000 822.7000
639 866.5125 821.5125 684 867.1125 822.1125 730 867.7125 822.7125
- 866.5250 821.5250 685 867.1250 822.1250 731 867.7250 822.7250
640 866.5375 821.5375 686 867.1375 822.1375 732 867.7375 822.7375
641 866.5500 821.5500 687 867.1500 822.1500 733 867.7500 822.7500
642 866.5625 821.5625 688 867.1625 822.1625 734 867.7625 822.7625
643 866.5750 821.5750 689 867.1750 822.1750 735 867.7750 822.7750
644 866.5875 821.5875 690 867.1875 822.1875 736 867.7875 822.7875
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FCC Chan.| Mobile Rx| Mobile Tx FCC Chan.] Mobile Rx| Mobile Tx FCC Chan.| Mobile Rx| Mobile Tx
|_ No. Freg. Freq |_ No. Freq. Freq F No. Freq Freq

737 867.8000 822.8000 783 868.4000 823.4000 - 869.0000 824.0000
738 867.8125 822.8125 784 868.4125 823.4125 - 869.0125 824.0125
739 867.8250 822.8250 785 868.4250 823.4250 - 869.0250 824.0250
740 867.8375 822.8375 786 868.4375 823.4375 - 869.0375 824.0375
741 867.8500 822.8500 787 868.4500 823.4500 - 869.0500 824.0500
742 867.8625 822.8625 788 868.4625 823.4625 - 869.0625 824.0625
743 867.8750 822.8750 789 868.4750 823.4750 - 869.0750 824.0750
744 867.8875 822.8875 790 868.4875 823.4875 - 869.0875 824.0875
745 867.9000 822.9000 791 868.5000 823.5000 - 869.1000 824.1000
746 867.9125 8229125 792 868.5125 823.5125 - 869.1125 824.1125
747 867.9250 822.9250 793 868.5250 823.5250 - 869.1250 824.1250
748 867.9375 822.9375 794 868.5375 823.5375 - 869.1375 824.1375
749 867.9500 822.9500 795 868.5500 823.5500 - 869.1500 824.1500
750 867.9625 822.9625 796 868.5625 823.5625 - 869.1625 824.1625
751 867.9750 822.9750 797 868.5750 823.5750 - 869.1750 824.1750
752 867.9875 822.9875 798 868.5875 823.5875 - 869.1875 824.1875
- 868.0000 823.0000 799 868.6000 823.6000 - 869.2000 824.2000
753 868.0125 823.0125 800 868.6125 823.6125 - 869.2125 824.2125
- 868.0250 823.0250 801 868.6250 823.6250 - 869.2250 824.2250
754 868.0375 823.0375 802 868.6375 823.6375 - 869.2375 824.2375
755 868.0500 823.0500 803 868.6500 823.6500 - 869.2500 824.2500
756 868.0625 823.0625 804 868.6625 823.6625 - 869.2625 824.2625
757 868.0750 823.0750 805 868.6750 823.6750 - 869.2750 824.2750
758 868.0875 823.0875 806 868.6875 823.6875 - 869.2875 824.2875
759 868.1000 823.1000 807 868.7000 823.7000 - 869.3000 824.3000
760 868.1125 823.1125 808 868.7125 823.7125 - 869.3125 824.3125
761 868.1250 823.1250 809 868.7250 823.7250 - 869.3250 824.3250
762 868.1375 823.1375 810 868.7375 823.7375 - 869.3375 824.3375
763 868.1500 823.1500 811 868.7500 823.7500 - 869.3500 824.3500
764 868.1625 823.1625 812 868.7625 823.7625 - 869.3625 824.3625
765 868.1750 823.1750 813 868.7750 823.7750 - 869.3750 824.3750
766 868.1875 823.1875 814 868.7875 823.7875 - 869.3875 824.3875
767 868.2000 823.2000 815 868.8000 823.8000 - 869.4000 824.4000
768 868.2125 823.2125 816 868.8125 823.8125 - 869.4125 824.4125
769 868.2250 823.2250 817 868.8250 823.8250 - 869.4250 824.4250
770 868.2375 823.2375 818 868.8375 823.8375 - 869.4375 824.4375
771 868.2500 823.2500 819 868.8500 823.8500 - 869.4500 824.4500
772 868.2625 823.2625 820 868.8625 823.8625 - 869.4625  824.4625
773 868.2750 823.2750 821 868.8750 823.8750 - 869.4750 824.4750
774 868.2875 823.2875 822 868.8875 823.8875 - 869.4875 824.4875
775 868.3000 823.3000 823 868.9000 823.9000 - 869.5000 824.5000
776 868.3125 823.3125 824 868.9125 8239125 - 869.5125 824.5125
777 868.3250 823.3250 825 868.9250 823.9250 - 869.5250 824.5250
778 868.3375 823.3375 826 868.9375 823.9375 - 869.5375 824.5375
779 868.3500 823.3500 827 868.9500 823.9500 - 869.5500 824.5500
780 868.3625 823.3625 828 868.9625 823.9625 - 869.5625 824.5625
781 868.3750 823.3750 829 868.9750 823.9750 - 869.5750 824.5750
782 868.3875 823.3875 830 868.9875 823.9875 - 869.5875 824.5875
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- 869.6000 824.6000 - 869.7375 824.7375 - 869.8750 824.8750
- 869.6125 824.6125 - 869.7500 824.7500 - 869.8875 824.8875
- 869.6250 824.6250 - 869.7625 824.7625 - 869.9000 824.9000
- 869.6375 824.6375 - 869.7750 824.7750 - 869.9125 824.9125
- 869.6500 824.6500 - 869.7875 824.7875 - 869.9250 824.9250
- 869.6625 824.6625 - 869.8000 824.8000 - 869.9375 824.9375
- 869.6750 824.6750 - 869.8125 824.8125 - 869.9500 824.9500
- 869.6875 824.6875 - 869.8250 824.8250 - 869.9625 824.9625
- 869.7000 824.7000 - 869.8375 824.8375 - 869.9750 824.9750
- 869.7125 824.7125 - 869.8500 824.8500 - 869.9875 824.9875
- 869.7250 824.7250 - 869.8625 824.8625
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A

Acknowledge Alert Tone 33
Add System 11

Affiliation Hold Off 28
Affiliation Type 46

Alert Site Trunking 28, 30
Analog Transmit DES/DES-XL 47
ANI 38, 41, 42

Announcement Group ID 55, 66
Announcement Group List 51, 62
Announcement Groups 55, 66
Anti-Cloning Features 76

Auto Scan 54, 66

Auxiliary B 23

Auxiliary B Input 23

Backlight Level 22
Backlight on Keypress 22
Backlight On Time 22

Band 18

Battery Saver 20

Baud Rates 12

Busy Channel Lockout 40, 42
Busy Channel Override 37
Busy Update Timer 58

Cc

Cdl Alert 38

Call Alert Decode 38

Cadl Alert Encode 38

Call Alert Usage 59

Call Guard (CTCSS/DCS) Codes
Table 79

Call List 34, 48, 60

Cadl Timer 33

CHAN PARMS 69, 72

Channel Alias 39, 41, 54, 65

Channel Bandwidth 46

Channel ID List 59

Channel Selector Enabled 23

Channel Setup 31

Channel Type 39, 65

CHNG CHAN 69, 72

INDEX

CHNG ZONE 69, 72

Clear Alert Tone 27

Clone Feature 75

Close 11

Comports 12

Computer Description 6
Connect Tone 46

Control Channel List 47, 60
Controller Type 22
Conventional System Parameters 32
Conversation 37

Convert Band 11

Creating Systems 8
CTCSS/DCS 39, 42
CTCSS/DCS Table 79
CTCSS/DCS/NAC List 37
Cursor 20

Customized Roaming Properties 45,
59

D

D/H Box 18

Data Registration Enabled 38
Decimal/Hexadecimal Select 8
Default RCM Address 59
Default User Selected Scan List 33
Delete System 12

Digit Duration 38

Digital Squelch 42

Digital UnitID 27

Display Option 27

Display Options 28, 30
Display Site Trunking 28, 30
DTMF Emergency ID 27
DTMFPTTID 27

Dynamic Regrouping 46, 59

E

Electronic Serial Number 76
Emergency 44, 57

Emergency (Conventional) 33
Emergency Alarm 33, 44, 57
Emergency ANI Call - Analog 33
Emergency Blocked 30
Emergency Call 44, 57
Emergency Call - Digital 33
Emergency Group ID 66
Emergency Hot Mic 33, 44, 57
Emergency Hot Mic Time 34, 44, 57
Emergency Retry Counter 44, 57
Encryption Key ID 33, 36, 62
Enhanced Private Conversation 46
Erase Keys on Keyset Change 22
External PA Display 23

87

F

Failsoft 30

Failsoft Enable 50, 62

Failsoft Inactivity 28

Failsoft Inactivity Duration 30
File 18

FileMenu 11

File Size Indication 8

Force Unmute Time 58
Frequency 39, 42

Front Keypad Lockout Only 22
Full Spectrum CC Scan 28, 29
Function Button Programming 25

G

Globa Emergency Channel 20
Global Screen 8, 19

Group ID 42

Group Selection 42

H

Handheld Control Unit (HHC) 6
Hang-Up Box Monitor 22

Help 7, 17

Hexadecimal 16

Hold Off Time 30

Holdoff Delay 30

Home Channel 20

Home Zone 20

Horn Cadence 21

Hot DTMF 47

Ignition Power Down 20
Ignore Clear/Secure 23

Individual (Unit) Call List Settings 33

Individual Call Maximum Target
Ring 30

Individual ID 44

Infinite Key Retention 21

Information 18

Initial Delay 38

Installation 7

Inter Digit Delay 38

ISP Sequence Length 58

ISW Delay Time 45

K

Key Management 21
Key PID 40, 50

Keypad 22

Keypad CTCSS/DCS 37
Keypad DTMF 40, 42
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Keypad Programming 69
Keypad Type 22

Keys 44, 57

Keys Table 21

L

LED Disabled w/Backlight Off 23
LED Indicator 20

Load System Keys 12

Lock Channel Selector 22

Lock Volume Knob 22

Lost Passwords 67

Low Battery Beep 20

Low Battery Indicators 20

Low Power 20

M

Main Screens 8

Make Dynamic Regrouping
Channel 66

Manual, Operating 6

Manual, Service 6

Master Radio 75

Menu Enabled 23

Menu Items Programming 25

Message Alias List 34, 48

Message Trunking 59

Mic Levels 21

Microphone Jack 6

Minimum Volume 21

Mixed Mode 41

Modulation Level 39, 42

N

NAC 42
New 11
Normal/Silent 33

(o)

On New 16

Open 11

Option Switch Functions 26

Option Switch/Menu Parameter
Table 26

Organization ldentity 15

Organizer 8, 18

OTAR 38

OTAR Enabled 38

OTAR Keys Table 22

OTAR Time Out 38

Other Band Trunking List 53

Out-of-Range Indication 29, 30

Override Talkgroup Security
Settings 43

P

P25 Packet Data 79
P25PTTID 27
P25 Talk Group on Rx 27
Password
Changing 68
Download/Upload 15, 67, 68
Management 15
Master 15, 67, 68
Operation 67
Power On 67, 68
User 15, 68
Zone 68
Penalty 37
Per System Screen 8
Permanent Keypad Lockout 22
Phone DTMF Timing 45
Phone Interconnect Usage 46
Phone List 48
PID/ASM Mode 21
Power 39, 42
Power Up Channel 20
Power Up In 20
Power Up Zone 20
Preference 62
Preferences 16
Preferred Sites 50, 51, 62
Print 11
Priority Lookback Time A 33
Priority Lookback TimeB 33
Priority Sampling 36
Priority Scan List 36, 52, 64
Private Call 2 46
Private Call Maximum Int Ring 30
Private Call Usage 46, 59
Programmable Titleand Logo 8
Programmed Channels Only on
Display 22
Programming Cable 5
Programming Procedure 9
Programming Setup 5
PTT -ID 59
PTT ID Enable 45
PTT Warning Time 58

Q
Quick Fade Protect 58

R

Radio Check 37, 58

Radio Inhibit 37, 58

Radio Menu 11

Radio Random Hold Off Time 30

Radio Wide Conventional
Parameters 27

Radio Wide Screen 8

Radio-Wide Scan List 24

rcf 7

88

Read Options From Radio 13

Read Parameters From Radio 12

Read Version Info From Radio 13

Read/Write IP Address 14

Read/Write Spur Frequencies 14

Release Notes 7

Remember Band 16

Remember Baud Rate 16

Remember Keys Directory 16

Remember Series 16

Remote Programming Interface
(RPI) 5,6

Response Pending Timer 58

RFSS 57

RFSS Response Time 58

RFSS/Site ID No. 62

Ring Time 30

RS-232 Port 79

RSSI Threshold 29, 46

Rx Audio to External PA 23

Rx Auto Detect 40, 50

S

Save 11

Save As 11

Scan Hold Time 25, 33, 45, 58
Scan List 66

Scan Mode 36, 52

Scan Talk Back Type 24

Scan Time 28

Security 40

Security Type 40, 50

Selected User 15

Send to Selected Organizer Group 11

Series 11, 18

Setting Up Channels 31
Setting Up Zones 31
Single Tone Encoder 38
Site 57

SiteList 52, 63

Size 18

Slave Radio 75

SLN/CKR Mode 21
SmartZone Coverage Type 58
Soft Power Down 20
Sound 21

Splinter Channels 46
Standard Private Conversation 46
STAR Trunking 47

Status AliasList 34, 47, 60
Status Aliasing 59

Status Bar 17

Strapping Mode 40, 50, 61
Surveillance Mode 23
SYSPARMS 69, 72
System ID 44, 56

System Key 74, 76
System Key Location 74
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System Lists 34 U
System Preferred Site List 52, 64 Unit 57
System, Creating 8 Unit RSl 27
Use Sys Preferred Site List 51, 62

T Use System Preferred Site List 50, 62
Talk Group 55 User Group ID List 37, 54, 65
Talk Group ID 51, 55, 66 User x 15
Talk Group List 35, 49, 61
Talk Group Specific Preferred Vv

Sites 51, 62 View Programmed Radio Wide
Talk Groups 66 Functions 12
Talk Permit Tone 55, 58 Volume Ticks 23
Talkback Scan 29, 30
Time Out 39, 42 w
Time-Out Timer 45, 58
Tone On/Off 21 WACN 56
Tone Volume 21 Wireless Cloning 75
Toolbar 17 Write Application Code to Radio 13
Toolbar Options 14 Write DSP Code To Radio 13
Transfer Menu 12 Write Parameters To Radio 12
Transmission Trunking 46, 59
Transmit 39 y4

Transm!t Disable 55, 66 Zone Password 68
Transm!t Power 46, 59 Zone Screen 8
Transmit Type 71, 73 Zone Setup 31
Tx Chirp 20

Tx DES/DES-XL 40, 50

Tx Time-Out 37

Tx/Rx Frequency 62
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